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What's New Topics?

= |nstallation

= Operating Systems Supported

= New Engines Supported

= New Features Supported

= New ECM Diagnostic Test Supported

= \What's New Summary
= INSITE™ Qverview
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Installation
INSITE™ 8.0.0 installation

= INSITE™ 8.0.0 1s available for download from the

on or after February 28" 2014.

= Administrative rights are NOT needed to install
INSITE™ 8.0.0 via Update Manager (nSsITE 7.6.x required on

the machine to use this method)

= New licenses may be required should license
migration fail from 7.6.X to 8.0.0. Launch INSITE™
first if INSITE was on the machine previously to
perform the license migration.

1/20/2014 c



https://insite.cummins.com/insite/downloads/index.html�
https://insite.cummins.com/insite/downloads/index.html�

Operating Systems

= Supported:
— Windows® 7, 32-bit and 64-bit
— Windows® 8.X 32-bit and 64-bit

= Not supported:
— Windows® XP, 32-bit and 64-hit
— Windows® Vista, 32-bit and 64-bit

Back to What's New Agenda e
1/20/2014



New/Modified Base Features Supported

= - Product Based Licensing

— INSITE 8.0.0 licensing has been updated to include licensing based on the
engine support needed. All of the existing levels of Pro, Lite and
RSGR/Industrial Pro and Basic are supported in all of the Product Levels.

— Product Levels:

« MR/HD Automotive - This will support all Mid Range and Heavy Duty _
automotive engines supported by the Service Information Rule (SIR) and Repair
and Maintenance Information (RMI) regulations.

* MR/HD Plus - This will support all Mid Range and Heavy Duty automotive and
industrial engines including those supported by SIR and RMI. This does not
include High Horsepower engines.

* Service Plus — This will support all Mid Range and Heavy Duty automotive and
industrial engines and High Horsepower engines. This functionality level will
require High Horsepower Certification before it can be purchased.

— Note: Higher functionality levels will not function without an active Basic
license.

1/20/2014 c



New/Modified Base Features Supported

= Reset Inactive Faults

— With INSITE 7.6.2, this function was disabled for the 2007 and above engine models.
To reset inactive fault codes, the Reset All Faults option can be selected.

= INSITE Integrated Simulator - Multi Module

— With INSITE 7.6.2, changes were made for 2007 models and above were combined into
one single simulator called INSITE Integrated Simulator - Single Module.

— With INSITE 8.0.0, for 2007 models and above multi module simulators are now
combined into one single simulator called INSITE Integrated Simulator - Multi Module.
This will display all the Features and Parameters, ECM Diagnostic Tests, and Advanced
ECM Data that is supported for multi module engines.

— The existing 2007 models and above multi module engine simulators will be removed.
This will not impact the multi module engine simulators prior to 2007 models.

= INSITE Data Packs

— Installed with 8.0 is the Data Pack program. This is a base program that will allow minor
updates to be installed without the need of an INSITE Feature Pack release. This
program, and the License Configuration Tool, is built into the INSITE installation and will
Install before INSITE. If they are removed after installation, INSITE will not function.
INSITE Data Packs may include the support of a new engine product, new feature
new monitors. These will be installed using the Cummins Inc. Update Manager.
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New/Modified Base Features Supported

= Calibration Selection and Download

= INCAL

— The INCAL expiration date has been extended from six months to seven months. This change will also apply
to calibrations that are downloaded from QuickServe Online.

= Calibration Passwords

— If a calibration authorization is needed during a calibration download, a Fleet Calibration Count will be needed.
Fleet Counts will be the only Calibration Authorization Password available with the Licensing Configuration
Manager.

— The single calibration password option is no longer available. The Calibration Authorization window will only
di?play a check box to use a Fleet Calibration Count and display the current and requested ECM Code
information.

= Programmable Datalink Device (PDD) Calibration

— When selecting PDD under Calibration Selection, INSITE will disconnect from the ECM and open the reflash
window in full screen.

— O_nc(:je the PDD reflash has completed, the PDD window must be closed by using the Close Button (X) on the
window.

— INSITE will not automatically reconnect to the ECM after the PDD window has been closed. A manual
reconnection will be necessary.

1/20/2014




New/Modified Base Features Supported
= Work Orders

— Work Orders and Images created in Simulator Mode on an
earlier release, will be deleted on the upgrade to 8.0.0. This
affects simulator only. Work Orders and Images created
from an ECM will be retained.

— When connected in Simulator Mode, only Work Orders and
Images created with the Integrated Simulator will be
displayed.
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New ECM Diagnostic Test Supported

= ***This will only be displayed if it is supported by the
calibration.
= Aftertreatment Diesel Particulate Filter Restriction Test

— This test will aid in the evaluation of the Aftertreatment Diesel
Particulate Filter to determine if it needs to be cleaned and if it
meets reuse criteria after a cleaning event.

Back to What's New Agenda c
1/20/2014




Advanced ECM Data

= ***These will only be displayed if they are supported by the
calibration.

= Aftertreatment Diesel Oxidation Catalyst Efficiency

— Each time a regeneration is performed, the ECM calculates the efficiency of
the Diesel Oxidation Catalyst. This value is logged in the ECM when there is a
change from the previously calculated value. This feature will display the last

ten log values.

= Aftertreatment Maintenance and Aftertreatment Maintenance Filter
Installation

— This feature has been updated to include two new monitors: Aftertreatment
Diesel Particulate Filter Remaining Hours and Aftertreatment Diesel
Particulate Filter Remaining Distance. These monitors provide the distance
and hours remaining before the next Diesel Particulate Filter cleaning.

1/20/2014 c




Overview of INSITE Licensing
Changes
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Overview of INSITE Licensing Changes

= INSITE will change how it is licensed with the release of
INSITE 8.0.0

— Requires an internet connection to activate a license and
revalidate the license (every 90 days).

— Introduces Product Based licensing

— The active 7.5.X or higher licenses will migrate automatically to
8.0.0 license system

— Allows for bulk license purchasing for larger customers (up
to100 licenses).

— Introduces Simulator Mode

— Allows the end user to activate, repair, revalidate, and transfer a
license.

= Will only support Windows® 7 and Windows® 8

Operating Systems c




New Licensing Terminology

= Activation Key — A 12 character alpha-numeric
string used as part of activating licenses via online
and offline mode methods. A license administrator
and/or Distributor will receive an activation key for
each license purchase transaction.

= Tool Instance — Replaces the PCID. The Tool
Instance will display everywhere the PCID
displayed previously (Work Orders, Activity Logs,

Images, Help About, etc.)




Internet Connectivity Requirements

= Does the new licensing require INSITE to be
connected to the internet all the times?
— No — The internet is only needed when activating

licenses, repairing licenses (corrupt / back dated),
transferring licenses, and revalidating licenses.

» Being connected to the internet at all times just limits the
prompting INSITE will do as the system gets close to the
revalidation period. (30, 15, 10-1 days remaining)

= NOTE: Requires everyone with an active INSITE
license to connect to the internet at least once
every 90 days.

&



Revalidation Information

= Everyone with an active INSITE license must
connect to the internet at least once every 90 days
to revalidate their licenses and counts.

= |f the revalidation period has passed (over 90
days), INSITE will revert to Basic functionality and
all counts on the PC will be removed.

= The user can connect to the internet after the
revalidation has passed and then functionality
iIcense will be activated back on to the PC.

= |If the license has expired after the revalidation
period, the user must purchase a new license and
enter in the new activation keys. e




Product Based Licensing

= With the introduction of INSITE 8.0.0, licensing will be
defined by product and functionality levels.

= INSITE Pro, Lite, RSGR/Industrial Pro, and Basic will
still be available as functionality levels.

= New Product Levels
— Service Plus — All supported engines
« All 7.5.0 to 7.6.2 licenses will be migrated to the Service Plus level
— MR/HD Plus — All supported engines minus HHP
— MR/HD Automotive — EPA 2007 > (SIR) and Euro VI (RMI)
products only

= Example: Currently have Pro, the license will migrate to
8.0.0 as Service Plus Pro.

= See screenshots on next two slides for more information. e




Product Levels and Functionality Levels

Product Level

Service Plus

MR/HD Plus

MR/HD
Automotive

(All Supported)

(All minus HHP)

(SIR/RMI Only)

Functionality Level

Pro

Lite

RSGR/Industrial Pro

Basic

Simulator*

XXX X[ X

XXX [X]X

XX | XX | X

*No licensing required.




Functionality Levels

Functionality Level

SIMULATOR

BASIC

LITE

RSGR

PRO

No license required /
No live ECM
connection

Read Only
ECM Access

No Calibration
Download

No Calibration
Download / Limited
Special Features and

Diagnostic Tests

Full Functionality

Features

View Trip Information

View Fault Trees

Fault Information System

View Troubleshooting Steps

View Parameter Settings

View Wiring Diagrams

View Engine Dataplate

Driver Rewards

Data Monitor / Logger

XX XXX XXX [ X

Reset Trip Information

Reset and Clear Fault Codes

Set Engine Features (on/off)

Set / Adjust Parameters

Set / Change ECM Passwords

Create Settings Templates

Create Work Orders / Jobs

KX XX XXX XXX XXX X[ X

ZAP-1t Functionality

X

Run Special Features

Limited

Run Diagnostic Tests

S XXX XXX XX XXX [ XXX

Limited

Read / Retrieve Calibration Files

Load Engine Calibrations

DX XXX X XX XX XX XXX X [ X




License Migration Information From
Versions 7.5.X or Higher to 8.0.0

= All active INSITE licenses that are 7.5.X or higher will be migrated
to the 8.0.0 licensing system.

= If the user only has a BASIC license and itis 7.5.X or 7.6.X, it will
be migrated for free to get the user onto the new licensing system.

= All active INSITE licenses will be migrated to the Service Plus
product level.

= The migrated licenses will keep the same functionality level.
= All fleet counts, Zap-Its, and OEM Zap-Its will be migrated.

= The expiration of the current licenses will remain the same once
the licenses are migrated to the new licensing system.

= Migrated licenses will not be able to be renewed once they expire.

— Once the migrated license has expired, a new license must be purchased in
the new licensing system with the correct product level and functionality level.

— Only those certified to work on HHP products will receive the Service Plus
product level once the migrated license has expired.




License Migration Information From Versions
7.5.X or Higher to 8.0.0 Continued

= To migrate the license from INSITE 7.5.X or 7.6.X
(recommended) to 8.0.0 follow these steps:

— Step 1: Install INSITE 8.0.0 and the License Configuration Tool on the
PC

— Step 2: Open INSITE 8.0.0 with an active internet connection

— Step 3: The 7.X. X licenses and counts will be migrated, if an internet
connection is on the PC.

— Step 4: The migrated licenses will work on the PC until they expire.

— Step 5. New licenses must be purchases once the migrated licenses
have expired.

NOTE: The PC must be on Windows® 7 or Windows® 8
operating systems to install INSITE 8.0.0




Bulk License Purchasing

= Distributors and License Administrators may
purchase up to 100 INSITE licenses at one time.

— Allows easier management of large accounts for the
Distributors and License Administrators.

— Can be broken up for a region or location for a particular
customer.

« Example: A business has 5 locations that need INSITE
licenses with each one having different types and numbers of
licenses.

— Option 1: Could purchase 7 Pros and then 16 Lites in one
transaction to track the whole business.

— Option 2: Could purchase for each location separately but in bulk
for the multiple licenses.

Location #1 [Location #2 |Location #3 [Location #4 |Location #5 |Total
2 Pro 1 Pro 1 Pro 2 Pro 1 Pro 7 Pro
1 Lite 6 Lite 2 Lite 4 Lite 3 Lite 16 Lite



Bulk License Information

= Licenses can be purchased in bulk from 2 to 99 at
one time.

= The licenses are for the same functional type and
product level type.
— If purchasing 15 Service Plus Lite licenses in bulk, will
receive 1 activation key for the 15 Service Plus Lite

licenses and 1 activation key for the 15 Service Plus
Basic licenses to go with those Service Plus Lite licenses.

= For bulk licenses, the first license to be activated

will be the expiration date for all of the other
licenses that were purchased in bulk.




New Simulator Mode
:.Abuut INSITE ﬂa

anm.

INSITE Version: 8.0.0,.289
Data Pack Version: 3.0.00P1
Tool Instance: MA

Copyright © 1997-2013 Cumminz Inc. -
All Rights Reserved. =l
B |

INSITE, INTELECT, Centinel, and ICOM are
trademarks of Cummins Inc.

COne or more patents relating to the subject -

System Info... |

https: /finsite. cummins.com
http: s cummins. com

= INSITE 8.0.0 introduces a Simulator Mode for showing INSITE to
customers prior to purchasing.

— Step 1: Install INSITE 8.0.0 or later on the user’'s PC and do not
add licenses.

— Step 2: In Help About, it will show NA for the tool instance.
— Step 3: Can view INSITE features using Simulator Mode.

23



New Simulator Mode Continued

= WIll not be able to connect to an ECM In Simulator
Mode. No “Live” connection.

= Will not be able to view images and/or Work Orders
created on a “Live” ECM.

= Will only be able to view information available in the
Simulators.

24 &
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INSITE Screen Changes — Help About

-
About INSITE

anm.

INSITE Version: 8.0.0.330 FT
Data Pack Version: 3.0.00P1
Tool Instance: 3BF 2F3DE

Copyright © 1997-2013 Cumminz Inc. -
All Rights Reserved. =l
B |

INSITE, INTELECT, Centinel, and ICOM are
trademarks of Cummins Inc.

COne or more patents relating to the subject -

System Info... |

https: /finsite. cummins.com
http: s cummins. com

INSITE releases.

content version for this release of INSITE.
= Tool Instance: Replaces the PCID.

INSITE Version: Keeps the same format as previous

Data Pack Version: This is new and contains the data

&



INSITE Screen Changes — Manage
Licenses

File_Ese vaw oo Minsgslicensels) Wipiow Heln
Be®| LW aa N Ze ofB aeY D ser i s BED

_ | Conrect 1o ECM
&

r’ Fault Codes

¥

The Manage License(s) Tab will launch
the License Configuration Tool (LCT)

o) ECM Disgrostic:
Teats

| &l Advanced ECM

) Ll

| Features and
Paramdors

O Siogen

R —— J [ 4 e s S0 woowe ]
The licensing information has been removed from the Tools > Options
location. All licensing must be done through the LCT.




End User Ability to Activate, Repalr,
Revalidate, and Transfer Licenses

= Will have the abillity to activate their licenses if
provided the Activation Key or QuickServe Log In
Information.

= Will be able to repair the license for PC back-dating
and if the license is corrupt.

= WIll be able to revalidate the license every 90 days.

= Will be able to transfer a license from one PC to
another.

= NOTE: All of these actions require a PC with
Internet access.

&



INSITE 8.0.0 Release Information

= INSITE 8.0.0 will be released through DVD only
starting in early January 2014.

= The user will be able to install INSITE 8.0.0 using
Cummins Inc. Update Manager DVD/CD install and
the DVD provided to them.

= The .1so file will be available on the INSITE website
In mid-February for downloading and creating
DVDs.

&



INSITE 7.X.X Licensing System Information

= The renewal function for the current 7.X.X system will
be turned off starting in May 2014.

— The user will not be able to renew a 7.6.X license after
May 2014.

* |f the user must be on 7.6.X due to a critical business need,
please contact your Cummins Distributor, who will request a
renewal from the Electronic Service Tools Product Marketing

Team.

— The system will still provide fleet counts, Zap-Its, and
OEM Zap-Its after May 2014.

= The 7.X.X Licensing System will be phased out
sometime in Q1/Q2 of 2015. All users must be on the
new 8.0.0 Licensing System prior to the phased out in

2015. c




Introduction to the Cummins
License Configuration Tool
(LCT)
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Cummins License Configuration Tool (LCT)
Overview

= The Cummins License Configuration Tool or LCT Is
a separate application from INSITE that handles all
of the tool licensing for INSITE.

= The LCT can be launched from inside INSITE
through the “Manage License(s)” tab or opened
from the Cummins Folder on the start menu.

= The LCT requires revalidation of the INSITE
functionality license once every 90 days.

= An internet connection is required to activate,
repair, revalidate, and transfer a license using the

LCT. c




View Active Licenses / Counts

No Licenses Activated Licenses Activated

T —

IMSITE Teal Instarce: BBFZFODE

Exit IMSITE Teal Instarse: BEFIFIDE

Englmh Lemghism) HW

Lic fCounts must be returnad to allow activation on another machine. Pleate select the
lleenses/counts to reburn

atahn

Transfer Licenses

There are no active lcenses on this machine

Active Counts
Transfer Counts

15 Asailable Fevaidate By

Zap-ft T 03713704

Fleet Counl

Theére ané na Sirad ounts on Hhis mackene

Update Licenses




ACTIV
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Cummins License Configuration Tool

S |
Rrguage  Englsh (Engish) < Help i
INSTE Active Licenses
i [lceme Type Piration Date \evalidate B Y
B o,
Transfer Licenses

08/27/14

e

COunL,

B —

Iﬂﬁ OPEfabon




Activate Licenses / Counts Methods

= There are two methods to active licenses and
counts.

— Activation Key Method
— QuickServe Log In Method




Activate Licenses / Counts — Activation
Key Method

= Activate Licenses with [-== -
an ACtivati O n Key To activate s license using the Activation Key, please enter the Activation Key and press
1. Select Activate Db, pae s 15 R when i s Rovas £ ur o i

Licenses / Counts _ Actvation Key
button

me and password registered with QuickServe Online, please log in to view |

2. Enter your Activation ||l » i e _
Key in the provided ten
field

3. Select “Activate”

4. Repeat for each
license (Basic,
Functionality Level,
and Fleet Counts,
etc.)
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Activated Licenses Example

INSITE Tool Instance:

Active Licenses

BBFZFSDE

Expirabion Date Revalidate By

08/18/14 03/13/14

Transfer Licenses Service Plus Basic 0917718 12713714

Aetivata Lirarcac/!

Uifiine Chperations
Active Counts
Counts Available | Hevalidate By

Zap-It 03713714

Fleet Count 0313714

Update Licenses




Activate Licenses / Counts — QuickServe
Log In Method Steps 1 to 4

= Activate Licenses 'a' oo Soirees ST ot e s2600E |

Activate Licenses/Counts

Wi t h a. Q u i C kS e rve JI w :_r::u“ E-' e To activate a license using the Activation Key, please enter the Activation Key and press

Activate. If an internet connection is available, your license will be activated immediately.

(therwise, please save it to a file when prompted and provide it to your kocal administrator to
L O g I n complete the activation process,
Activation Key ﬂ
T—
1. Select the Pr—
Counts m
(1} T
ACtlvate _ If you have a usemame and password registered with QuickServe Online, please log in to view ||

Offine COperations the list of available licenses

Licenses/Counts”
button

Mease enter your QuickServe Online Username and Password to log in and

Select “Log In" sdminister licenses

Enter the QSOL—1 [
Username and
Password

Password

4. Select “Log In”

37



Activate Licenses / Counts — QuickServe
Log In Method Steps 5to 7

= Activate Licenses with
QuickServe Log In

5. Select the passwords
you want to activate

6. Select “Activate” to
apply these
passwords to the PC.

7. Select “Yes"t
confirm the activation
of the license(s)

Note: “Reset” button will
deselect all checked
items.

Help Bt

IMSITE Tool Instance BBF XFODE

x i
Activate Licenses/Counts

You are curmently logged in as gy775. Please press the Log Out button ta log out.

| i Eerwu FIILI!: pla

Licenses

|| Service Plus Basic

-—

Oriffane perations

Ot Type
Fleet Count
|| Zap-It OEM 22
¥ |zZapt ] 7
—
| Activate selected licenses? m m




Activate Licenses / Counts — QuickServe
Log In Method Step 8

- : -
Cummins License Configuration Toal 2 L = e
L

= Activate Licenses |[[ee= oo
with QuickServe '
Log In

8. Review the

activated licenses |5
by clicking “Yes” — ————.

Help  Exit ) INSITE Tool Instance: BBF2FODE

Activate Licenses/Counts

H.ense 1ype

Counts

Fleat Cowunt 1
Zap-Tt OEM 1 Z
7 | Zap-it 1 7




Activated Licenses Example

INSITE Tool Instance:

Active Licenses

BBFZFSDE

Expirabion Date Revalidate By

08/18/14 03/13/14

Transfer Licenses Service Plus Basic 0917718 12713714

Aetivata Lirarcac/!

Uifiine Chperations
Active Counts
Counts Available | Hevalidate By

Zap-It 03713714

Fleet Count 0313714

Update Licenses




<

Cummins License Configuration Tool

- 0O
language  English (English) Help Exit
INSITE . .
Active Licenses
Active Licencae/ . -
Counts ____ ype pl'raon'[}ate Revalid ate B
Basc e C—

: - 08/25/18 o

Tﬁﬂsft‘! U(ErlSes

08/27/14

COunLr,

B

" Operations

Active -

TIN
REPAIRING / REVALIDA
UPDATING LICENSES

Pd3t
8 FC.
E'ns
es
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Repairing and Revalidating Licenses

= Repairing a license will happen automatically when LCT
detects a condition that requires the license to be
repaired with the server

— Corrupt local license
— Backdated licenses
— Tampered licenses

= Revalidation of the license happens every 90 days. If the
PC Is always connected to the internet, LCT will perform
this action on it’'s own. However, if the PC is only on the

Internet for short periods of time, the user can trigger a
manual revalidation by selecting “Update Licenses” on

the Active License Page.
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Updating Licenses

= Updating licenses will happen every time LCT
connects to the server and sees changes to your
active licenses. For example, if you renew a
license and extend the license for another year, the
next time LCT checks, then it will update your local
license to reflect the new expiration date.

= |[f for any reason this update does not happen, the
user can trigger a manual update by selecting
“Update License” on the Active Licenses/Counts
page. (Screenshot example on next slide)




Updating Licenses Manually

= The user can trigger
a manual update by

0818714

T = , selecting “Update
Licenses” on the
| Active
e Il Licenses/Counts
T —— nage.
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Cummins License Configuration Tool

=
language  English (Engiish) - Help Eyit
INSIT - H
NSITE Active Licenses
Counts Ucense Type (Piration Date

—
Basic

' 08/25/18
Transfey Licenges

e

COuan,

ﬂé:éfe By

08/27/14

TRANSFER LICENSES /

G(OU
N TS o Mach
0 -




Transfer Licenses / Counts — Transfer All
Method
rctmﬁnstimtmﬁgmﬁmhd . =@ & ]

=  Select “Transfer P e e e ——
Licenses” Button

" | Licenses/Counts must be returned to allow activation on anather machine, Please select the

i Transfer Licenses

= Select “Transfer
All” button

= Select*Yes” to
transfer all
licenses and
counts off of

Machine #1 \
NOTE: This will

remove all licenses
from Machine #1

(9/18/14

Saprvice Flus Basic 178

:9 Are you sure you want to transfer all Bcenses/counts?
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Transfer Licenses / Counts — Save

Activation Keys

*Recommended:
Save the Activation
Key information, by
clicking on “Save

Keys” button — =

=This will save the
Activation Key(s)
Information to a file
for future reference.

=Once the Activation

& Cummins License Configuration Tool

Lenguage | English (English

Help  Exit

INSITE Tood Instance: BEFFODE

Key(s) file has been
saved, click “OK” to
continue

47

v_ Licenses/Counts must be returned to allow activation on another machine, Please select the
licenses/counts to return.

The {p!lpwin-g licanses have basn returned ':-un:-;':s.sl:uﬁy. Pleass use the Actvation ".r:,-
or login to the LCT on another machine to activate the license.

e 3

Service Plus Pro

BROONUQLEIIN

I P
g | Service Plus Basic

ZTOKDIZNOMIL

HRM2CIEIFRX

1RAUMOLPGHIY
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Transfer Licenses / Counts — Save
Activation Keys Continued

=Enter a unique
name for the
Activation Keys and
then click “Save”. Wi

Documents library

] RSGR-IndPro Activation Key.csv
"1-] Transferred Activation Keys 09-19-13.c5v

=Once the Activation e Bt
Key(s) file has been e
saved, the location

iInformation will be
displayed, click “OK”
to continue

I"- "‘-I Activation keys have been saved to DA\Users\gy7 75\ DocurmentshIMNSITE 80
WLET InformationyOEM Zap it Activation Key 12-13-13.csv,




Transfer Licenses / Counts — Selected
Method

. SeIeCt “TranSfer i;‘:‘::e”“'mw“m‘jlp Exit INSITE Tool Instance:  BBF2FODE
Licenses” Button |

=@ & ]

INSITE

Licenses/Counts must be returned to allow activation on another machine, Please select the
licenses/counts to refurn.

Transfer Licenses

= Select the Licenses
and/or Counts to be
transferred off of
Machine #1.

<
= Select the “Transfer

Selected” button \ : .
= Select “Yes” to \ * Lo =
confirm the transfers
= Same process as
“Transfer All” Method

from this point
forward. c
49
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Transfer Licenses/Counts Summary

= Once the licenses and/or counts have been
transferred back to the server from Machine #1, the
user can use either the Activation Keys created
during the transfer process (in saved file) or the
QuickServe Log In Method to activate the
transferred licenses on Machine #2.

= See the Activate Licenses/Counts Section for more
Information on how to activate the transferred
licenses and/or counts.

= There Is a transfer limit for licenses and counts.

= NOTE: Transferring the licenses back to the license
server does not stop the expiration count down. e
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e Cummins License Configuration Tool

language  English (Engiish) - Help Eyit
INSITE

Active Licenses
I .wl- = M :

Counts

Ucense Type | Expiration Date

Revalidate By

Basic 08/25/18 08/27/14
Transfer Licenses

 Acthate leaneast

Counts

Offne Operations

€ no
Active COung On this '

Pdate I-Ffeee.




Offline Operations — Activate License Items
Needed

= The following is needed to perform offline
activations:

1. PC without Internet Connection (INSITE and LCT
Loaded)

2. PC with Internet Connection (Only Need LCT for this
machine)

3. The Activation Keys you want to activate on the offline
machine

4. A method to transfer files between the 2 PCs.
USB Drive, Android Phone in Mass Storage Mode, etc

&



Offline Operations — Activate License Steps
1to4

1. Select “Activate
Licenses / Counts”
on Machine without
Internet connectivity;
and with INSITE and
LCT installed

2. Enter the Activation
Key in the provided
field

3. Select “Activate”
4. Select “Yes” to the

message that is
displayed c

IMSITE Tog! Instance BEFZFADE

Activate Licenses/Counts

To activate a license using the Acthvation Key, please enter the Activation Key and press
Activate. if an internet connection is avallable, your license will be activated immediately.
Otherwise, please save it to a file when prompted and provide it to your local administrator to

P— complete the activation process
L JCETSES

Activation Key

I:-'I-H"-Irl: m

-‘ If you have a username and password registered with QuickServe Dnline, please log in to view

O, e Operations the |kt of svailable lcenses

JA Woeuld you like to create a Request File to activate the license offline?

— e

|
¢ Thelicense could net be activated due to lack of network connectivity.




Offline Operations — Activate License Steps
5108

5. Provide a name for o =
the request file. o

o
6. Select “Save” o
7. Select “OK” ol
8. Repeat Steps 2 S

through Steps 7 for
each License that
needs to be activated
on the Machine.
(Basic, Functionality

Level, Fleet Counts, S
etc.) Be sure and use

a different file name
for the Request File. e

a7 The Reguest file has been saved to ChUsers\trekken?3\Desktop
| | \TestMachineRequestl.arg. Please send the Request File to a License
= Administrator to activate the licenses offline.,




Offline Operations — Activate License Steps
910 13

9.

10.

11.

12.

13.

55

c - olEM

Cummins License Configuration Tool

Open LCT on the

Language

English (English) Help  Esit

INSITE Generate Response File

Machine with an
Internet connection

Select “Browse” and
select the Request file
generated in Step 6

/

Select “Generate
Response File”

Ll Rl To activate or repair a lioense when there is no intermnet, please follow the steps below, {If the
. licenses need to be activated /repaired on this machine and the Response file has already been
copsed, please skip steps 1-3)

2. Please copy the response file generated to the machine an which the licenses need to be
activated or repaired

3. Launch Cummins License Configuration Tool on the machine.

CUsershtrekeenT 3 Desktop\TesthachineReguest 1ang

el

Favcins

Name the Activations
file and Select “Save™

Repeat for each
Request file created

Fdkiuree




Offline Operations — Activate License Steps
14 to 15

14 1) = The Response file has been saved to D-\Users\bpd 05\ My Cubby\Wark Stuff
14 . S e I e Ct O K fo r o “Test Maching 1 Activationarp. Please copy the response file to the user's

machine.

confirmation dialog > maam

15.Transfer the files via
USB drive or other
means to the Machine
without Internet

NOTE: Remember to
transfer ALL files
created.




Offline Operations — Actlvate License Steps
16 to 18 (e

h:ensrsneed be a mwbbd."r\:pu.rﬂion this machine and heRc-spmueﬁl e has .ﬂr\uudyb-u

connedctivity, go to the Offline ....._ ety

L. Gemerate Licemnie Response File

Opera‘tions tab e i:h:l;cup}' the response file generaled 1o the machine on which the licenses need fo be
P— vated or repaired

3. Launch Cumming License Configuration Tood on the maching.

17. Select “Browse”

f||e from the Other MaCh|ne | Activate/Kepci=licenses From Response File
and Select “Open” N -

= Cummins License Configur,
= Select a Response Fil
- - o By Cubby » 'Work Stufi
g Blew
e e
I Desktop
Dowedoads Test Machine | Activation. =p
My Cubby
W Proto SEresen
. Recent pi
e SioyD

File mamme | Test Machine | fictivation.amp




Offline Operations — Activate License Steps
19 tO 21 e Cummins License Configuration Toal - o IEl

19.

20.

21.

GruBg Enghsh [Englsh) Help  Bat

Generate Response File

bl To activate or repair a license when there is no internet, please follow the steps bebove. (If the
Counts licenses need to be activated/repaired on this machine and the Response file has alveady been
copled, please skip steps 1-3)

1, (perwerate License Response File

Select “Apply Response
File”

Select “Yes” or “No” to
view the activated
License

2. Please copy the response file gemerated to the machine on which the lcenses need to be
activated or repained

3. Launch Cumming License Configuration Toal an the machine,

If you have more than
one key to enter select
“No” and repeat Step 16
thru Step 20 until all
Activation Files have
been applied




Offline Operations

= Offline operations only work for activating and
repairing licenses or counts, not for revalidating a
license.

= The user must connect to the internet to revalidate
the license once every 90 days.




Licensing: Frequently Asked
Questions

Service Entrance #

Parts Entrance 2




Does the LCT take the place of the

Tools/Options/Security process for passwords
used for the old 7.X.X licensing system?

= Yes, the older system has been replaced.
INSITE licensing is no longer under the
Tools/Option/Security section of INSITE.

= The LCT Is a separate application from INSITE.

= The LCT can be launched through INSITE
under the “Manage License(s)” tab or through
the PC start menu under the “Cummins” folder.

&




Will the technician need to use the LCT?

= It will depend on the location and what the
Service Manager allows the technician to do on
his or her own.

— If the technician is provided the activation key or QSOL
Login to activate the license(s), then yes the technician
will need to know how to use the tool to activate the
license.

— The technician will have the ability to repair the license
using the LCT through the “Update License” button.

— The technician will have the ability to transfer the license
off of the PC through the LCT.

— The technician will be able to manually revalidate the
license(s) through the “Update License” button. c




Will the use of Update Manager also take
care of the licensing internet connection
requirement?

= Sort of, the LCT works similarly to Update Manager
where Update Manager checks the servers for updates
at a set time designated by the user.

= The LCT does a maintenance check daily with no user
Interaction, so if the user is connected to the internet at
any time, even if they are not using INSITE, the LCT
will revalidate and move the date out by a day.

= They are separate applications.
— Update Manager for updates and software installation
— License Configuration Tool for the licensing

&



How will the INSITE user (technician) be
notified the 90 day revalidation is needed?

= There is a pop up that will let the technician know about
the 90 day revalidation starting at 30 days out, then 15
days, then 10 days, and then every day past 9 days.

= |f it Is after the revalidation date, INSITE will revert to
Basic and will provide a pop-up that the user needs to
connect to the internet to continue using INSITE. Once
the user connects to the internet, INSITE will revert to
the previous functionality unless the license has

expired during that time.

NOTE: If the revalidation period has passed the user will
lose the counts that are on the PC, since there is no way

to verify if the counts were used during the last 90 daye

64



When will our dealers activate subscriptions
be migrated to the new licensing system?

= When the user installs INSITE 8.0.0 and goes to open
INSITE for the first time, the migration process will be
attempted at that time.

= |f the user Is not connected to the internet, a pop-up will
ask If they want to activate using the offline mode
method or not.

= The user can either connect to the internet to migrate
the license or use the offline mode process to activate
the license with the activation key(s).

&



What happens when a dealer with an active
INSITE 7.6.X subscription upgrades to
INSITE 8.0.07

The license will be migrated to the INSITE 8.0.0 licensing system
and will keep the same expiration date as the INSITE 7.6.X
license.

The expiration of the current licenses will remain the same once
the licenses are migrated to the new licensing system.

All active INSITE licenses will be migrated to the Service Plus
product level.

The migrated license will keep the same functionality level.
All fleet counts, Zap-Its, and OEM Zap-Its will be migrated.

The migrated license cannot be renewed in the new licensing
system. A new license must be purchased in the new system once

the migrated license has expired.




The Distributor supplies the dealer a new
functionality password when their subscription
expires with the old system, what will we supply the
dealer with the new system when their subscription
expires?

= Once the subscription has expired in the new system, if
the license is not a migrated license, the system will
update the license on the PC without user interaction
once it is connected to the internet.

= For the migrated licenses from 7.X.X, a new license
must be activated on the PC. Once a new license has
been activated, no technician interaction is needed as
long as there Is an internet connection to the PC.

= The offline mode activation is also available for renewal
for those without internet connectivity.




What will happen to a dealer subscription
that expires the day after the change to the
new licensing system?

= They will revert to Basic and will have to purchase a
new license in the new licensing system.




Does the new licensing require INSITE to be
connected to the internet at all times?

= No, the internet is only needed when activating
licenses, repairing licenses (corrupt / back dated),
transferring licenses, and revalidating licenses.

= Being connected to the internet at all times just limits
the prompting INSITE will do as the system gets close
to the revalidation period. (30, 15, 10-1 days remaining)

&



What's New Summary

— This has been an overview of INSITE™

— For further training on INSITE, please
refer to the INSITE™ Virtual College CD,
P/N 4091839

— For Additional information and support:

« Contact Cummins® local distributor

* Visit

* INSITE™ Help Desk 1-800-433-9341
Option 2 or 812-377-8136 Option 2

Back to What’'s New Agenda c
1/20/2014



https://insite.cummins.com/insite/index.html�

INSITE™

INSITE™ Functionality Breakdown and Details

Innovation You Can Depend On"



Table of Contents — Part 1

= Audit Trall
= Calibration Selection and Download

= ECM Connections

= Data Monitor Logger and OBD Monitors
= ECM Diagnostic Tests and Advanced ECM Data
= Fault Information and Fault Information System

= Feature and Parameters

» Inquire Data Extraction

72 1/20/2014 Cummins Confidential Innovation You Can Depend On e




Table of Contents — Part 2

= [nstallation and Tool / ECM / User Security
* Trip Information
= \Work Orders

= Cummins Inc. Update Manager

73 1/20/2014 Cummins Confidential Innovation You Can Depend On e
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INSITE™ Audit Trail

Electronic Service Tools

Innovation You Can Depend On"



75

Audit Trall

=Tracks changes made to ECM settings
* INSITE Tool Version
e User Identification
« ECM Time

=Audit Trail displays the last four or eight
times, If supported by the calibration, that the
ECM was modified

=A single record can contain multiple

changes e
1/20/2014 Cummins Confidential Innovation You Can Depend On




View Tools ManageLicense(s) Window Help

B L BRBR (SR M < FGEBRY O &> R

Click on
Audit Trail

1/20/2077

@ Connected to ECM. : ] 27 Signature/SX - CMET0 Simulater A -




File Edit View Tools Managelicense(s) Window Help

teels 2R |SR GBS oFBIEERYIO|@ > n o HB X

ﬁlg:nﬁmrmfm
B an o Window Re-sizing
B D3 oo /togoer Hold the mouse Click and hold the
Ho_Id the mouse pointer on the mouse on the black
Bk Desnostic || poINter vertical lines arrow and adjust
< || @nywhere on until the black the width of the column
Dam the_top edge arrows appear by moving the mouse
Foctures and until the black to the left and right
Porameters arrow appears.
Calibration Click and hold the
mouse on the black
s Work Orders arrow and adjust the
size of the screen by
ﬁ]’np Information R
moving the mouse up
[ At e and down
% Inquire Data
Extraction
Qﬁ_. OBD Mornitors *|Record Number ¥ Tool Name Tool ID User Type |UserID ECM Time {Key on Time ECM Real Time
Code Description
= Signature/ISX - CM870
= CM870
“E INSITE 950211112020 Software 95024444 Not Applicable 08-Jan-1996 18:29:52
- 2 Compulink 950877770020 Cartridge 23435120 Not Applicable 01-Jan-1996 18.52:22
“# 3 Echek 950788881020 Cartndge 00000000 Not Applicable 31-Dec-1995b 20:42:19
i 4 YEPS CEC000600123 Software 00000000 Not Applicable 31-Dec-1995 19:10:43

1/20/2014 = _
@ Connected to ECM. il Q |§ Signature/SX - CME70 Simulator




3 INSITE 8.0.0.379

File Edit VYiew Tools

Manage License(s) Window Help

LEB| LIERISRIAIRS o FBEBRYIO &0 n v BRBE |

3 Disconnect from
ECM

o8
Z%Faﬂcmﬁ

£, . Data
0] Monitor/Logger

ECM Diagnostic
Tests

%1 B;v:u:adECM

Features and
Parameters

Calibration
Selection

WnrkOrxlars

@ Connected to ECM.

* |Record Number Tool Name Tool ID User Type |User ID ECM Time {Key on Time) ECM Real Time
Code Description
= Signature/1S5X - CM870
= CM870
=l | INSITE 950211112020 Software 95024444 Not Applicable 08-Jan-1996 18:29:62
000 Unknown
003 Cruise Contrc
005 Road Speed
009 Maximum Vel
- 2 Compulink 950877770020 Cartridge 23435120 Not Applicable 01-Jan-1996 18:52:22
000 Unknown
001 Idle Shutdow
002 Remote PTO
003 Cruise Contr¢
“E3 Echek 950788881020 Cartridge 00000000 Not Applicable 31-Dec-1995 20:42:19
000 Unknown
003 Cruise Contrc
VEPS CECO000600123 Software 00000000 Not Applicable 31-Dec-1995 19:10:43
002 Remote PTO
Use + or —signs to
expand or collapse :
each record If th_e Real Tlme_CIock
option in INSITE is
selected, Real Time will
show instead of the ECM
Time
2
g i |5 signature/sX - CMB70 Simulator ~L




. INSITE 8.0.0.379
File Edit View Tools

Manage License(s) Window Help

LER| iR SR AIBSI<EEBIBRY T« o> nn EBF |

:E Disconnect from
ECM

19]0]
%M&dﬁ

=,  Data
D Monitor/Logger

ECM Diagnostic
Tests

Features and
Parameters

Calibration
Selection

Wnrk()rdets

@ Connected to ECM.

Software Version of
the application

Audit Trail

* | Record Number Tool Name Tool ID User Type |User ID ECM Time (Key on Time) ECM Real Time
Code Description
= SignaturefISX - CM870
= CM870
EI 1 INSITE 950211112020 Software 95024444 Not Applicable 08-Jan-1996 18:29:52
000 Unknown
003 Cruise Contr¢
005 Road Speed
009 Maximum Vel
=2 950877770020 Carlridge 23435120 Not Applicable 01-Jan-1996 18:62:22
000 Unknown
001 Idle Shutdow
002 Remote PTO
003 Cruise Contre
=3 950786881020 Cartridge 00000000 Not Applicable 31-Dec-1995 20:42:19
000 Unknown
003 Cruise Contr¢
4 CEC000600123 Software 00000000 pplicable 31-Dec-1995 19:10:43
00 Remote PTO

User ID who made
the change

Codes that identify the
type of ECM changes

E g |(§ Signature/ISX - CMBT0 Simulator

E| |




Manage License(s] Window Help

N IRE RN -

5K = CMEM) - Engine Senal Numb

r= 10101000 = ECM Code = AB10040.00

@ uw JR=

sl'““"' S Number Tool Name Tool ID User Type  UserID  ECM Time (Key on Time) ECM Real Time
age FT |
Code Description
save “s fature/ISX - CM870
Save As.. 1870
Convert L INSITE 980211112020 Software 98024444 Not Applicable 08-Jan-1996 152952
Export L 000 Unknown
Impos ’ 003 Cruise Contr
Connections ¥ 005 Road Speed
Page Setup... 009 Maxirmurn Vel
Print Preview... Compulink 960877770020 Cartridge 23436120 Not Applicable 01-Jan-1996 186222
Prifit... Crrl=P \ 000 Unknown
Send To ¥ 001 |dle Shutdow
Properties Alt=Enter 002 Remote PFTO
et 003 Cruise Contro
— . Echek 950788881020 Cartridge 00000000 Not Applicable 31-Dac-1995 20:42:19
000 Unknown
@ Work Orclers 003 Cruise Contre
- 4 VEPS CECOD0600123 Software 00000000 Not Applicable 31-Dec-1995 19:10:43
Trip Infomation 002 Remote PTO .
To Print :
2 i b Click on File and
choose Print
!LL,.OGIJ Mot ors
@ Conmectsd to ECM. g P | syrsturensx . cusTo simulster -




Wy —

o

T8 Ll SHh AN RSNNOPE RS &0 0 wEHBE® |
Disconnect from | Record Number |Tool Name Tool 1D UserType  UserID  ECM Time (Key on Time) ECM Real Time
ECcu . Code Description |
Fouit Codos - Signature/ISX - CM870

- CM870
=1 INSITE 9560211112020 Software 95024444 Not Applicable 08-Jan-1996 18:29.62
& mw 000 Unknown
003 Cruise Contre
] ECH Diagnostic 005 Road Speed
009 Maximum Vel
i -B:':mud ECM =2 Compulink 950877770020 Cartridge 23436120 Not Applicable 01-Jan-1996 18:62:22
000 Unknown
Features and 001 Idle Shutdow
Parameters 002 Remote PTO
i 003 Cruise Contre
Selection 83 Echek 950788881020 Cartridge 00000000 Not Applicable 31-Dec-1995 20:42:19
000 Unknown
""“"‘""""‘ 003 Cruise Contre
=4 VEPS CEC000600123 Software 00000000 Not Applicable 31-Dec-1995 19:10:43
B Trip information 002 Remote PTO. [
Bxpand .
H& Collapse To Print :
Pascit Trasl .
Refresh  » Alternate Click
3, i Dt prnt.. and chose Print
raeCion
1 OBD Monitors
@ Connected to ECM, E ﬂ |,-_l,l SignaturaiSX, - CHETD Simulaios j l_




Audit Trail Wrap Up

= The most recent changes will appear
under record number 1

= Multiple changes might be listed under
each of the 4 or 8 records if supported by
the calibration

= Audit Trail will automatically update as
changes are made to the ECM

= User can perform refresh within INSITE™
by using the alternate click and choosing
Refresh

82 1/20/2014 Cummins Confidential Innovation You Can Depend On
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You have concluded this section of the training.

Please click to the next slide and continue or Click Here to return to
the Table of Content.

1/20/2014 e
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INSITE™ Calibration Selection

Electronic Service Tools

Innovation You Can Depend On"



Calibration Selection

Programmable Datalink Device

= The Calibration Selection has been redesigned to
Include a separate section for Programmable
Datalink Device (PDD) Calibrations such as the
Aftertreatment Device or Turbocharger. This will
allow users to bypass connecting to the ECM and
download directly to a PDD.

85 1/20/2014 Cummins Confidential Innovation You Can Depend On c




I3 NS 8.0.0.379

. le Edit View Teols Manage License(s) Window Help
LR FRRI SR (ARBSFEERY O ®«er 1 s SR

iE Digconnect from
I ECM

[510]
(o= ]

|, Data
2 ¥ Monitor/Logger

T ECM Dagnosic Select ECM to download
Abvanced ECM “ Calibrations to an ECM

Select PDD to download
Calibrations to a
Programmable Datalink
Device.

_ 5 Signature/ISX - CME70 Simulator - -



Calibration Selection

Ablllty to update or change the rating of an Engine

'-EH'E £mt_'|'_m1uu= Manage License(s) _'mn.muu
S L eSS s RS o E  BRETIC &y n o PR

- Bty Cormpaiinr Ficshiction D sta
. &T‘W from ? A oy Ciacamber 2013
Fo iy Calbration Workspace (C:\nislect\SITE Cal |
Fault Codes. Lerovo_Recovery (D2
Es i
Ilw.ﬂwﬁ"l.mr = B




Calibration Selection

= Calibration Selection has products sorted into
groups:
— Automotive
— Industrial
— HHP/PowerGen
— Other

Back to What’'s New Agenda e
88 1/20/2014 Cummins Confidential Innovation You Can Depend On



' File Edit View Tools Manage License(s) Window Help

LER | I RR SR MRS cPE BRI IO @ n s BB

:EI[E.'ican:nmm:tfmn

o
E@Fancﬂdm

3|, - Data
o] Monitor/Logger

ECM Diagnostic
Tests

%1 .Bc::ru:adECll

Features and
Parameters

Calibration
Selection

WnrkOr:lars

@ Connected to ECM.

B- E.’:'_J‘ My Computer

E
E

04 cn
]‘ﬁ Calibration Workspace (C:\Intelect\INSITE\Cal

- = Lenovo_Recovery o:y

54 pecaniamcaL 2 )

EI @ December 2013
Automotive

CELECT Plus Ind.
CEMSE

Centinel
CEMTRY

PIM
QsM11
} QEX11.9/15 CM225

4

m |

Next Generation Cense CM2330

b

.E_El" A IE.F;E Signature/ISX - CM870 Simulator

Praduction D ate |

December 2013

Expand each category to
view the calibrations

E| |



B

View Took Managelicensels) Window Help

MBS oPBIBET D= n n 4B =

#- [ 15859650836 CH2180
[ 156 -cus0

ECM Pt Nourmbsen
¥eTA
eI
a4

Picture of INCAL shows
Calibrations are
available on these drives

& =

i uw |

B u 584 - Autodetect Cabbration

B @ 1| (i Calibaation Change History Fle
BRI Active Calbmtion Fle

w [ e

# sy Copy L
E Qe P A
= 0 =0l Fird

& | 15l

& @ sz Cestification Codes

- [ mosoers) s

# [ LG

& Lws

Alternate Click menu




Calibration Selection
Ablility to Select Specific Certification Codes

-
Certification Code Selection I M
Available Cerification Codes Selected Cerification Codes
Certification | Agency Certification | Agency &
CETE ADR-
MAMI ADR Australian Motor Vehicle Cerdif. Board
ADR3 Australian Maotor 2
- | ADRT Australian Maotor
o ARAI AUTOMOTIVE B | N0
4o <
Selected s ——anoreasd  Selected
CAR
Code CARE Califomia Air Re Code
CCNR CENTRAL COM brrerrrrerrrerrrrerreerrhit
Add AI I CCS China Classification Society
CEPA China Environmental Protection Agency
C d e i CHAS
oaes CHIN
<o e ————ERAZILIAN CON R emove
COn4 Brazilian COMAM
CONS Brazilian COMAM A” COdeS
COMA Conama
PR CEMTRAL POl LTION CONTRO ROARD.
1| ] | b 1| ] | b
Please select the certffication codes of interest.
Help QK Cancel
b i X
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Calibration Selection

Calibration Selection
= Search/Find Calibration Note Data

= Sort each Column in Ascending or Descending
order

= Filter Calibrations according to HP, Torque, etc.
= Move Columns to better align Notes

- L
Flnd l . L A =
Find ﬂhat;l Find Mext
Find in: |ECM Code Bl Cancel

» | Direction
Engine Model =
I Match case (jyarket L |Vt'" Up *" Down
Critical Parts List i
5 i - i ci— - — e — — c
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INSITE 8.0.0.379 FT - Signature/ISX - CM870 - Engine Serial Number - 10101010 - ECM Code - AB10040.00 & = —_“_ e @ g

@ File Edit Window Help ®

CHE BEY

View Tools Manage License(s)

¢ 2

ECHM Code  |Engine Model | Market Applicat

3 Dizconnect from
ECM

o8
g@m&ﬂﬁ

4], - Data
I Monitor/Logger

4

@ Connected to ECM.

B- E_’EJ‘ My Computer

-,

=485 Decao13mecaL 2 Y
£ % December 2013

B [ Automotive 5 LINEHALIL
J B5.9G - 15 LINEHALL
C Gas/B Gas Plus Filter 15 LINEHAUL
836 15 LINEHALIL
T 22 BTG [STATS LINEHALIL
Celect 12 B2 AB10S18.06 |5TA15 LINEHAUL
Celect Plus 12 BB ABI042512 |5Ta LINEHALIL
15B5.9 G/ISC8.3 G CM2180 14 E ABT042612 |STA LINEHALL
5L G - CM2130 15 [ 28 AB10427.12 |STAIE LINEHALIL
16 22 AB1042812 |5TAT5 LINEHALIL
15M 17 22 ap10429.12 |57A15 LINEHAUL
1SM - CM870 18 [22 AB10431.12 |5TA15 LINEHALIL
1M - CM75
15M - CMB76 1
- Select filtered value
15M-Fuel Contral Madule -CM570 23 B2 AB1043912 [STA LINEHAUL
15K - CM&T1 24 [29 AB1044012 |5TATS LINEHALIL
SX/ISZ13 OM2150 SN 25 BB AB1044212 |5Th LINEHALIL
26 25 AB1044312 |5Ta LINEHALIL
[5X12G CM2180 83 27 B2 AB10444.12 |5TA1S LINEHAUL
15X12/11.9/15 CM2250 28 [ AB1044512 |5Ta LINEHALIL
15%12/15 CM2350 % 102/%101 29 % AB1044E612 |5TATE LINEHALIL
1515 CM2250 AN 30 B AB14B4.12 |STATE LINEHALIL
31 25 Ap104E512 |5TA LINEHALIL
L Gas Plus 32 B3 AB104BE12 |5TA LINEHAUL
L10G 33 2 ABI0457.12 |5Ta LINEHALIL
Signature/ISK 34 [29 AB1045812 |5TAIE LINEHALIL
Signature/ISX - CMB70 35 25 ABI4B912 |5TATE LINEHALIL
3% 29 AB1045012 |5TATS LINEHALIL
B9 3682729 7 B2 ABI019R17 |5TA1S LINEHAUL
-E¥ 3683289 38 22 4B10204.17 |5TATS LINEHALIL
B8 3684009 39 2B AB1022617 |STAIS LINEHALIL
. a0 [ AB1023317 |STATE LINEHALIL
4] f=y Industrial
)~ &g Industrid M 2B AR10040.04 |STATS LINEHALL
B~ (£ HHP/PowerGen 42 29 AB10041.04 |STATS LINEHALL
[ = Other 43 25 AB10048.25 |5TATS LINEHALIL
g P 44 2B AB10057.25 |STAIS FIRE TRUCK
61\ 45 |22 AB1005825 |5TA15 LINEHAUL
= 46 [29 AB10130.18 |5TAIE LINEHALIL
47 [ 25 AB1M31.18 |5TATE FIRE TRUCK
48 2B Ap1013218 |5TATS FIRE TRUCK
43 BB ABIN3318 |5TATE LINEHALIL
50 (29 AB1020017 |5TA1S FIRE TRUCK
51 29 AB1020017 |5TA1E FIRE TRUCK
52 [ AB10217.17 |5Ta FIRE TRUCK
. W — e |
4 i [ sionaturensx - charo Smulator -

EEI---% Calibration Workspace (C:\Intelect\INSITE\Cal
------ = Lenovo_Recovery O:9

)

=
2

1
2
3
4

ABT097.17
AB10205.17
AB10Z37.17

Ikl vl Il

Select to

LINEHALL
LINEHAUL
LINEHAUL

#754| 0365 hp & 0000 rpm
gzaz| 0400 hp (3 0000 rpm
o204 0435 hp 2 0000 rpm

0450 hp (2 0000 rpri
8513 0465 hp @ 0000 rpm
8522|0475 hp (@ 0000 rpm
4519|0500 hp & 0000 rpm
g2| 05010 hp & 18010 rpm

0525 hp (2 0000 rpm
8519 usauh @ 0000 rpm

00

8285 0950 hp (& 0000 rpm
8285 550 hp @ 0000 rpm
8285/0550 hp @ 0000 rpm

5h 0550 hp @ 0000 rpm
b5 (550 hp @& 0000 rom
bS5 0550 hp @ 0000 rpm
b5 (0550 hp & 0000 rpm

8285 0550 hp (2 0000 rpm
8285 0550 hp & 0000 rpe
8286 0550 hp (2 0000 rpm
8286 0550 hp & 0000 rpm
8285 0560 hp 2 0000 rpm
8286 0550 hp @& 0000 rpm
8285 0550 hp 2 0000 rpm
8285 0550 hp (2 0000 rpm
8286 0550 hp & 0000 rpm
8286 0560 hp 2 0000 rpm
8286 0550 hp @& 0000 rpm
8285 0550 hp 2 0000 rpm
8285 0550 hp G2 0000 rpm
8285 0550 hp & 0000 rpe
8283 0530 hp (2 0000 rpm
8284 0530 hp & 0000 rpm
8283 0530 hp 2 0000 rpm
5284 0530 hp @@ 0000 rpm
8125 0525 hp & 0000 rpe
2127 0525 hp (2 0000 rpm
8281 052% hp & 0000 rpm
8282 0525 hp 2 0000 rpm
8282 052% hp & 0000 rpm
8284 0525 hp 3 0000 rpm
8283 0525 hp (2 0000 rpm
8234 0525 hp & 0000 rpe
8283 0525 hp (2 0000 rpm
8281 052% hp & 0000 rpm
8285 0525 hp 2 0000 rpm
8288 0525 hp @ 0000 rpm

U5ES hp (=0 2000 rpm
(0565 hp = 2000 rpm
(0565 hp @@ 2000 rpm
(0565 hp {2 2000 rpm
(0500 hp & 2000 rpm
(0500 hp & 2000 rpm
0500 hp G 2000 rprm
(0500 hp & 2000 rpm
0500 hp =2 2000 rpm
(0500 hp & 2000 rpm
(0500 hp & 2000 rpm
0500 hp G 2000 rprm
0518 hp @@ 2000 rpm
0518 hp = 2000 rpm
0518 hp @ 2000 rpm
0518 hp {2 2000 rpm
0518 hp & 2000 rpm
0518 hp @@ 2000 rpm
0518 hp (& 2000 rprn
0518 hp @ 2000 rpm
0518 hp {2 2000 rpm
0518 hp & 2000 rpm
0518 hp @@ 2000 rpm
0518 hp (& 2000 rprn
0518 hp @@ 2000 rpm
0518 hp = 2000 rpm
0518 hp @ 2000 rpm
0518 hp {2 2000 rpm
0518 hp & 2000 rpm
0518 hp @@ 2000 rpm
0518 hp = 2000 rpm
0518 hp @ 2000 rpm
0518 hp {2 2000 rpm
0518 hp & 2000 rpm
0518 hp @@ 2000 rpm
0518 hp (& 2000 rprn
(0520 hp & 2000 rpm
0530 hp =2 2000 rpm
(0530 hp @& 2000 rpm
(0530 hp @& 2000 rpm
0500 hp G 2000 rprm
(0500 hp &2 1900 rpm
0500 hp =2 2000 rpm
(0500 hp & 2000 rpm
0500 hp = 2000 rpm
(0500 hp & 2000 rpm
(0500 hp & 2000 rpm
0500 hp G 2000 rprm
(0500 hp & 2000 rpm
0500 hp =2 2000 rpm
(0500 hp & 2000 rpm
UEUU hp @ 2000 rpm

1350 [b-ft (& 1200 rpm
1850 Ib-ft & 1200 rpm
1850 Ib-ft @ 1200 rpm
1850 Ib-ft @ 1200 rpm
1850 [b-ft & 1200 rpm
1850 [b-ft (& 1200 rpm
1850 Ib-ft (@ 1200 rpm
1350 [b-ft (& 1200 rpm
1650 Ib-ft & 1200 rpm
1650 [b-ft @ 1200 rpm
1650 [b-ft (& 1200 rpm
1650 Ib-ft (@ 1200 rpm
1350 [b-ft (& 1200 rpm
1850 Ib-ft & 1200 rpm
1650 [b-ft @ 1200 rpm
1850 Ib-ft @ 1200 rpm
1650 [b-ft @ 1200 rpm
1650 [b-ft (& 1200 rpm
1650 Ib-ft (@ 1200 rpm
1650 [b-ft @ 1200 rpm
1850 Ib-ft @ 1200 rpm
1650 [b-ft @ 1200 rpm
1650 [b-ft (& 1200 rpm
1650 Ib-ft (@ 1200 rpm
1650 [b-ft (& 1200 rpm
1850 Ib-ft & 1200 rpm
1850 Ib-ft @ 1200 rpm
1850 Ib-ft @ 1200 rpm
1850 [b-ft & 1200 rpm
1650 [b-ft (& 1200 rpm
1650 Ib-ft & 1200 rpm
1850 Ib-ft @ 1200 rpm
1650 Ib-ft @ 1200 rpm
1650 [b-ft @ 1200 rpm
1650 [b-ft (& 1200 rpm
1850 Ib-ft (@ 1200 rpm
1350 [b-ft (& 1200 rpm
1850 Ib-ft & 1200 rpm
1850 Ib-ft @ 1200 rpm
1850 [b-ft (& 1200 rpm
1650 Ib-ft (@ 1200 rpm
1650 [b-ft (& 1200 rpm
1650 Ib-ft & 1200 rpm
1650 [b-ft @ 1200 rpm
1650 Ib-ft @ 1200 rpm
1650 [b-ft @ 1200 rpm
1650 [b-ft (& 1200 rpm
1650 Ib-ft (@ 1200 rpm
1650 [b-ft (& 1200 rpm
1650 Ib-ft & 1200 rpm
1650 [b-ft @ 1200 rpm
1850 Ib ft @ 1200 rpm

m
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@ Connected to ECM.

=- @ My Computer

1A, oy

]‘E Calibration Workspace (C:\Intelect\INSITE\Cal
“ = Lenove_Recovery {D:Y)

B9 Deca013mcAL_2 E:)

EI@ December 2013
El @ Automotive
] B5.9G
C Gas/B Gas Plus
C8.3G
Celect
]| CelectPlus
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I5L G -CM2180
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E¥ 3633289
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- [ Industrial
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[ [E5) Other
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o

ECM Code

&B10511.06
AB10512.06
&B10513.06
AB10574.06
&B10515.06
AB10516.06
&B10517.06
AB10518.06

Engine Model

[l

STalG
5Ta1G
STalG
5TA1G
STalG
STa1G
STalG
STA1G

Market
|10

LINEHALL
LINEHALL
LINEHALL
LINEHALL
LINEHALL
LINEHALL
LINEHALL
LINEHALL

| 0550 hp @ 1800 o
B513 0550 hp @ 1500 rpm
8522 01550 hp @ 1500 rpm
B513 0550 hp @ 1500 rpm
8522 01550 hp @ 1800 rpm
B513 0550 hp @ 1500 rpm
8522 01550 hp @ 1800 rpm
B513 0550 hp @ 1500 rpm
£522 0550 hp @ 1800 rpm

0500 hp @ 2000 rpm
0500 hp @ 2000 rpm
0500 hp @ 2000 rpro
0500 hp @ 2000 rpm
0500 hp @ 2000 rpro
0500 hp @ 2000 rpm
0500 hp @ 2000 rpro
0500 hp @ 2000 ipm

1850 b-ft Gz 1200 rpm
1350 Ib-ft (22 1200 rpm
1850 Ib-ft Gz 1200 rprn
1350 Ib-ft (22 1200 rpm
1650 Ib-ft Gz 1200 rprn
1650 Ib-ft (22 1200 rpm
1650 Ib-ft Gz 1200 rprn
1650 Ib-ft (2 1200 rpm

Critical Parts List | Advertized Power at RPM | Governed Power at RPM | Torque Peak at RPM | Application
[ 40)

[&m

AUTOMOTI
AUTOMOTI
AUTOMOTI
AUTOMOTI
AUTOMOTI
AUTOMOTI
AUTOMOTI
AUTOMOTI

4\

Only shows calibrations
with selected parameter

<

L[}

.% g |(§ Signature/ISX - CMET0 Simulator

E| |
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(34 Calbration Workspace (C:\inkelect INSITE\Cal E‘EIE ABID0ZI08 [STATS LINEHALL §127 0500 hp @ D000 DOUbIe C||Ck to
Calibrat SR R eI 8127 0450 @ 000
L
alorations 2R e o secon| transfer selected
available on the CD === 5 s S5 Lot i vy oA
L Bl 5 .II1
% M8 ABINZI0S |STATS LINEHAUL 250 (4750 @ D000 COde to ECM or
ECM Disgnostic [£5 AGH:I:IIIOG_STME: LINEHALL 250,400 by & 0000 -
Tests & @ % \gg ABIONTO8 |STATS  LINEMALL ot 0400 o @ 000D Alternate click
- 29 8 ABI003208 |STATS LINEHAUL 5250 0400 kg @ D000
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] :-mmum.sms LINEHAUL N EShp @00pem  BOp@1900mpn (16506 @ 1200pm  AUTOM
. 3 B ABIM225 |$TA1S LINEHALL 201 0500 hp @000 e (S00ho@2000impm 16504 @ 1200pm  AUTOM
and are not ava”able on ~RK 105 AB1004325 |STA1S LINEHALIL 8281 0S00hp @ 0000 1pen (SO0 he @ 2000 1850 16A @ 12000 ALUTOM
K cMs7f| 41 8 ARI00M4 21 |STATS LINEHAUL 2292 (500 bp @ 0000 (S00hp@2000mm  [16SORA @ 1200me  AUTOM
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T oo ] 45 3 ARIO04R IS |5TATS LINEHALL F21 0525 kg (B 0000 1pen (1500 hp (3 2000 tpen 1650 I-f (@ 1200 AUTOM
- [ 15X12/11.9/15 CM22%0 % E AB10043.26 | STATS LINEHAUL 8251 (400 ko @O000men (400 ho (P 2000 tom 1450 kit 6 1200 1o AUTOM
fusdkt Trall - [ 1SX12/15 CM2350 X1024%101 :; ] g:ﬁug g;ﬁ:g uw:ml. g: m:gmm Transfer To ECM
; 1.25 |5TA LINEHALIL tpen
3 Dot g g:nﬁ::::zs:m 49 f' ABIDDS213 | STATS LINEHAUL 8285 0475 hp @ 0000 rpen Copy
& Inquire L 0 & ABIDDS3V4 |STATS LINEHALL B285 0475 hp @ 0000 rpen Paste
Exraction E- [ ws 51 B AB100S421 |STATS LINEHALL 8285 0500 hp @ 000 rpen _
{!‘\ B[ Sigratures 52 5 ABIONSE13 |STAIS LINEHALIL 8285 0500 o @ 000D rpen A
7\ OBD Monitors il . E3 B ABIDOSE13 |STAIS LINEHALL 8285 0500 b @ 000 rpen )
wr = O Soratreis - a7 5¢ 8 AB10057.25 |STATS FIRE TRUCK H282 0525 e D000 rpen View Replacement Calibrations...
£ xams 55 M0 ABIN0SA.25 |STATS LINEHAUL 8282 0525 hp @ 0000 rpen tvow Comuatible Caibmti
B¥ 3633289 5 9 ABI0059.25 |STAIS LINEHAUL 8282 0400 hp @ 0000 rpen et
B 3 W View Compatible ECM/FCM Calibrations v
_ : 0475 b @ 000K rpen
& g el \ Alternate Click menu 285 01 @Opm | ShowAdheColbatons
H- gy e _ 8286 0500 hp @ 0000 rpen Show Installed Calibrations
- ey Other Bl E AB100B4.27 |STA LINEHALL 5236 0435 he @ 0000 1pen Aoply Custom Fit
= F 62 1 ABI0ESZT |STA VOCATIONAL 8285 (455 hp @ 0000 rpe e —
&l B3 B AB100BE27 |5TA1S LINEHALIL 8285 0435 hp @ 0000 1pen Certification Codes...
= B4 18 ABIN0ET.Z7 [STAIS VOCATIONAL 8235 (455 hp @ 0000 rpen _
65 & ABI00BA11 (STA LINEHALL 8286 0400 hp @ 0000 rpen Print
65 5] AB1006312 |STA LINEHALL 8286 0400 b @ 0000 rpen Properties
67 5 ABIOTDIZ |STA LINEHAUL 8236 0400 hp @ 0000 rpem Fnd
63 W) AB10071.12 |STA LINEHAUL 8286 (450 hp @ D000 rpen
B ABID07212 |STA LINEHALL 8286 450k @000 ipen 040k @ 2000pm  1ESOR@ 1200 0pen  AUTOM
70 E ABI007IN |STAIS LINEHAUL 9285 MO0bp @000 P (AD0ho @ 2000mpm  14500H @ 12000 m AUTOM .
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Calibration Selection
; Read
ECMCaIlbratlon D'cmrnloadWmard — — — . .
_ calibration
Welcome to the Engine Control .
Module(ECM]) Calibration Download // Wal"nlng

Wizard /

arning!

Failures or damage resulting from
unauthornized engine modifications or

horse power uprates, including, but [
not limited to, recalibrations of ECMs

through the ECM Calibration Wizard,
are not covered by Cummins warranty

| Next to continue

or CAP programs.

| Cancel to stop

< Back

Cancel | Help
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Calibration Selection:
Authorization Passwords

Calibration Authorization Password is not required:

— Calibrating an ECM to a newer or older ECM Code
revision

— Superseding ECM Codes
— Calibrating a Foot Printed ECM

Calibration Authorization Password Is required:
— Calibrating a ROM booted ECM
— Changing to a different ECM Code

Authorization can be done by using:
— Fleet Count

— Calibration Authorization Password c
o7 120THese are obtained from' local"distributorg" Pepend On




r - W — -
ECM Calibration Download leardl - e - u
Calibration Authorization y
A Feet Calibration Count is required . .
Information given

—/

The selected calibration has a different ECM code from the one that is cumently detectedin =

the ECM. In order to continue with the Calibration Download, a Fleet Calibration Count is

required . This will reduce the number of Fleet Calibration Courts available. For more Flest

Calibration Courts, please contact your local distributor | - i
| |

Curment number of Heet Calibration Counts available: 0

\ Number of
[T Usze a Fleet Calibration Count

Fleet Counts

If Fleet Count

available, _
Check to use | i cLim240 available to use
Fleet Count i|  Requested ECM Code: CL10033.41 :
) !
= Back MHext = Cancel Hel 'l
— I '\ | £ | - | L

V4

Next to continue or Cancel to stop

98 1/20/2014 Cummins Confidential Innovation You Can Depend On



i ECM Calibration wlcad Wizard ::- -~ uw
System ID and Dataplate ﬂ
- Verfy and/or modify the System |0 and Dataplate information
Can edit Dataplate \\\ .
EMEEEDF | |:
ElEl [ alibration |nformation H
& Calibration Software Phaze O746002C
% Calibration Time/Date Stamp 40213150018
- DO Option
Optlon to Save and % ECM Etudg 1|:T1Enn32_4|3
Restore Adjustable & glt:hglrpf:g:':ms | 11832
parameters. i T -
For Industrial s 7 v o Rdioaeabie Parameias)
Applications this
should not be \
C h EC ked Restore Criginal Yalues
Undo Dataplate edits 1]
< Back | I Cancel Hel
LT e — | // :

99 1/20/2014 Cummins Confidential

Next to continue or Cancel to stop )/ e
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g ™
ECM Calibration Download Wizard® S - - [

Summary
Please verfy that the displayed infformation is comect.
L3
Flease verfy that the displayed information below is comect, then select nexdt. The information -«
below will be used to recalibrate the connected ECM. L
[= CM2250[0]
' Requested ECM Code CL10032.41
. Current ECM Code CL10032.40
. Fleet Calibration Used Mo

@ Calibration Information
[+ Customer Information
[ ECM Information

- Engine Information

| | = System Information

L& Wehicle/OEM Information

Cancel to stop
| calibration download

AN

Next to continue

calibration download \

l
< Back [ Net> | Canca | Help

LT e e — —— —— — e o o e A

Adjustment Confirmation u

-

Adjusting ECM - You are about to make changes to ECM.

While adjusting the ECM, do not change the key state unless instrudted
to do so.

Click Ok to continue the download, or click Cancel to leave the ECN
unchanged

v
Cancel

OK to start calibration download

100  1/20/2014 Cummins Confidential Innovation You Can Depend On




Calibration Selection

-
ECM Calibration Download Wizard - .- [
Calibration Transfer
Please continue when the transfer is complete
L]

A Calibration Download is in progress. Please do not change the key switch state durng download =
process unless instructed.

— CMZ250[0]

Preparing ECM to receive calibration. 10 seconds remaining

oo,

— Calibration Transfer Summary

| -

Progress Bar

< Back [[ Net> |  cancel | Hep |

e - L 3 = — W1 I — I N W > |
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Calibration Selection

* Follow all prompts through the calibration transfer
process until the calibration transfer has been

Click OK

completed.
[ Calibration Transfer Results ﬁ1 [ Key Switch ﬁ1/
/
CM2250(0]

Saving Dataplate Parameters Successful.
I Saving Adjustable Parameters Successful. I
Calibration Transfer Successful.

Restore Dataplate Parameters Successful.
Restore Adjustable Parameters Successful.
| Audit Trail Update Successful.

Turn key off , follow instructions,
then key on and click OK

i = ™
Key Switch / .

—

Action: Watting 30 seconds before allowing for Key On 21 seconds remaining

a0
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Calibration Selection

- _ _ _
ECM Calibration Download Wizard &

-

=

Calibration Transfer
Flease continue when the transfer is complete

process unless instructed.

A Calibration Download is in progress. Please do not chanage the key switch state during download =

—CM2250[0]

Closing ECM.

100 %

N

0 seconds remaining

— Calibration Transfer Summarny

I
] CMZ250[0)
{ Saving Dataplate Parameters Successful.
Saving Adjustable Parameters Successful.
Calibration Transfer Successful.

i Restore Dataplate Parameters Successful.
Restore Adjustable Parameters Successful.
l Audit Trail Update Successful.
< Back Next > Cancel | Help

103 1/20/2014
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Follow
instructions
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Calibration Selection

=

— E_ E = -
ECM Calibration Download Wizard —

-
R e - ﬂ

Calibration Transfer
Flease continue when the transfer is complete

Select Mext to continue.

—CM2250[0]
Closing ECM. 0 seconds remaining
I — Click Next

r—Calibration Transfer Summary

I

CM2250[0]

Saving Dataplate Parameters Successful.

Saving Adjustable Parameters Successful.
Calibration Transfer Successful.

Restore Dataplate Parameters Successful.
Restore Adjustable Parameters Successful.
Audit Trail Update Successful.

yd

< Back [ Nedt>

Cancel | Help

1/20/2014

Cummins Confidential

Innovation You Can Depend On



105

Calibration Selection

ECM Calibration Download Wizard l

-— — = !E1
R - & -

Please select Finish to closs the ECM Calibration  »

Download Wizand

Click Finish to close the
- Calibration Download
/ Wizard window

1/20/2014

Cummins Confidential

Innovation You Can Depend On e




Programmable Datalink Device (PDD)
Calibration Download Capability

= INSITE provides the capability to download a
calibration to a PDD using any RP1210A adapter

= This capabillity is found in the Calibration Selection

= The latest INLINE 4/5 and INLINE 6 Drivers Firmware
are needed to support the calibration download

106  1/20/2014 Cummins Confidential Innovation You Can Depend On c




Lg INSITE 8.0.0.379 FT - [SX12/11.9/15 CM2250 - Engine Senial Number - 79461125 - ECM Code - CL10032.41

File Edit View Tools anage License(s)] Window Hel - &
‘ File Edit Vi Tools Manage Li (s) Wind Help
# <HEBRY
3 Disconnect from
ECM

To download calibrations to an ECM, please select ECM.

ECM

To download calibrations to a programmable datalink device, please select PDD.

FOD

Calibration
Selection

Click on the PDD button.

i_{_l_;\'l OBD Monitors

@ Connected to ECH. _é" ; B |E) INLINES,USB (J1939) Connection j RP1210A (J1839) Firmware: 6.34



Programmable Datalink Device (PDD)
Calibration Download

caibrationseiecion S W

= The Cummins Reflash Utility will close all opened views and disconnect
LE from the engine.

Select OK to enter the Cummins Reflash Utility or Cancel to continue
using the rest of INSITE.

Acknowledge the
warning dialog message.
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e T —
- Calibration Selection

TS0 | n EI
Select Product CA “lume 20137 ; -l
EA\ "December 2013°

Compatible Calibration | &)

Click on the drop down menu to
select the Database Location.

- Reflash Status

1/20/2014
—




Brogrammable
- Calibration Selection

Sedect Database Location [EA "December 2013" | 2]
Setect Product '

Aftertreatment Dhesel Exhaust Controller

Compatible Calibrati Turbe Actustar Contraller

Click on the drop down menu to
select the Product type.

- Reflash Status




~ Calibration Selection
Select Database Location | B "December 2013° = ||
Select Product Aftertreatrnent Diesel Exhaust Controller

Compatible Calibration | &

Beeciing...

Detection Process Progress Bar

- Reflash Status




- Calibration Selection
Select Database Location |E\ ‘December 2013° -2

Select Product | Aftertreasment Diesel Exhaust Controlier

Compatible Calibration 2]
Device Address Desice PN Software PN Voltage Versian

Device Information

Click on Reflash
button to download

o

- Reflash Status




| L3 Programmable Dstalink |

- Calibration Selection

Select Database Location | B "December 2013° - [
Select Product Aftertreatment Diesel Exhaust Controller
Compatible Calibration | &
| Device Address Device PN | Software PN Valtage Version
03D 2080480 5283312 13/ AND 24V 3.7.8
Reflash Status progress bar.
- Reflash Status /
5283312 der =+ 30
| & |
Elapsad Tirme: 01 manutes 48 seconds Remaining Time: 0d minutes 18 ssconds




~ Calibration Selection

Cedect Diatabase Location | B\ "December 2013 :

Select Product Aftertreatment Deesel Exhaust Controller
Compatible Cahbration | &

[ Dewvice Addmess  Dewice P Software P ltage fersion
(w30 5283312 (378

INSITE displays Calibration
Transfer Successful upon
completing the reflash.

Cuenemins INSITE i

|
| Calibration Transfer Successiul.,

- Reflash Status

5283312 .dsr =+ 030
Reflash is completed successfully,
Elapsed Time: 04 minutes 39 seconds

Click the OK button on the
information box.




{4 Brogrammable Datalink Device Reflash Managemen

-~ Calibration Selection

Select Distabase Location | EX, "December 2013" 2]

Select Product |Al’teﬂmalment [wesel Exhaust Controller

Compatible Calibration E

[ Device Address Device PN Software PN Voltage Version
30 2880480 5283312 12V AND 24V 3.7.8

Click on the red X button to close.

i

- Reflash Status

S283312.dsr =+ 30
Reflash is completed ssccesshully.
Elapsed Tirme: 04 minutes 39 seconds




Single key off for multi-module downloads

= INSITE™ only requires a single key off at the end of
a multi-module calibration download

= All ECM Codes to be downloaded can be selected
before the calibration download begins
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ECM Calibration Downiey

Multiple ECM Download
Choose Multiple Module or Single Module Download

IMSITE can aid in calibrating the entire engine contral system. To
calibrate the entire system or more than a single ECM, please select
Calibrate Engine Control System and then MNext. Ctherwise please select
Calibrate Single ECM and then Mesd.

i* Calibrate Engine Control System (Single Key-Off)

" Calibrate Engine Control System (Muttiple Key-Off)

" Calibrate Single ECM \

b

then INSITE provides the guidance to select calibrations
perfarm entire system download with only a single Key-Off
required at the end of the download.

ff calibration Engine control System (Multiple Key-Off) is
|selected then INSITE provides the guidance to calibrate each
ECMin Engine Control System with a Key-Off required after

I download to each module.

if calibration Engine cortrol System (Single Key-0ff) is sel%ed\.n
and

Make a selection and
click Next to begin the
calibration download

Cummins Confidential Innovation You Can Depend On
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ECM Calibration m_gﬂ

Select Calibration
Please Select an ECM Code to be downloaded
L.}

ECMCodeE=pr |FHDptiDn |F'.JEI|::tin:un |Envirnnment |EngineMndeI |EmissiDnLeveI |r\luml:uarEIfI:jI

AREO0Z506  FROGS4S  PJIOGFES  TBD OSKTASO-CE TIER 2

FROB545 | PJOGTES QSKTASOCE [TERZ [ |

1| i | 3

ECM Part Mumber |ECM Code | ECM Serial Number | &ddiess | N\ |
4921776 ARE0040.05 26003952 1

~

¥ Show only compatible calibrations

Select the calibration
and click Next

[ Skip calibration download for this ECM

< Back I ﬁ::— I Cancel Help

Cummins Confidential Innovation You Can Depend On




-

.
ECM Calibration Download Wizard -

Calibration Authorization
A Fleet Calibration Court is required
%

The selected calibration has a different ECM code from the one that is cumently detectedin =
the ECM. In order to continue with the Calibration Download, a Fleet Calibration Court is
required . This will reduce the number of Fleet Calibration Counts available. For more Flest
Calibration Courts, please contact your local distributor | -

Current number of Heet Calibration Counts available: 0

[T Uze a Fleet Calibration Count

Cument ECM Code- _ Select the Fleet
Calibration Count if
required and click Next

Reguested ECM Code: ACGB06S2 00

(4
< Back I MHest = Cancel Help
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[ ECM Calibration Dﬂ_gl

Calibration Transfer
Please continue when the transfer is complete

download process unless instnucted.

A Calibration Download is in progress. Please do not change the key switch state during =«

—CM850[144] Secondary 2

Preparing ECM to receive calibration.

2 seconds remaining

oo

—Calibration Transfer Summary

I
CMa50[0] Primary
Calibration Transfer Successful.

Calibration Transfer
Summary shows the

CME50[1] Secondary 1
' Calibration Transfer Successful.

calibration download
status

I‘ < Back Mewt » | Cancel I Help |

. A — e, e, NN O IR T

Cummins Confidential Innovation You Can Depend On




ECM Calibration ¥ :
- Key Switch o — x

Calibration Transfer
Please continue when the transfer is complete

A Calibration Download is in progress. Please do not change the key switch ¢
download process unless ™ -
Calibration Transfer Results g

—CMB50[144] Secondany CMB50[0] Primary

e Calibration Transfer Successful, e

\ 100 % | |
CMBESD[1] Secondary 1

I Calibration Transfer Successful.
~Calibration Transfer Sumill - p1850[144] Secondary 2

' CME50[0] Primary Calibration Transfer Successful, / CI IC k O K
| Calibration Transfer 5

CMES0[1] Secondary

Calibration Transfer 5
i
| < Back [ et Cancel Help |
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Adjustable Parameters Recovery File

= |f a calibration download fails when Save/Restore
Adjustable Parameters is selected, INSITE™ will

save these parameters to an Adjustable Parameter
Recovery File

= The file can be used by INSITE™ to restore the
Dataplate and adjustable parameters on this ECM If it

IS In a ROM Booted or Foot Printed state on the next
successful download
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Adjustable Parameters Recovery File

. _
ECM Calibration Download Wizard 1

=

Adjustable Parameter Recovery Rle

INSITE has detected an Adjustable Parameter Recovery File for QSK50/60 CM250
MCRS/QSK50/60 CM2150 MCRS that was created when the calibration transfer with
Save and Restore failed on 12-Dec-2013 at 02:10 PM.

IMPORTAMNT: The adjustable parameter values will be restored using the Adjustable
Parameter Recaowvery File.

lUncheck this option to use the calibration default values.

| iRestore Adjustable Parameters using the Recovery File 4’ }
| |

Help

< Back [[ Net> |  Cancel

N

Check the box to
restore adjustable
parameters and click
Next to continue the
calibration download
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Calibration Selection

Calibration Supersession

— Supersession refers to the process of
providing replacement calibrations for
obsolete calibrations

— Superseded Calibrations are not active and
not installed on the INCAL DVD

— Calibration Reduction has generated a large

number of Superseded Calibrations c
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Calibration Selection

Calibration Supersession

—If INSITE has “Show Installed Calibrations” or “Show Active Calibrations”
selected

 Calibration Selection will not display the Superseded calibration
» Auto detect will not find the Superseded calibration

— Uncheck “Installed Calibrations” and uncheck “Active Calibrations” on
Tools menu

* Tools > Calibration Selection or Alternate Click

—When downloading the replacement calibration, first select the
Superseded calibration. A pop-up window will appear displaying the
replacement calibration.

—View Replacement Calibrations
» Tools > Calibration Selection > View Replacement Calibrations
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Fle Edt View Tools Manage License(s) Window  Help

Le iR AR A DS |oPE BE Y

2 & My Computer
B,

View Replacement
Calibrations

Calibration 290245
IS not available on

= -

Q58S 02150 B10A0ERE. T O

Q4. 55, 9. 7 - OMEE0

B mesis
B¥ #2176

& [0 gses-9/+4, 5.9/, 4.5/, 1.9/

Double click ECM
> Code or Alternate
click to transfer to

ECM

sl

B4E6 190 hp (3 2300 rpm
E510 185 ho (2 2500 rom
BS11 250 he 3 2300 rpm
EE10 185 hp (2 2500 e

HUMTFR=Lr
HOM ROAD
MOM ROAD
MOMN ROAD
HOM ROAD
NOMN ROAD
NOM ROAD
NOMN ROAD
NOM ROAD
HON ROAD
MOM ROED
HOMN RQAD
HOM RDAD
NOM AOAD
MON ROAD
MON ROAD
NOMN ROAD
NOM ROAD
HOM FDAD
MARIME

HOM ROAD
MAFINE

MOMNAOAD
NOM ROAD

Teansler To ECM
Copy

Pacte

Select All Calibratiana

Viewi Replacement Calibratien...

Shoew Compatable Celibratsong

Virw Compatible ECMUTFOM Caldbration:

Shoew Actrve Calibratsons
Show Installed Calibrations
Apply Custom Filter
Certification Codes...

Prirt

Properties

Fand

BTSE 108 g (3 2000 rpem
BTSS 130 hp @ 2000 rgen
BTSE 128 hp (3 2000 rpm
BTEE 140 hp & 3000 rom
BTS5 139 hp G 2000 rom
ETS4 121 hp (2 2200 rpen
B7SS 0130 ho @ 2200 spm
BTSS 0152 he @ 2200 pm
B725 160 he (3 2300 rpm
BT 180 hp (2 2400 g
BAEE 220 hp (3 2200 rom
BTSE 128 he (2 2200 rpemy
B7SE 140 he (3 2200 rpm
ETSE 140 hp @ 2200 ren
BTEE 106 g (3 2200 rgem
8756 109 hp (3 2200 rpem
BTSE 128 hp (3 2200 rpen
BES 230 hp (B 2200 rpen
1660 (ME0 he @ J400
510 190 hp @ 2500
TEED DAS0 ho @ 3400 i
BE1T 275 hp (@ 2500 rpen
1700 120 b & 2200 rpm

3 Jew

L8 S8 (J1639) Comnecten

j__ | APIZI0A (J1930) Firswware: 840

240 hp @ 2500 ipm
185 by @ 2200 pm
186 hp @ 2200 pm
275 ho @ 2500 pm
155 hp @ 2000 pm
160 e @ 2000 pm
155 ho @ 2000 pm
155 b (@ 2000 spm
110 hg @ 1800 spm
130 ho @ 1800 pm
108 g @ 2000 ;pm
130 hp (@ 2000 pm
128 bp @ 2000 pm
T4l b @ 2000 pm
138 ho @ 2000 o
121 hp @ Z200 pm
01200 b @ 2300 ipmy
0152 he @ 2200 tpm
160 b (@ TH00 spm
160 he @ 2400 pm
110 b @ V800 i
130 hp @ 1800 pm
108 gy 3 2000 spm
130 bp (@ 2000 pm
128 b @ 2000 pm
140 ho @ 2000 om
178 ho @ 2000 pm
121 hp @ 22300 pm
0130 hpy 6@ 2200 tpm
D52 by @ 2200 upm
160 he @ 300 pm
160 b @ 2400 pm
220 hp @ 2200 spm
13 hp @ 2200 pm
140 bp @ 2200 pm
140 hp @ Z200 pm
109 hp @ 2200 pim
109 b @ 2200 spm
128 hp @ 2200 pm
220 hp & 2200 ipm
(UTS hp (3 3475 epm
190 ho @ 2500 om
475 b @ 3475 ipm
275 hp @ 2500 pm
121 hp @ 2200 pm

B85 b0 (3 1500 ¢
575 b @ 1500 ¢
T30 bl & 1500
575 I}I@ﬁlﬂr-,
T bR (3 1500
T3 b 1500
E95 bR 3 1000+
547 b (2 1500
T3l 31500
450 bl (3 1500
524 b8 3 1500 ¢
A0 B G 1500 ¢
4E0 B (3 1500 ¢
360 bl 3 1300
400 B8 B 1300
IBERE10
457 B8 3 1000
400 el @600 ¢
432 bk 31500 ¢
372 eh G 1800
37 BH @500
0857 b @ 1500
0405 bt @ 1500
4ED b 3 1500
450 b 1500
350 bm 31300
400 Bef 313001
I3 b0 (315001
457 i (B 1600 ¢
400 Bl 3 1000 1
43 bR E 1500
I A (3000
W7 bl @500
0457 b @ 1500
0405 b4 @ 1500
4B0 bl (3 1500
A i R 1500 ¢
700 B0t 3 1500
357 b0 18000
A3 bR @ 1600 ¢
433 bl (@ 1600 ¢
33 bk @ 1500
33 b0 315001
3T b4 3600
00 Bl (3 1500 ¢
030 bA @ 2200
520 b-h (21500
0340 b & 2200
T30 bl @ 15001
W bRE10r -

L]




Calibration Selection

Selected Calibration that
was not available

-
B Calibration Superseded l ;- Sl T g
— L . apes——— ) -

The selected ECM CaHbration has been superseded.

m. | »

: l: Superseded caljrations below are grayed out and not available to be transferred to an ECM.

The first rgflacement calibration in the list has been highlighted. Another replacement calibration may

| |ECM Code wgine bodel | Market | Critical Parts List | Advertised Power at RPM | Governed Power at APM | Tar ||
MNOMNEOAD 86171( 260 hp @ 2400 rpm 260 hp @ 2400 rpri el |
29007010 BRJALE MWOMROAD 8611 260 hp @ 2400 rpm 260 hp @ 2400 rpm Far |
| | 29007210 EETAW MWOMROAD 8611 280 hp @ 2400 rpm 2B hp (= 2400 rpm Far |
Z90454.08 EBTAL MHOMROAD 8611 280 hp @ 2400 rpm 2B hp (@ 2400 rpm Al |
\ .
- - ]
| |

| | Replacement Calibration .

L[] 1 r
|
|
|
|

Click OK To ECM to
continue calibration

transfer with replacement
ECM Code
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PowerMatch calibrations are now
able to be sent using INSITE

—The PowerMatch calibration will be based on an ECM
Serial number and will only download to the specific
ECM for which it was created

—Calibration download attempts to different ECMs will
produce a warning message and will end the
calibration download process

INSITE - Calibration Selection

The PowerMatch calibration was not generated for the connected ECM, Please ensure the ECM serial number matches the connecked ECMLINSITE wil
) niot perform the calibration download.

................................

.................................

O’&‘v
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Calibration Selection Wrap Up

— Calibration Download is used to update the ECM
— Calibration Selection

» Contact local distributor for Calibration and/or Calibration
Authorization password

* To view Superseded Calibrations, uncheck “Installed
Calibrations” and uncheck “Active Calibrations”

— Use Calibration filtering to reduce number of
Calibrations listed

— Calibration Authorization Password is required for
uprating or ROM Booted ECMs
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You have concluded this section of the training.

Please click to the next slide and continue or Click Here to return to
the Table of Content.
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Connections

Additional Connections/Simulators can be
added.

—Add new...
—Tools - Options = Connections

—File & Connections - Add New Connection...
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Connections
File
General
All i
Inguire Data Extraction | fEL I Emulatnrl
Units of Measure

MName

User Manager INLINES,USB (J1939) Connection

Work Orders INSITE Integrated Simulator - Single M.
INLINES, USE {Auto Detect) Connection  Disconnected
EZ TAP COM7 - Auto Detect - RP1210A Disconnectad
EZ TAP COM7 -J1939 - RP1210A Disconnected
INLINESR, USB {J1539) Connection Disconnected
Signature/15X - CME70 Simulator Disconnected
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Auto Configure

= The Auto Configure feature is updated and
Improved to identify not only Cummins adapters but

also other third party RP1210A compliant datalink
adapters
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136

ECM Connection Wizard — Auto

Configure

ECM Connection Wizard PE|

Welcome to the ECH Connection
wWizard

The ECM Connection *izard will guide wou through creating a
cohnection ko a Datalink Adapter ar ECK Simulatar,

To continue, click Mext,

Cancel |

Click Next to
continue

1/20/2014
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Configure

ECM Connection Type

ECM Connection Wizard ‘

Please select a connection that will corfigure INSITE to use your Datalink Adapter and

Se I eCt Auto \ computer configuration.
Configure N x

& A ito Configurei

Connect using the detected datalink adapter

i~ RP1210 Adapters
Connect using a RP1210 adapter

" Legacy Adapters
Connect using an INLINE/IMLINE I/INLINE 1I

 Simulator
Connect to a simulated ECM through a virtual port

ECM Connection Wizard — Auto

’f

Click Next to
continue

<Back Next> e |
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ECM Connection Wizard — Auto
Configure

ECM Connection Wizard

Auto Configure
Pleasze zelect Start far INSITE ta autoratically detect and canfigure a connection.

Inztruchons

11 Enzure the Datalink Adapter driver iz ingtalled.

21 Enzure the adapter iz physically connected to 241333 ar J1708
FOI IOW the / communication network, the key switch iz on and the adapter iz powered up.
Instructions, <
then Click Start

Help <Back | | Cancel |
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Connection Auto Configure

ECM Connection Wizard

Auto Configure
Pleasze zelect Start far INSITE ta autoratically detect and canfigure a connection.

Inztruchons

11 Enzure the Datalink Adapter driver iz ingtalled.

21 Enzure the adapter iz physically connected to 241333 ar J1708
communication network, the key switch iz on and the adapter iz powered up.

Pleaze wai. ..
Attempting to detect an AP12104-compliant adapter. .

Help | |
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Connection Auto Configure

ECM Connection Wizard

Auto Configure
Pleasze zelect Start far INSITE ta autoratically detect and canfigure a connection.

Inztruchons

11 Enzure the Datalink Adapter driver iz ingtalled.
21 Enzure the adapter iz physically connected to 241333 ar J1708
communication network, the key switch iz on and the adapter iz powered up.

Click Start to
restart the

Click Detalls
d for more
information

Auto Configure

Auta Configure process was successful,

D etailz

Start

1 Click Next to
continue

Cancel |

Help <Back
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Connection Auto Confiur

ECM Connection Wizard |£|

Auto Configure

IMSITE haz detected the following configuration(z]. Please select the desired configuration
and select Mest.

. Device
Wendor Device esipion Fuort Supported Protocollz]

S e I e Ct th e E USE Port | Unavailable

connection

[

[£

. Click Next to

continue
|

Help <Back.
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Connection Auto Confiur

ECM Connection Wizard [Z|

Connection Hame:
Specify connection name

The information dezcribing your connection iz grouped together az an ECHW Connection
and labeled with a name you provide.

Fleaze enter a name far the new connection.

Connection Mame:

Click Next to
continue

Help <Back. Mext: Cancel
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Connection Wizard

= The connection wizard is updated and simplified for
the easy selection of RP1210A compliant datalink
adapters and connection tests within the connection
wizard
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ECM Connection Wizard

ECM Connection Wizard PE|

Welcome to the ECH Connection
wWizard

The ECM Connection *izard will guide wou through creating a
cohnection ko a Datalink Adapter ar ECK Simulatar,

To continue, click Mext,

Select Next to

continue the
/ wizard

Cancel
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Updated ECM Connection Wizard

EEM Conrecian i ‘

S

ECM Connection Type

Please select a connection that will corfigure INSITE to use your Datalink Adapter and
computer configuration.

{~ Auto Configure
Connect using the detected datalink adapter

Connect using a RP1210 adapter

" Legacy Adapters
Connect using an INLINEAINLINE I/IMLIME 11

" Simulator
Connect to a simulated ECM through a virtual port

/
Help <Back Mesd >

Cancel |

b . e

Click Next to
continue
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Updated ECM Connection Wizard

RP12 10A Datal | n k ECM Connection Wizard ‘

Adapter Vendor list Connection Settings
Wl I I b e d | S p I ayed |f Please select the specific Connection Settings based on the system configuration.

the corresponding
. Vendor

adapter drivers are \\

. |<F‘Iease Select a Vendor: ;I

installed. Select the e

Datallnk Adapter Cummins Inc. INLIMEG

Vendor

Cummins, Inc.

Protocal

| 2

[ratalink Adapter Connection T est |

Heut: Cancel
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Updated ECM Connection Wizard

ECM Connection Wizard

Connection Settings

Yaou can choose the specific Connection settings based on the configuration af waur
computer.

D atalink Adapter Wendor

| Curmming [ne.

Lo

Select the \ Dratalink. &dapter

I Lo |<Select an Adapter:
Datalink Adapter Q SdctonAdie
Computer Part

; IMLIME 4/5

Dratalink, Protocal

S5 |

=l
My
Wt

Help <Back | |

Cancel |
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Updated ECM Connection Wizard

148

Select the
computer port

1/20/2014

ECM Connection Wizard

Connection Settings

Yaou can choose the specific Connection settings based on the configuration af waur
computer.

D atalink Adapter Wendor

| Curmming [ne. j
D atalink, Adapter

o] |NUNES |

Computer Part

(3 | <Select a Part: j

<Select a Paort:

D atalin 023 Comrmunications Part [COM1)
Communications Part [COR 3]

=§;,’;=' [ALTD Oetect =]

Help <Back |

Cancel
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ECM Connection Wizard

Connection Name

Connection Hame:
Specify connection name

The information descrbing your connechion 1z grouped together az an ECM Connechion
and labeled with a name vou provide.

Pleaze enter a name far the new connection,

Connection Mame:

Test Connectior] /

<Back Mew

Cancel |

Type name for
connection

| g

Select Next to
continue the
wizard
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Completing the ECM
Connection Wizard

ECH Connection Wizand P§|
— Select to make
Completing the ECM Connection the new
Wizard ]
The ECK Connection Yizard has successfully configured the / conn eCtI on
riew connechion, actlve
After you close thiz wizard, you can uze thi nechion at any
time by zelecting it from the Co fonz List at the bottom of
the screen.
Select to

¥ iTo make this connection active, select this box and ther

ick Finish create
[ To setup anather connection, select thiz box and then anOther

Pleaze select finizh to exit the ECh Connection wizard.

Select Finish
@ack [ Finish <——rammer— to conclude

wizard
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Connection Wizard

Fle Fda View Took Menagelicensslil Window Halp
PERR IR SA NS o EET D=8y e PR

Coosrwrmesrs T LW

W Fault Codes.

o Dtk
(o Mbenit o Lisgoes

Connection
wizard shows
automatically

New
Connection is
active

B [ s oraad Camacen o] |
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Datalink Adapter Connection Test

ECM Connection Wizard

Connection Settings
Fleaze select the specific Connection Settings based on the zysterm configuration.

D atalink Adapter YWendor

|Eummins [, ﬂ
D atalink Adapter
(o] [INLINE 5 |
Cormputer Part

(3) | UsE |

D atalink Frotocol CI ICk On Datal | n k

=?3= |.-'-‘-.ut|:| Detect ﬂ Ad apte I
Connection Test

| Diatalink &dapter Connection Test @ T |

Help <Back Mexts Cancel
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Datalink Adapter Connection Test

Datalink Adapter Connection Test : /l Click OK |

L] E Please verify that the Datalink Adapter is connected ko an ECM an
-

=iitch is on.

Cancel

Datalink Adapter, Connection Test [z

Status bar showing the
connection status

Testing ECM Connection configuration settings. .. please wait.

I —

Click OK

\‘l‘) The Datalink Adapter is correcthy configur
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Connections

Select the desired Connection Type
—INLINE 5/6, RP1210A or Simulator
—Will open a Connect Window

If previous connection type selected
—Tools - Connect to ECM
—Ctrl+E
—Connect to ECM icon on the View Bar
—Connect to ECM icon on the Tool Bar
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Tools Manage License(s)

Beaary O&®ae » o0 H B

Connect to ECM Ct
Disconnect ECM Connect tO

Login a Mew User ECM
ECM Passwords... Optlon

ECM Password Removal...
PowerSpec...

Reset Datalink Adapter

Connect to
Calibration Selection EC M

Data Monitor/Logger .
option

Trip Information

Connect to Connect to
ECM ECM

=F 1 Extraction

,"'*':1' 1 OBD Monitors

@ No ECM Connected. : ] | INLINES,USB (J1938) Connection v-



Connections

Connect

Security Tvpe: Master ;I
ECM Password: kskokoh|
Conneck Cancel Properties Help
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Engine Simulators

—INSITE can Simulate connections to all supported
engines
e Celect Plus, ISX, ISB...
* Almost Full Simulated tool Functionality
« Can be used for training or exploring Engine Features

« Data is simulated and may not represent actual engine
data

— Simulator can be used to learn INSITE and Engine
features without being connected to an Engine
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Connections Wrap Up

—Make sure the desired connection Is
selected

—To connect to ECM
« Use Ctrl+E as a shortcut to get connected
* Use the View Bar icon

* Tool Bar icon to connect
» Click on Tools = Connect to ECM
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You have concluded this section of the training.

Please click to the next slide and continue or Click Here to return to
the Table of Content.
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Data Monitor / Logger

Method to view or log live engine data at a
user defined sample rate.
= Monitor data:
* View selected parameters to display
*|og data:

« Continuous logged data for each parameter
selected and saved to a file for analysis

= Snapshot:

 Single data point logged for each parameter
selected and saved to a file for analysis
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| INSITE 8.0.0.402 - Signature/ISX - CMB70 - Engine Serial Number - 0 - ECM Code - ABL0400.23 T o e S

E—-hﬁEiIe Edit View Tools Manage license(s) Window Help |-||E‘||x

LRI ERSRIABRS BB BRI @0 1 0 ER
Farameter Groups |; . Minimum Maximurn|
Disconnect from
Ay Pon - Predefined Pararmeter Yalue|Units Measured Measured
: All Parameters Apoelera’ror Fedal Position Sensor 000y 000 000
~ ECM Informatio Signal Yoltage
 EGR and Turboc arger | |Adjusted Tire Size BO1 revs/mi b01 B01
""" Performance Ajr Conditioning Pressure Switch On
...... Engine Braking Amber Warning Lamp Status On E
...... Engine Protection Anti-theft Status Unlocked
...... Hard Start é Barometric Pressure 24.3 InHg 243 243
...... Lamps Barometric Pressure Sensor Signal 000y 000 000
------ Low Power and Fuel kconomy _ Woltage ' ' -
- " | Battery Voltage 13381V 13.81 15.88
Parameaters \ | Brake Pedal Position Switch Depressed M
B SignatureflSX - CM870 Calibration Software Phase 06060001
~# CM870 Camshaft Position Sensor 0 RPM a
Camshaft Position Sensor State Low
Clutch Pedal Position Switch Depressed
Cruise Control ONOFF Switch off
Ceica Dontral Ser L Loc)me Switch Neutral
Parameter Groups available [___ ’ ‘
for some products to allow
common monitors to be Not Avay
: ESLUre 2.0 2.0
. selected quickly. o arenr
SEL?\OBD Monitors T i 0.00 0.00
: The Upper and Lower limit columns have been modified to
Click once to open Data ) . :
: display the Minimum Measured and Maximum Measured
Monitor/Logger : :
values read by INSITE while the parameters are being
monitored.
Engine Brake Switch Level 0 Percent a 0
Engine Coolant Level Error i

@ Connected to ECM. .r i ! ID INLINES, USB (J1839) Connection j RP1210A (11838) Firmware: 6.40



INSITE 8,0.0.402 - Signature/ISX - CM870 - Engine Serial Number - 0 - ECM Code - AB10400.23 {0 |

3 File Edit View Tools Manage License(s) Window Help |_ ||5‘|| x|
CER| LR SRIAIRDS I« PBIBRYIO|@e > n n ER Z
Farameter Groups | - : Minimum taimum| =
Disconnect f i =
:gIEC“ rom - Predefined Parameter Walue| Units Measurad Measured
All Parameters Accelerator Pedal Position Sensor 000y 000 000
2@@&@ - ECM Information Signal Voltage ' ' '
llllll EGR and Turbocharger | |Adjusted Tire Size BOT revami 501 501
Performance Ajr Conditioning Pressure Switch On
...... Engine Braking Amber Warning Lamp Status On E
...... Engine Protection m Anti-theft Status Unlacked
...... Hard Start 2 | Barometric Fressure CI 243 243
- - ick on the arrow
. — Lamps Sgg‘gstnc Fressure Sensor Signall - 000 000
¥Data | Low Power and Fuel Economy <
— '1Baﬁery\/ol’rage to ShOW/HIde the 13.75 13.94
Features and Parameters ' [ | Brake Pedal Position Switch |eft CO| umn m
= Signature/ISX - CM870 Calibration Software Phase
Calibration ~= GM8T0 _| | Camshaft Position Sensar O RPM i] i]
Solenti =
ection g Accelerator Pedal Position " || |Camshaft Position Sensor State Low
Work Sensor Signal Voltage Clutch Pedal Position Switch Depressed
Orders Adjusted Tire Size Cruise Control ONJOFF Switch Off
Air Conditioning Pressure Cruise Control Set / Resume Switch Neutral
ﬂm" Information _ Switch _ Current Miles On Tires 0 mi 0 0
8 Amber Warning Lamp Status || pjagnosic Test Mode Switch aff
Audit Trail Anh—‘rheﬁ_ Status Driver Reward State Mone
gam"‘e?fc ireSSUfe = ECM Time 145809 HH:MM 5SS
¥ Inquire Data g Darometnic rressure wensor EGR Cooler Efficien Not Available Percent
Bxraction 8 Signal Voltage . . o
= EGR Differential Pressure -2.0 InHg -2.0 -2.0
: Battery Voltage EGR Differential Pressure Sensor
ﬂii\,osn Monitors Bra_ke P_edal Position Switch Signal Voltage 0.00W 000 0.00
Calibration So_ﬁ_ware Phase EGR Flow Derate Active
gams:a: EOS!I!O" 29"5‘” EGR Ternperature 32 °F 32 32
= Camshaft Position Sensor -
State \E/STF;gTsmpera‘rure Sensor Signal 517 516 517
CIUt_Ch Pedal Position Switch EGR Valve Position (Percent Open) 0 Parcent 0 0
Cru_lse Control ONJOFF EGR Yalve Position Comrmanded 0 Percent i] i]
Switch EGR Walve Position Sensor Signal
Cruise Control Set / Resume Voltage J 0.00Y .00 0.00
= Switch - - Engine Brake Output Circuit 2 Inactive
Current Miles On Tires ; o ;
- - Engine Brake Output Circuit 3 Inactive
Diagnostic Test Mode Endine Brake Switch Level 0P i 0 0
= Switch ng!ne rake Switch Leve SrCen
Driver Reward State i Eng?ne C_)oo!anT Level Error i

@ Connected to ECM.

_"il g |{:) INLINEG, USE (11938) Conngction

j RP1210A (11938) Firmware: 6.40




|5'Eitﬁﬁt[- S — S
(vBw| i:hn R A REFMofBEBETYT D & n S8 &

Disconsect Paramater Grou A Mininniim Masdrnum
Bes e Engine Bmi:ings i Valde|Unis Measured Measurad
o Engine Protection
F = Faull Codes Hard Start
Lamps
L Mortion/Lagasr Low Power and Fuel Economy
Sensors
bie E:;m Swilches '!
White Smoke and Engine g
Adwanced ECM Stumble =
Outa Custom | -
m-:ﬂ Parameters Remutnoe from Monton/Logges Alte rn a.te C I I Ck
7 Signatre/ISX -CMET0 | cmehiewGoup. <— and select Create
Calibration - CMBT0 | EditGroup.
BU— s Acoslerator Pedal Postion Delete Group-. New Group
SEﬂE‘:‘r Slgﬁi "'-"t:ﬂfag& | Fename Group.
@mm Adjusted Tire Size | Espotto Fil
i B Air Conditioning Pressure Sw|  Impont from File.
Expand
Amber Warming Lamp Status R
- Anfr-ineft Status _
il Barometric Pressure Set Samphing Rate.
incpire Dels Barometric Pressure Sensor i Event Marker Setup_.
A Voltage Start Graphical Monitering
Battery Voltage
OBD Mordon Brake Padal Posion Swilch
Calibraton Software Phase
Camshaft Poshion Sansor
Camshaft Postion Sensor State
Clutch Padal Position Switch
Cruisa Control ON/OFF Switch
Cruisa Contral Set | Resume
Switch
Current Miles On Tires
Diagnostic Test Made Switch
Drvar Raward State
ECM Time
FRRE Manlar Fffiranes

i. Cannacted 1o ECM. 3 i [g MUNEE USE (1193%) Connecion 3 | RPIZIBA{J1639) Frmwire 6.40




-

Name new group

Create Parameter Group

Create Custom Group

:.IEIQ

Fleaze enter the group name below. l

Group Mame: Il:ustl:um Group 1
Select parameters or groups on the left, and click "Add" to add to the group.

Select parameters on the nght, and click "Remowve' to remove from the group.

Ayvailable Parameters | -
i [=] Signature/|5 - CME70 |:|
= CME70

Arocelerator Pedal Pozition
Senzor Signal Voltage

Select Add to add
parameters to
new group

Group Parameters |
=l EM570

Accelerator Pedal Pogition
Senzar Signal Yalkage

- Adiusted Tire Size

Adjuzted Tire Size

ditioning Pr

<- Remove

Arnber Warning Lamp Status

- Air Conditioning Pregzure Switch

Anti-theft Statuz
Barometric Pressure

R armrmetie Pressire Sensnr

Help |

Cancel |

Select desired

parameters for
new group

Select OK to
continue
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INSITE 8.0.0.402 - Signature/ISX - CM870 - Engine Serial Number - 0 - ECM Code - AB (=T e S|
=¥ Fle Edit View Tools Manage License(s) Window Help [-[=]x]

LR iR SR AIRS cFBIBRY O e > 1 s 5P

Disconnect from |- Parameter Groups | * Pararneter Value| Units Minirmurn Maxirmum
ECM - Engine Protection Measured Measured

- Hard Start f-\_ooelerator Pedal Position Sensor 000y 0.00

g@ Fault Codes || Lamps Signal Voltage
* Low Power and Fuel Economy | | kelkecieWENEeIRERS ch | O | | |

Data || Adjusted Tire Size BOT revsimi 501
Morgtor/Logger Sensors |

- Switches
ECM Diagnostic | White Smoke and Engine el
Tests Stumble z

B Ad iecm | Custom

5" T —

| &

Features and
mm Parameters
[E Adjusted Tire Size
Calibration = Alr Conditioning Pressurg
Selection Switch
Amber ¥arning Lamp Status
Work Orders Antitheft Status Desired
Barometric Pressure L
ﬁ Trip Information Barometric Pressure Sensor Signal paramete rs for
Woltage
| pc o Battery Voltage Custom Group
Brake Padal Position Switch NeW Custom
"} Inquire Data Calibration Software Phase
Bxtraction Camshaft Position Sensor g rou p
] Camshaft Position Sensor State
ﬁi\om Monitors Clutch Pedal Position Switch

Cruise Control ON/OFF Switch

Cruise Control Set f Resume
Switch

Current Miles On Tires

Diagnostic Test Mode Switch
Driver Reward State

ECM Time

EGR Cooler Efficiency

EGR Differential Pressure

EGR Differential Pressure Sensor
Signal Yaoltage

EGR Flow Derate

i
1/20/1 Ola{"ﬂ Trrmmmr— Foare
T —— P4 _r f g IE) INLINEE, USB (J1338) Connection j RP1210A (11939) Firmware: 6.40




Data Monitor / Logger

Setting the Data Monitor / Logger sample rate.
= Select Tools - Data - Monitor/Logger - Set Sampling

Rate
~ OR:Alternate E Set Sampling Rate E3
Click in Data Monitor/Logger =
While not S
Monitoring or Feal Time
Logging + |ser Specified Rate (1 sample in ... 0
Log Data . 1 o= hour -
Start/Resume - _“_1
minutes
QK secands
Print milliseconds

Remove All Parameters
Set Sample R.ate c
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E-'Ie Edit Miew Took ManagelLi

PeR LN SR M DSNFE BEY R N omE B
Parameter Groups 8 . Minirmur Maxdmum
Dizconned from ]
ECM Engine Protection ete va]ue_unns Measured Measured
Hard Start Accplerato\PedaN osifidhg Sen
Fault Codes Lamps Sigijal Voltake 000V 0.00 0.00
Low Power and Fuel Economy Alr Ponditionig Pres\ure On
m,w Sensors
Switches
TT_j ECM Diagnoatic White Smoke and Engine -
fets Stumble Stop
TR Advanced Ecu |~ Custom
bata :
Features and Parameters = Pau Se LRI
Parameters - ire Si Log Date
[zl Adjusted Tire Size _
Calibeation = AIr Conditioning Pressure Start/Resume
Selection Switch Pause
Amber Warming Lamp Status : Start/Resume S
() Wok orders Arttitheft Status Print
Barometnc Pressure iad»d: A;Gtsrc Up.-
to Group...

@ Connected to ECM.

Barometnc Fressure Sensor Signal
Waoltage

Log

Battery Voltage
Brake Pedal Position 3
Calibration Software P

Snapshot

Camshaft Position Sensor
Carmshaft Position Sensor State
Clutch Pedal Fosition Switch
Cruise Confrol ONJDFF Switch
Cruise Confrol Set f Resume
Switch

Current Miles On Tires
Diagnostic Test Mode Switch
Driver Reward State

ECH Time

EGR Cooler Efficiency

EGR Differential Pressura

EGR Differential Pressure Sensor
Signal Voltage
EGR Flow Darate

B M Tarsesred iem

Alternate Click Menu
for Monitor Options

Remove Parameter(s)
Remove All Parameters

Set Sampling Rate...
Event Marker Setup...

Start Graphical Maonitoring

-
S [ s, uss (01939) Connection

E| |_nﬁzm (J1939) Firmware: 6.40



Data Monitor / Logger

Saep [Gln = =@

Converting a Log file for
external use:

—Generate a Log File o
— Save the Log File s e —
 INSITE prompts to save once Stop Emt View Tools Window Help
has been selected in Data e
) pEn... Chrl4iD
Monitor/Logger Close
Save Ctrl+5

* The log files or the snapshot files are
saved as Comma Separated Value

Expart

(CSV) files -
 This file is saved to the hard drive in Connections
the C:\Intelect\Insite\Logs Directory o
or to the drive INSITE is installed Frint... Cirk+P
« User Comments can be added to the ST,
Log File Exit
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Data Monitor / Logger

—Log file contains:

INSITE Professional 8.0.0.402
Cummins Inc.

Data Log Information
Start Date and Time: 17-Dec-2013,11:05:54.441

Total Log Time: 00:07.7
Source Log Filename: C:\Users\AME\AppData\Local\Temp\\DML-20131217-110553.log
Destination Path C:\Intelect\INSITE\Logs
SamplingRate: 1 seconds per sample
Comments:
Customer and Vehicle Information
Customer Name: Bart Starr
Vehicle Unit Number: 123456
Engine Information
Model: STA15
Serial Number: 0
ECM Part Number: 3684009
Date Time Accelerator Pedal Position Sensor Signal Voltage (V) Adjusted Tire Size (revs/mi) Air Conditioning Pressure Switch  Amber Warning Lamp Status
17-Dec-13 05:54.5 0 5010n On
17-Dec-13 05:55.5 0 5010n On
17-Dec-13 05:56.9 0 5010n On
17-Dec-13 05:57.9 0 5010n On
17-Dec-13 05:58.9 0 5010n On
17-Dec-13 06:00.2 0 5010n On
17-Dec-13 06:01.2 0 5010n On
17-Dec-13 06:02.2 0 5010n On
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Data Monitor / Logger

Data Monitor / Logger Limits

= The Lower Limit and Upper Limit column titles have been replaced with "Min
Measured" and "Max Measured”

= The Min Measured column now contains the minimum value observed for
each parameter during an open Data Monitor/Logger session.

= The Max Measured column now contains the maximum value observed for
each parameter during an open Data Monitor/Logger session.

= The Out of Range Parameter window will no longer be used and has been
removed.
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Data Monitor / Logger

Increasing the font size in Data Monitor/Logger:

—Select Tools - Options and select Appearance under the
General settings

Options

| = Select desired
Eillaennectluns Appearance FO nt S i Ze
-| General

Appearance Text Optians Se I eCt M Od |fy

] IsnssgzyData E straction f—'«udit Trail
o Audit Trail Columng
Authorization Pazsword | [1ata Manitor/Logger
ECM Pazzword Remova
Flzet Calibration Countz
Unitz of Measure
+ Uszer Manager

N

[z

gef.ground Colors

Fant style:

FEH_ ~
Work Orders Adit Trail Columnz i Fiegular | ok |
Audit Trail Highlights w S Sans Serif A
- & M5 Seri — italic Leied
| WS Ul Gothic Bald
Select Data olors Q B MT Exba Bold Italic 14
- () 1 Bal = 18
Monitor/Logger [ 4 P NSimGun 24
it Trail Columnz () Palating Linohype b
rttata Monitor/Logger b
Effects Sample
Current Selechion I:I [~ .
[ Strikeaut
AaBby
[ Underline Bz
Sample Tes Colar
R E=ck - Script:
L% | £ |Western

Ok, ‘ Cancel | | Help ‘
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Data Monitor/Logging

= An event can be marked while logging in the main
Data Monitor / Logger screen, or when in Graphical
Monitoring, by pressing the spacebar

= This provides the option to enable or disable the
Event Marker as well as providing the option to
create comments for event markers

= The Log file contains the Event Marker Description.
For more information on Data Monitor/Logger, refer
to Data Monitor logger module on slide 20.
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(3 INSITE 8.0.0.802 - Signature/T5X - CMBT0 - Engine Serial Mumber - 0 - ECM Cofe - ABL0400.23 g —— - e |, | Y | g
a File Edt View Tools Mlnagn License(s) Window Help =158 x
pow i hbR|SdRADS I aRPEB BEY @ e nmER®
SR | o G i [ vao s o —
- e
. All Parameters Accslerator Pedal Position Sensor 0.00 vV .00 0.00
M8 Fout Codes ECM Information 2| BLSignal Voltage '
EGR and Turbocharger i Adlusted Tire Size 001 Jrevs;ini
& Dt Performance Alr ':’Cﬂdm':rﬂlng Pressura Switch on
% Engine Braking Arnter Warning Lamp Status On E
717 ECM Diagnostic Engine Protection Antitheft Status Unlocked
= Tests Hard Start ! Earometric Pressure 243 InHg 245 243
i _— Lamps L Earometnc Pressure Sensor Signal 000V 0.00 001
158 Data Low Power and Fuel Economy _ o 9139¢
- Battery Voltage 1388V 13.76 1594
Features and Farameters * || Brake Pedal Position Switch Deprassed I
Fan Control Command Calibration Software Phase 06060001
Calibration Fan Control Switch sition Sensor 0 RPM 0 0
Selection & Fuel Shutoff YaM Dpata Monitor/Logger : Enter Event Description. =+
% Gear-Down Pro o
@wﬁm = Govemnor Type Phease enter your description below for: Event 1
Idle Validation Sy| |**""
Q. Trip Information o Intake Manifold 0 0
Temperature
m\,ﬂ Trot Intake Manifold
Temperature Se M-S
. Voltage . . :
K % Inquire Data EGR Cooler Efficien Mot Available Percent
-5 Extraction & Intake Manifold Pressure . : L4
. EGR Differential Pressure -2.0/InHg 20 20
g Intake Manifold Pressure EGR Differential Pressure Sensor
41 OBD Monitors Sensor Signal Voltage Signal Voltage 0,00V 0.00 0
%1939 Broadcast ! Eg e [.‘rgar e e
= 41939 Engine Control EGR Temperature . . b 30
" Source con e .| Event Marker with numeric
/1939 Engine Control Vetaas P 7 5.17
Status vorage and user entered . 5
o J1939 Engine Source s ':'5_ .nnt . .
Address EGR Valve Position Co descr|pt|on 0 0
J1939 Retarder Control EGR Valve Posifion Sel - Y T 0.00
 Source Voltage
o J1939 Retarder Control Engine Brake Output Circuit 2 Inactve
Status Engire Brake Output Circut 3 Iractive
- J1939 Stop Broadcast Engine Brake Switch Level 0| Percert 0 0
Sourna Address Dne Engma Cﬂolant Level Error I

g 5,! }a INLINES,USB (11538) Connection

j-nmmmmsam Firmmware: 6.40




Data Monitor/Logger Graphical
Monitoring

= Graphical Monitoring is a way to display, log, print,
and save data for up to six parameters in a graph

= Graphical Monitoring visually monitors and plots
multiple parameters into a graphical display

175  1/20/2014 Cummins Confidential Innovation You Can Depend On c




3EII: Edit  View ]'_wls Manage License(s) Window |Help

Pl &SR A DS oPEB BE Y & @ r s ERE

Parameter Groups 5 ' Minirnum Maximum, -

- Predefined O R Measured  Measured
All Parameters Accelerator Peddl Position Sensor 0.00 Vv 000 0.00
ECM Information _| | Signal Voltags '
EGR and Turbocharger | |Adjusted Tiry/ Size 601 revsimi 501 501
Performance Air Conditigning Pressure Switch Oon

Armber On E

Engine Braking
Engine Protection
Hard Start
Lamps

-

Low Power and Fuel Economy

arnirg Lamp Status

Ant-thrft St
Eargphetric Pressure
L EBagyometnc Fressure Sensor Signal
4"hltage
"~ [ /Battery Voltage

Parameters

& Governor Type

Fan Control Command
Fan Control Switch

& Fuel Shutoff Valve

& Gear-Down Protection S

Idle Validation Switch
o Intake Manifold Air

|- 7 Erake Pedal Position Switch
Calibration Software Fhase
Camshaft Position Sensor
Camshaft Position Sensor State
Clutch Pedal Position Switch

Cruise Control ONOFF Switch
Cruise Control Set / Resume Switch
Current Miles On Tires

Click on the icon or
right-click to start
the graphing -

Temperature Diagrostic Test Mode Switch
Intake Manifold Driver Reward State
Lzrl?ggéature Sehsor Signal ECM Tirme
EGF‘. Cooler Efficien
& Intake Manifgld Pressure Differential Pre?;ure

Differential Pressu
bl Woltage

Temperature
Temperature Sensor Signal

== Valvie Position (Percant Opan)

Address

Source

Status

@ Connected ta ECM.

P J1939 Engine Source
o J1939 Retarder Control
= J1939 Retarder Control

o J1939 Stop Broadcast
Soume Address Dne

EGR Valve Position Commanded
EGR Valve Posifion Sensor Signal
Yoltage

Enging Brake Oufput Circuit 2
Engine Brake Output Circuit 3
Engine Brake Switch Level
Englna Coolant Lewvel

Lnlocked
245 InHg

0.00 v

1381V
Depressed
OE0G0001
0/ RFPM
Low
Depressead
Off
Meutral
0O/
Oft

Snapshot
Log Data
Start/Resume
Pawse

Stop

Print

Save As Group...
Add to Group...

Remove Parameter(s)

Remewve All Parameters

Set Sampling Rate...

Event Marker Setup...

Start Graphical Monitoring

243
0m
1594

Mone

t Available Percent
-2.0 InHg

0.00 v
Active

32 °F

1TV

0| Percant
0| Percent

0.00 v
Inactive
Inactive
0 Percent
Error

= 5,,! |-QNLHEEUSB{J1QGQitmnachm

:I F|.P121IJAH'IS3E] Firmware: 6.40

HH:MM:55

=20
0.00

32
517

.00

2.0
0.m

32
517

0.00
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i ——— ———

— Parameter Selection

Select parameters for graphing on the left and click "Add". To remove parameters from the “Selected Parameters™ list, select -

parameters on the right and click "Remove”. Only 6 parameters can be selected for graphing. Click “Import” to open an existing log

file. -

HLorailable Groups - Selected Parameters
» ~[= Predehned |:| Accelerator Pedal Position Sensor Signal Voltage
i = All Parameters - Adjusted Tire Size
.= CMETO0 SLL=E Ajr Conditioning Pressure Switch
I Accelerator Pedal Position Sensor . Amber Warning Lamp Status
|| R, Adjusted Tire Size Anti-theft Status
----- Air Conditioning Pressure Switch Bar{:mﬂtri{: Pressure Sensor Signal Voltage
------ Amber Warning Lamp Status
(IR Anti-theft Status
N e Barometric Pressure Sensor Signal
N (| Barometric Pressure -
L L i | 3 | Add or Remove parameters
] Sampling Rate (1 Sample in ... to be graphed
Select the
; 1 : seconds -
sampling rate = =l
and click OK
I Import
|
QK Cancel Help

|

177 1/20/2014 Cummins Confidential

Innovation You Can Depend On



[ INSITE 8.0.0.802 - Signature/15X - CMBT0 - Engine Serial Number - 0 - ECM Code - AB10400.23 -

now i hbe SRRl o BERY D) = r i ERE

5Ellt Edit View Tooli Manage License(s) Window Help H EE]

Parameter Groups < ' Minirmunm Marirnurn
Disconnect from }
= Predefined PRSIV — “easurad| Measured
All Parameters Accelerator Pedal Position Ser
Faul Codes ECM Information || |signal Voltage The graph can be e o
EGR and Turbocharger " |Adjusted Tire Size | mpo rtEd or s aved 501 501
& Data Performance Air Conditioning Pres p
Monitor/Logger . .
Engine Braking | —
TT_] ECM Diagnostic Enging'=3 INSITE - Data Monitor Logger - Graphical )
Hard 31, | Edt  View Grophing Help
i Advanced ECM | Import Log Fils 4E A= It
| Swttﬂsl“im.lrt F— - 13.94
Featunes and Save/Export File
Paramet ers
Print Preview - 'ba_rcmmngﬁegsueﬁwit
Calibeation Print o 0 0
_ — “Aenbar \nfarning Lamp Status” 1
Exit -
1| — “Anli-thaft Status® |
00
200 -
=— “Adjusted Tire Size” |
Trip Irnformation 0 0
10.0 |
00
Entrnﬁ;nha @ = “Accelerator Pedal Pesition Sen |
sor Signal Voltage” 2.0 20
OBD Monitors 100 T Fressure SerserSia 1B 00 0.01
32 32
17 617
J1939 Engine Source reen 0 0
4 s ddress EGR Valve Position Commandead 0 Percent 0 0
= 1939 Retarder Control EGR Valve Position Sensor Signal 000V 0.00 0.00
Source Voliage o _
5 11939 Retarder Control Engine Brake Output Circuit 2 Inactive
Status Engire Brake Output Circuit 3 Inactive
o J 1939 Stop Broadcast Engine Brake Switch Level 0 Percent Q [}
= Source Address One _ | |Engine Coolant Level Error
@ Connected to ECM. E :! ! |ﬁ HLNES USE (J1535) Connection j l— RP1Z10A (J1933) Firmware: 6.40

m
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INSITE 8.0.0.402 - Signature/ISX - CM870 - Engine Serial Mumber - 0 - ECM Code - AB10400.23 =& | &
35 File Edit View Toocls Manage License(s) Window Help |- ||£'|| x|
2Rl i 2RSSR MRS | <cFBIBRY O)@e > n = ERB

Di from | Parar‘r_we’rer Groups |; Parameter value| Units Minirnum Maxirum| -
ECM |E‘ Predefined tMeasured Measured
: All Parameters Apoelera‘ror Pedal Position Sensor 000y 000 00
;%Fancﬂdu - ECM Information _ | |Signal Voltage
EGR and Turbocharger “| |Adjusted Tire Size BOT revs/mi 501 501
m " Performance Ajr Conditioning Pressure Switch On
orflegger | Engine Brakin AmberWamm Lamp Status £
q q 9 p
ECM Diagnostic - En == IMSITE - Data Monitor Logger - Graphical Dlspla)r P _I__—-_lg Jl-_
Tets .. Hg File Edit View Graphing Help L 24.3 243
| Advanced ECH | Lal) W+ «laalnr D d sk 3E 0.00 0.01
a e Lo L
- Signature/|SX - CMETD | 1375 13.94
Features and (== 10.0 — b
Parameters . ] == “Air Conditioning Pressure Swit
] ch” L
gg‘;‘;ﬂn D.B—: “Amber Warning Lamp Status” - 0 0
_- ] Exit Graph | | 3
] = "Anti-theft Status”
Work Orders 1002 L
51{).1}—_ Do you want to save the log file before exiting? = "Adjusted Tire Size" i
ﬁ Trip Information ‘= I 0 0
@2 Il W L
?ﬂ E 500.0 7 Yes | Mo | Cancel L
=\ Audit Trail
{E| ral ] L ; _P\ . J L
"} Inquire Data 100 *Accelerator Pedal Position Se |
- = — Erator gl Fosimon T
Extraction sor Signal Voltage” i 20 o0
. = D.B—- = “Barometric Pressure Sensor Sig i
720,080 Montors ' - ral Voltage 0.00 0.01
J ]
-10.0 - | ] R
=} 1200 a0 1400 \ Message pops up 32
= 517
= B 12— when you attempt O
- alve Position (Percent Open
- J1939 Engine Source
Y address g EGR “alve Position Commanded to C l O S e th e g rap h i
EGR “alve Position Sensor Signal 1 1
511939 Retarder Control 9 without savi ng 0.00
Y Source Voltage
.J] 939 Retarder Control Engine Brake OUTpUT Circuit 2 T e
Y Status Engine Brake Output Circuit 3 Inactive
J1939 Stop Broadcast Engine Brake Switch Level 0 Percent 0 0
* Source Address One Engme Coolan’r Level Error il

@ Connected to ECM.

il' :ib IE) INLINES,USB (11838) Connection

j RP1210A (J1939) Firmware: 6.40
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INSITE 8.0.0.402 - Signature/ISX - CM870 - Engine Serial Number - 0 - ECM Code - AB10400.23 - I =& | =X
3{ File Edit View Tools Manage License(s) Window Help |_ ||E‘|| x]
Rl i 2RSSR MRS | cPB BRY O)@e > n = EB

Di § | Farameter Groups |; ; Miriraurm Maxirnurm| =
:EIEC" rom = Predefined Parameter Yalue|Units Measurad Moasured
— All Parameters gpoelle{/atﬁr Pedal Position Sensor 0.00Y 000 000
2@%&@  ECM Information | ignal Voltage
EGR and Turbocharger ~ | |Adjusted Tire Size 501 | revsimi 501 501
m """ Performance Ajr Conditioning Pressure Switch On
orflogger | Engine Braking Amber Warning Lamp Status E
ECM Diogrostic | E{/22 INSITE - Data Moritor Logger - GraphicalDispay ...x:"_::'—tgl_l_J-_
Tets | H3 File Edit View Graphing Help | 243 24.3
 Advanced ECM | L3l m|+ «l@@lh M@ HEa&R = 0.00 0.01
a e Lol |
- Signature/|SX - CMBT0 | 1375 13.94
Features and Pa L4
Paramet 100 )
- J:: Save Log File ﬂ Pressure Swit
Calibration ] - | o .
Selection 0o ] Choose log file format Lamp Status i
Work Orders -10.0 L File Formats 3
51{”}_- B {* Electronic Graph File(*.elf) ze" |
ﬁ Trip Information 1 —E ” Comma Separated File[" csv) or Tab Delimited File(" bt) | 0 0
& 500.0 —{F
Audit Trail I
E L -
) 10,0 3
¥ Inquire Data 1 | Position Sen
= ] 2.0 2.0
. = 0.0 == “Barometric Pressure Sensor Sig
Si{fl\_'JOBD Monitors . 1 nal Voltage™ 0.00 001
100 — == — — I | |
b 2100 2150 2200 \ 2250 2300 | 32 32
4 eSS | 547 517
= btatus ! I I s
J]g3g Engine Source Select the format and 0] Percent a 0
= address I k S 0 Percent 0 o
; J1939 Retarder Control CliC ave 000 000 000
* Source
, J1939 Retarder Control Engine Brake Output Circuit 2 Inactive
Y Status Engine Brake Output Circuit 3 Inactive
J1939 Stop Broadcast Engine Brake Switch Level 0 Percent 0 0
P J
= Engme Coolan‘r Level Errar

@ Connected to ECM.
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INSITE 8.0.0.402 - Signature/ISX - CM870 - Engine Serial Mumber - 0 -

ECM Code - AB10400.23

ﬁ; File Edit View Tools Manage License(s) Window Help |_||5|||x|
e SRIAIRS o FB BEY T ®e > n = FER
from Parame’rerGroups |; Pararmeter “alue| Units Minirmum Maximum| +
= Predefined teasured Measured
E All Parameters gpcelleﬁtﬁr Pedal Position Sensor 000y 000 o0n
- ECM Information | Ignal volage
EGR and Turbocharger | |Adiusted Tire Size BO1 revsimi 501 501
B, Data | Performance Alr Conditioning Pressure Switch on
Honitor - Engine Braking Armber \Warning Lamp Status On 3
Ec" Diagnostic | Er 25 INSITE - Data pa . -EKF:M = F;e S, _Q_MHM__
ests gl File Eat \ T '_' | 243 243
[g] ivarceazcm | Laf ) W[ o] @) 7| « Intcect » INSTE » Log: ~ [49] | Search Logs Pl 0.00 0.01
% Data - Lol o . New fold - @ |
= e e § | 1375 13.94
Features and Pal 10,0 — B Desktop “ MName Date medified Type |
o T 4 Downloads T bning Pressure Swit
Calibration 1 5l Recent Places Mo items match your search, . - - 0 5
Selection oo - fning Lamp Status L
_. ] 4 Libraries ) I
Work Orders 00 ] @ Documents = ftatus L
5.”}:0 1 Ji Music ) |
) ) ] [ Pictures re Size” |
ﬂ.ﬁlp Information E ] E Videos | 0 0
1&g sooof L
7 ] L
? Audit Trail _ M Computer
c {8 Local Disk (C:) I
100 — oy -
|3 Inquire Data ] ' Lenove_Recoven Pedal Position Se
Bxraction % DVD RW Drive (E: = < | ] ot | F 0 50
- = 00 File name: G-DML-20131217-113618.elf - | |Pressure Sensor Sig
S_{;’XOBD Moritors ] 000 001
1 Save as type: [El.ectmni.c Graph File(*.lf) v] |
-10.0 % |
) ' Hide Folders Save ] [ Cancel ] L 32 52
| \ _) IS | 517 517
¥ Status ™ 7 - T '
,J1939 Engine Source EGR Valve Fosition (Percent Open) 0 Percent 0 0
® address EGR ‘alve Position Commanded 0 Percent 0 0
. J1939 Retarder Control EGR ‘alve Position Sensor Signal 000y 000 000
* Source Voltage
. J1939 Retarder Control Engine Brake Output Circuit 2 Inactive
* Status Engine Brake CQutput Circuit 3 Inactive
J1939 Stop Broadcast Engine Brake Switch Level 0 Percent a a
* Source Address One Engme Coolan‘r Level Error il

@ Connected to ECM.

é ﬁ IE) INLINES,USB (1193%9) Connection

j RP1210A (J1938) Firmware: 6.40
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Data Monitor / Logger
Wrap Up

— Data Monitor/Logger provides a means to View,
Log or Snapshot live engine data

—Log and Snapshot files can be saved as a CSV or
Tab delimited (.txt) files for analysis in Excel

— The Data Monitor/Logger appearance can be
modified through Tools = Options to display data
In a larger font

— Graphical Monitoring is a way to display, log, print,
and save data for up to six parameters in a graph
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OBD Monitors

= The OBD system monitors components that
can affect the emission performance of the
vehicle

= Displays a map of all available fault codes with
associated monitor type and its readiness
status.

= OBD Monitors are never cleared from this view
= User can refresh the view
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INSITE 8.0.0.402 - ISBe4 (4 and 6 cylinder) - Engine Serial Mumber - 15012345 - ECM Code - AP10040.00

',1} Eile Edit View Tools Manage License(s) Window Help

Bee| iR SE AR
MIL ON Distance

@ Connected to ECM.

Sl PB| BEY DO @&e»n s HBE=

(Al Faults) Refresh
MILON ino (o View oif
Fault Code Description Monitor Type Readiness Code
o145 Enne Coolant Tomperaturs | Soneor et -Vollage | Amblent M Temporaiute Semsor ot Complet
Intake Manifold 1 Pressure Sensor Circuit - Voltage above| Catalyst Outlet Temperature Sensor
0122 normal. or shorted to high source Rationality Check Trip Status Complete
0432 gﬁ?ﬂ?g;ﬁg;?%ﬂ or Lever Idle Validation Switch Circuit - Er;?]iirt]gr(_}r?izlasr:;:{fsmperature In Range Complete
Monitor Type Distance the vehicle has
Definition driven with the MIL ON
Completed = The vehicle has completed
two trips in which the specified
fault has not reoccurred.
Not Completed = The vehicle has not
yet completed two trips in which
the specified fault has not reoccurred
g i |5 15Be4 (4 and 6 cyinder) Simulator ~l
Cummins Confidential Innovation You Can Depend On A
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You have concluded this section of the training.

Please click to the next slide and continue or Click Here to return to
the Table of Content.
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ECM Diagnostic Tests

= ECM Diagnostic Tests window displays tests
available for the connected engine

= Each Engine supports different ECM
Diagnostic Tests
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3 INSITE 8.0.0.407 - Signature/ISX - CMETD - Engine Sevial Mumiber - D - ECM Code - ABIO0023 e o Tl s ———— e =
i.;'fll: Edit View Tools Manage Licersefs) Window Help = | 2|

Welcome lo the ECM Diagnostic Tests Wizard.

This wizard helips you through the steps nesded to run a0 ECM Ciagrostic Test.
To continue, select a test from the kst below and press: the Nead button.

| = Signature /15X - CM&70

Cylinder Cutput Test

Cyiinder Performance Test

EGR Valve | Turbocharger Operation\Test
EGR Valve Test

Engine Stabe Monibor

Fian Orverride Test

Imjecter Chadk Valve Diagnostios Test

SA&F 11839 Datalirk Control Test

Setup for Dymamometer

Swatch and Sensor Imtermetient Connechion Test
Turbecharger Actuator Test

Double Click the test or

Select the ECM Diagnostic Test
and then click Next

@ Connected to ECH i J MES) MLIKES, LISH (11238 Conneclion b RF1210A (11938) Frmware: 5.40
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Cutout Cylinders

@ Connected to ECM.

189

1/20/2014

Engine Statistics:

‘

Follow the instructions in
each ECM Diagnostic Test

me [ s |

e ] | INLINES,USB (J1938) Connection v!m’"?"m (41938) Firmware: 6.40
Cummins Confidential Innovation You Can Depend On N




i IMSITE 8.0.0.802 - Sig 25K - CMETO - Ergine Senal Number - 0 - ECM Code - AB10800.23 e W

LeR | iR SRiaRSfoRfB BRY D iser n s AR R

)

S Faut Codes

L

n-mmnmnummmn:ﬂmrm
L
4. Lock Engre Fan in the: peston..

1f the engre stalks, or commurcation with the ECM i lost durng test operation, the lepswech must be cyded 1o restone cylinders i
ther sctive state,

Click on Show to open the instructions
In a new window

Connecied 1o ECM B ) e wunes usa (1099 Consecten < [ AP12104 11938 Frmware: €40
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ECM Diagnostic Tests
Wrap Up

— Each Engine supports different ECM
Diagnostic Tests

— Follow the directions of each test carefully
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Advanced ECM Data

= Advanced ECM Data window displays the special
features available for the connected engine

= Each Engine supports different special features
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INSITE 8.0.0.402 - Signature 15X - CMETD - Engine Serial Number - 0 - ECM Code - ABL0S00.23 [ it -

- Eile Edit Yewew Tools Managelicensefs] Window Help T
W e " & & i A O R ST & @ » s WP =
T

= CMEBFD
8 | as1t-The t Protection
B Fault Codes Duty Cyde Monitor
Engine Abuse History
Engine Protecton
Engine Torgue History
it Mairtarance Maritar
Real Time Clock This fepture & nbended for use varth the AoadRielay system. In order to start an engine that is seoeed vash an ané-Sheft password fhe operator must first enter & matching
L7 ECM Diagnostic SAF 11575 Multipleysd password usng the RoadRelsy system. Passwords must corsst of six numeric characters,
i Tests Fault Data
SAE JEF39 Powertran
i Ad { ECM Contral
1 Fassaords | Stahs | Enter Passward:
Pasoword 1 Disabled li
Password 2 Disabled |
Features and Fassword 3 Disabled
Farameters Fassword 4 Disabled : | ; |
Password & Desabled
C son Pasoword & Disabled
Salection

- e Follow the instructions

I Vehude Anhb-theft

| e
%Mﬁﬂ
E ¥ Inguire Dals Q
" Extraction Heb

Select the special feature
supported for the engine

@ Connected o ECU ) P |2 minies usa (11828) Comnectan = RPI2104(J1538) Firmware: .40
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Advanced ECM Data Wrap Up

— Each Engine supports different special
features

— Follow the directions of each feature
carefully
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You have concluded this section of the training.

Please click to the next slide and continue or Click Here to return to
the Table of Content.
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Fault Codes

— Fault Codes window displays an engine's fault
data

— Fault Codes include both engine faults and engine
protection faults

— Each fault is represented by a Cummins fault code

* Indicates a specific malfunction or abnormal
condition within the controller, subsystem, or
engine

— Ability to link to Fault Information System for
Troubleshooting Information
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- - Engine B -
Edit WView Toals Manage License[s) Window Help
el 2B S0k sl Bf oFB ES YD

& 3 0= H RS

Select
2 Fouit Codes Fault Codes

Alternate Click
Menu — Use to Clear
Inactive Faults

= g:-nuﬂ:u =
* Fault Code Status Count  |Lamp  Description /ﬁ'ﬂ SID J1587 FMI | J1939 FMI 5PN -
Features and Fault Parameters First Last  Units ~
s = CMa70 ECHM Time 162110 HH:MM S5
Calibration Engine Hours Q0000 HH:MM. S5
; Keyoffs 29
EGR Valve Czorol Circuit - Current below
Bperd II Circuit - Voltage above
il T wiormation # 00195 Active 1 Collapss to high source 111 3 3 11
' Pieset Inactive Faults * srature Sensor Circuit -
=0 0263  Active 1 Reset All Faults mal. or shorted to high 174 3 3 174
Reefresh Al
pssure Sensor Circuit -
ncuirn Deta 00128 Active 1 Sont nal. or shorted to low 102 4 4 102
Print
) ir Circuit - Voltage below
0014 Fﬂ:—m:m . to low Source 100 4 4 100
o Fuult Trees Troubleshooting Steps re Sensor Circuit -
=0 0144 Fault Trees Index lvml, or shorted to high 110 3 3 110
SAE 11939 Multiplexed Fault Data
Intake Manifold Alr Temperature Sansor
Amber Circuit - Voltage above normal, or shorted to 106 3 3 106
. . high source
Lin kS to Fau It In fO rmation Amber Oil Temperature Sensor Circuit - Voltage 176 3 3 176
ove normal, or sho o source
Amber Barometric Pressure Sensor Circuit - Vollage 108 A A 108
below normal, or shorted to low source
Turbocharger #1 Compressor Inlet
#0069 Active 1 Amber Temperature Sensor Circuit - Voltage above 3 3 172 -
‘| i |
@ Connecssd to ECM, g J e wnies uss (1138) Connectan - I_FIPIIWA [J15389) Frmware: §.40
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File Edit View Tools Managelicense(s) Window Help

28| s 2R SR MBS IcFEBIEEY T ®e > 1= SR

Click and hold on
the top bar to resize
Fault Code Window

* |Fault Code Status Count |Lamp |Description PID SID [J1587 FMI |J1939 FMI |SPN -
Features and Fault Parameters | First Last LInits
o = CMBT0 ECM Time 16:24:48 HH:MM:SS
Calibration Engine Hours 0:00:00 HH:MM 5SS
Selection Keyoffs
Work Orders
ECM Time
ﬂ]’ﬁp Information Unlocked l:LjJnlr:)cke
' ) Air Conditioning
| Auct Tred Pressure Switch @7\ on
) Barometric
mi?a Pressure 243 24, InHg
Eaftery Vaoltage  13.81 1388 W
,& OBD Monitors Brake Pedal Depresse Depress
Position Switch d ed Cl . k + .
Clutch Pedal Depresse Depress IC on Sl g n to
Position Switch | d ed
Eroise Corte see Fault Snapshot
. Off Off
ON/OFF Switch d ata
Diagnostic Test Off Off
Mode Switch
EG R Differential 20 20 InHg
ressure
EGR Temperature 57 57 °F
EGR Vale
Position (Percent 0 0 Percent
[ TaT=Tak! i
< | ] | »
@ Connected to ECM. T ) IE INLINES, USB (J1938) Connection - -RP121DA(.I1939:| Firmware: 6.40
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=:.'|I=
H e = [ &

=] (70-fc145) C
=] (70-fc1519E
=] (70-fc153 I
=] (70-fc1543 I
=] (70-fc155 In
=] (70-fc1a7) =
=] (70-fc1951 E
=] (70-fc195-2
=] (70-fc195-3
=] (70-fc1961 E
=] (70-fc196-2
=] (70-fc196-3
=] (70-fc1971 E
=] (70-fc2129 C
=] (70-fc213 C
=] (7O0-fc214) E

?

= (70-fe1 I 0V

LS

% Pressure Sensor

Intake Manifold Pressure Sensor Circuit

Intake Manifold Intake Manitold
Pressure Return \ / Pressure Signal
Y

=y
1

44
47

Intake Manifold

Intake Manifold

ECM

Hide Back Fonward Refresh  Print
Contents lﬁearch] Favu::rjtes] Overview
= {3 Troubleshooting
E] (70-fc111) E CODE REASON EFFECT
= T0-1c122 |
E] (70-tc123) Ir Fault Code: Intake Manifold Pressure Sensor Circuit - Engine
%j (70-fc131) £ 122 shorted high. High signal voltage detected at | power
%E;gﬂggi FID: P102 the intake manifold pressure circuit, derate
= -1C . .
=] (70-fc1341 R EEII\JSE g
=] (70-fc1351 E iy
=] (70-fc1419E LANP:
=] (7O-1c143) E Amber
=] (70-fc144) C SET:

7 N
Pressure +5 Volt Supply Engine

Harness




Fault Codes Sorting

= Fault Codes can be sorted by either the column, or
by right click for multiple column sorting

= The Fault Code data can be sorted by clicking on the
column header for a single column sort

= The data will be sorted based on the selected column
In ascending order. Click on the column header again
to resort the data in descending order

Note: Sorting can only be used on the Fault Code,
Status, Count, or Lamp columns

Back to What's New Agenda c
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I ™SITE B.0.0.402 - Signat ‘ 3 Nuemib
Fle Edit View Tools mmg.elmmm Window Help
LEE| LR SR AR ol B BEETID e 0 AR

II:’ .Eltwnu-ﬂ fram
ECM
'#Fu Codes
Diata
Mol o/ Lipger
ECM Diapnostic
Tests
w ECM —Sort by
* |Fault Code Status Count Lamp  Description
Fault Parameters |First  |Last | Units [status | % Ascending
= CMET0 ECM Tirre 162110 HHMM:SS " Descending
Enging Hoursg 00000 HHMMES
Feyoffs ~Then by
v EGR "u"ahrr- f"nrtrul Glr uit - Cu '
oL i I
=0 0195 f o« Descending
Trp Infommation
Reset [nactive Faults —Then by
=2 0263 Active 1 Rieset Al Faults _
Puscht Tradl I{”"”E} LI & pascending
Eefresh All
" Descendi
% Inquire Data =0 0123  Active Bat SCeEnding
Frent oK I Cancel
113080 Montrs ©00141  Active Fauk Trees Oveview
Fault Trees Troubleshooting Steps
=2 0144  Active Fault Trees Index al. or shorted to high 110 3 3 110
SAE 115929 Multiplexed Fault Data
Intake Manifgld Air Temperature Sensor
=0 0153 Active Amber  Circuit - Voftage above normal. or shorted to 106 3 3 105
high sour
. . erature Sensor Circuit - Voltage
176 3 3 175
Right- click to select Sort  |femal. or shorted to high source
. tric Pressure Sensor Circuit - voltaga 4 4 108
and sort by OpthﬂS ormal. or shorted to low source
tharger #1 Comprassar Inlet
I‘ =0 0691 Active 1 Amber Temperature Sensor Circuit - Voltage above 3 3 1mi.-
i n [ b
@ Connected to EEM. E i ! [E HLINES, S8 ¢11930) Connection j.ﬂi‘l!‘l“lﬂiﬂ] Firmware: &.40
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Fault Codes Wrap Up

= Fault Codes window shows active and
Inactive Fault Codes
= Alternate click

— Link to Fault Information System for
Troubleshooting information

— Clear Inactive Faults

= Links to Troubleshooting available in the
Fault Information System
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You have concluded this section of the training.

Please click to the next slide and continue or Click Here to return to
the Table of Content.
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Features and Parameters

*Allows licensed user to make changes to
ECM settings

=Each Engine family may have a unique set
of Available Features and Parameters

=Parameters are a subset of Features

=*INSITE™ lists Features and Parameters in
one view - allowing multiple adjustments
at once
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i INSITE 800402 - Signature/I5X - CMB70 - Engine Serial Number - 0 - ECM Code - AB10400.23 L_|_"

.Fie Edit Wiew Tools Manage Licenseis) Window Help

EE | RSP A BS oRB BRI &y 0 s ER
Disconnect from | CE81UMES and Paramelers ECM Valug Unils Original Value =
"' = Signature/ISX - CMET0
- 2 CME70
@ System ID and Dataplate
Data « i@ Accelerator Interock Disable
~ihe Moniter/Logger » il Adaplive Cruise Disable
T EcM + i Adjustable High Idle Governor Speed
= Tests « il Adjustable Low Idle Speed
. — 7 i Baltery Voltage Monilor Disable
il Data = @ Centinel Oil System . Disable
o « i Cruise Control Alternate CI ICk Enable
Parsmeters = @ Cruise Control Switch Setup |\/| enu
) “ @@ Driver Reward Disable
Sedection “ i@ Engine Brake Confrol Disable
1 Engine Coolant Level Sensor Installed
@m&m - @ Engine Protection
o Fan Control
i, Trip Information + i Gear-Down Protection —
« i@ Governor Type Send T r
E\u Trail i ldle Shuldown Expand e
) =g J1939 Controls Collapse
=71 Extract o « i Load Based Speed Control Restore Origanal Value
# i Mainlenance Monilor Restore All Qviginal Values E
4|y OBD Manitors = @ Powerirain Protection Riefresh v
« i PTO/Remote PTO mits
# i Remote Accelerator [nsable
“ @ Road Speed Governor
“ i SAE J1939 Mulliplexing Disable
+ @ Starter Lockout Disable
« @ Switched Maximum Engine Operating Speed Disable
= i Tire Wear Adjusiment Disable
+ @@ Transmission Sefup
= #4 Trip Information Enable
“ @ Vehicle Eleclrical System Vollage
= &4 Vehicle Speed Sensor Anti-Tamoering Enable -
o Connacted o ECH, =) Y] [ vumes usa (11538) Connectan | [ RP12104 (11938} Frmware: 6.40
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i INSITE 8.0.0402 - Signatire/ISX - CMBT0 - Engine Serial Mumber - 0 - ECM Code - AB10400.23 L___“

.FI'E' Edit Wiew Tools ManageLicensels) Window Help
W | Y PSR A RS o B B2y D) e » n s BB &

Cisconnedt from | [ E8lUres and Paramelers i ECM Value Units Original Value =
ECM : Expand Al

1

Collapse All
= CMET0 i
= Fauill Codes -+.S]F‘stﬂl‘l Alt t CI_ k { Auto Size Column
] fasta Seze All Columns
i+ il Acceld ernate IC Betore Al Cricinat Ve Disable
- - 1 L1 mgina WS
Mot ear /L osgpgeor = @ Adaph Menu |S dl'ﬁ:erent | » ? Disable
. « @ Adjus ] . = :
L} el
o) e .‘.Mjusfl when on Title Bar of
. =il Batt Disable
| AdvarcogEcu | 8 Batter Features and Disable
e Parameters-This Enable
Parameters - ags
gives the ability to Disable
Selection Disable
Expand all o
T Work O Features
Enable .
P, T Information i @l Gear-Down Proteciion Disable
: = i Governor Type
U[F5| Audn Trad & i Idle Shutdown Disable
= i J1939 Conlrols
A ota “ @ Load Based Speed Control
« il Maintenance Monitor Disable
!JI:{,_.JDBD Mt ors = i Powertrain Prolechon Disable
i @ PTO/Remote PTO
i il Remole Acceleralor Disable
@ Road Speed Governor
i+ @ SAE J1939 Multiplexing Disable
= @ Starter Lockout Disable
= @ Switched Maximum Engine Operating Speed Disable
i« i Tire Wear Adjustment Disable
@ Transmission Selup
&= @ Trip Information Enable
i il Vehicle Electrical System Vollage
= & Vehicle Speed Sensor Anti-Tampenna Enable =
@ Connected o ECM. =, o = wmes usB (11538) Connecton | | RPIZ10A (S5 Frmare: 6.40
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L T

8 G

i B o n

= ‘HRS

[ [NSITE 80,0402 - Signatune/15X - CMETD - Engine Serial Mumber - 0 - ECM Code - AB10400.23 L___“

.FI'E' Edit Wiew Tools Manage License(s) 'Window Help

RSk A B o

Ciscormect from | T Ealures and Paramelers ECM Value | Units Original Value =
= Signature/ISX - CM870
= CME70
- Fault Codes
@ System D and Dataplate To Send Changes to ECM:
il Accelerator Interdock
Monitor/Loger # @l Adaplive Cruise . .
— cu e |81 Adjustable High Idie Governor Speed| Tool Bar icon OR Alternate Click
+ Teats # @ Adjustable Low Idle Speed
| Atncea icu |8 Batiery Voltage Montor Select Send To = ECM
| = i Cenlinel Oil Syslem
Features and # @ Cruise Confrol Enable
Parameters i« i Cruise Control Swilch Selup
= @& Driver Reward Disable
Calibration
Selection = Engine Brake Control Enable Disable
@“""‘ Ordors # @ Engine Proteciion P
i il Fan Conlrol —LL & - _M I 5
g, Trip Indomation # @ Gear-Down Protection Expand e
i @ Governor Type e
ﬁm Traal @ Idle Shuldown et G“lgi"f". Velue Disable
*.4.” 939 Controls Restare &ll Original Valuess
¥ Inquire Data « @l Load Based Speed Control Refresh r
# § Maintenance Monitor ol Disable
OED Monitors i il Powertrain Proteciion Disable
@ PTO/Remole PTO
= @ Remote Accelerator Disable
= il Road Speed Govermnor
= @8 SAE 11939 Multiplexing Disable
= @ Starter Lockout Disable
= @ Swilched Maximum Engine Operating Speed Disable
@ Tire Wear Adjustment Disable
# @ Transmission Selup i
= @ Trip Information Enable
« i Vehicle Electrical Sysiem Vollage
- &1 Vehicle Soeed Sensor Anti- Tampenna . Enable . x
@ Connected to ECM. 3 A |E= wmes usB (11939) Connectan | | RPIZI0A 13 Frmware: 6.40
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Check Limits

6 INSITE 0402 - Sagnacure/15X - CMET - -0- - BB [ | (5
. File Edt View Tools Merage Licerse(s) Window  Help - 8] ¥

" | REBL MBS oPE REYC|®@e » n o BB &
Fealures and Parameters ECM Value Unils Original Value <
= Signature/ISX - CM&70
= GMET0

= i System ID and Dataplate

- @ Accelerator Interock Disable

- @ Adaplive Cruise Disable

i Adjustable High ldle Governor Spead

- @ Adjustable Low Idle Speed

" Low ldle Speed

Find...

*w. Low Idle Speed Adjustment Switch Enable
* i Battery Voltage Monitor | f 2t * | Disable
@ Cenfinel Qil System | Expand Disable
il Cruise Conlrol | Collapse Enable
=il Cruise Conlrol Swilch Sefup | Restone Origiral Velue
. . Driver Rewand | Restore &l Original Values Dissbla
* i Engine Brake Conlrol Rafresh * | Disable =
A Engine Coolant Level Sensor Lirruts | instanea
* il Engine Prolecton
i Fan Control Enable
7 il Gear-Down Prolechion Disable
* i Governor Type
« i ldle Shutdown Disable
+ @ J1939 Controls

-;::f;glgﬁgg::'::j Alternate click and select Limits

il Powertrain Protectio

< PTOMRemote PTO

il Hemote Accelermlor Disable

i Road Speed Governor

@ SAE J1939 Multiplexing Disable

« i Starter Lockout Disable

=i Switched Maximum Engine Operating Spead Disable

« il Tire Wear Adjustment Disable

=i Transmission Setup

s 1 Trip Information - Enable . =

@ Cosnecied 12 ECU L o [ misies usa (11535) Cannecton | I R 2104 1908) Pirmwara: 880
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Features and Parameters

Limits Send to ECM prompts

a ll

Selected Parameter
Cruize Control % b #ximum Cruize Coptrol Speed

This parameter has a maximum walue limided by:
Road Speed Governor i, Road Sgeed Gowkrnor Feature
Enable \ Maximum vehicle Speed = 150 mp

b axirnumm Linnit Thetallad

Thiz parameter has a ma&imum walue limited by:
Road Speed Govemoy® Road Speed Govermor Feature Enable b

Mavimum Yehicle Spéed = 150 mph 1) *

dase turn the Key Switch off For 30 seconds,

Mirirnurm Lirnit
Thiz parameter has a minimum walue limited by
0 mph

ECM Write Succeeded

................................

(] : Help

.................................

................................
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Features and Parameters Wrap Up

=Multiple adjustments can be made at once
=Tool Tips help In adjusting parameters

=Alternate Click
e Ability to search using Alternate Click Menu
e Send changes to ECM
* View Limits of a parameter

« Expand all parameters when alternate click on title
bar of Features and Parameters
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You have concluded this section of the training.

Please click to the next slide and continue or Click Here to return to
the Table of Content.
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Inquire Data Extraction

—Used to quickly extract and store ECM data

—Reset selected parameters in a connected
engine

 When no active faults or other iIssues are
present

—Inquire Data Extraction is typically
performed while fueling the vehicle

—Extracted data is saved to a ‘CSV’' (Comma
Separated Value) file for future use
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Inquire Data Extraction
Tools = Options

Options r>__(|
Connections I . .
nquire Data Extraction
File q Select the
+ General .
Inquire Data Extraction Connection Settings connection
= Security Select the conmection settings For Inguire Data Extrackion
Authorization Password
ECM Password Remaval / j
Fleet Calibration Counts I3E - CM21500 Simulakor -
Lnits of Measure IMLIMES USE - 11939 - RP12104 i

IMLIME IT COM1 {&uka Detect) Conneckion

+ User Manager

IMLIME II COMI {11939 Cannection
wiark Orders IMLINE4S COMI - 11939 - RP12104

£

Dratalink Protocol

Inquire Daka Extraction Resets

Available Operations Selected Operations

Reset Trip Information

Reset Maintenance Manitor Data
Reset Inactive Fault Codes
Reset Duky Cyile Monitar Group 1 <
Reset Duky Cycle Monitar Group 2
Reset all Fault Codes =

L]

e

Qukput Files
Save as type

|Cu:umma Separated Files (*.csw) j

|A
[l

Ok | Cancel | Help |

an Depend On




Inquire Data Extraction

Options |'£|
C ti 0 .
F“”e””e': e Inquire Data Extraction
+ General
Inquire D ata Extr Zonnection Settings
+ Security Select the connection settings For Inguire Data Exkraction
Units of Measure Sel eCt
4 User Manager IMLINE 11, Auto Detect, COM 1 Ed Operations
wWwhork, Orders Adapter Type Serial
Camputer Part 1
Datalink Adapter IMLINE II
Datalink Protocol :  Auto Dekect
Inguire Daka Extraction Resets
Awailable Operations : Selected Cperations
Reset Trip Information
Reset Maintenance Monitor Dgta
Reset Inactive Faulk Code
< Reset Duky Cwcle Maonitor Group 1
Reset Duky Cycle Monitor Group 2
:l Reset All Faulk Codes
L
OutPuk Files
Save as bype
|Comma Separated Files (*.csv) ﬂ
0K | Cancel | Apply ‘ Help ‘
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Location of Inquwe Data Extraction

!hﬁtmmmmmwm -
TER LR SR A S OFE BaT 0 se 0 s 4B =

Click on Inquire Data
Extraction when you are not
communicating to an ECM

EJJ E WLINEG, USE (11835) Comnechan v!ﬂﬁﬁiﬁ Frmwme E.40
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Inquire Data Extraction

1St Tl m e En g | n e New Engine Information
E dit the Mew Engine Information
EXt r aCt Narr.ne . Yalue
E:l?t”;fufnir;l Murnber  ES012345 —
. . . Cuskomer Mare Cuskomner
= Vehicle information Group Hame New Group
Listed
= Can be customized for
easier identification

Cancel
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INSITE - Inguire Data Extraction

g

~ Inquire Diata Estraction Status

Current Connection Configuration ;

Connection Mame  : Signature/15% - CME70 Simulatar
Computer Port 21

Datalink Adapter : MAA

Datalink Protocol © MNAA

[To change the zettings click on 'Optionz' button)

Please connect to a vehicle

0z

—ehicle Properties ;

| Group Mame Engine Serial Mumber | Unit Mumber | Customer Mame

[ Yehicle ES012345 623 Customer
IEG012345_0_ 200407 20105757 cav

IEG012345_0_ 2004072010242 cav

IEG012345_0_ 2004072011031 0. cav

I[EG012345_0_ 2004072011 0447 cav
[ Yehicle

115012345 0_20040720110415 cav

15012345 UMITO0T Customer
15012345 _0_20040720110829. cav
= Yehicle
[307EE2884_0_20040720110654. cav
|307EE2884_1_200407 20110656, cav
|307EE2884_2_ 200407201106859. cav

307662884 A5KG Customer

Inquire Data
Extraction

Connect |

Cloge |

Options




Inquire Data Extraction Wrap Up

= Excellent application for fleets that need to
quickly gather vehicle data

= Simple connection to vehicles
= Provides resets as needed

= Data is automatically formatted for
Importing to a spread sheet or data base
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You have concluded this section of the training.

Please click to the next slide and continue or Click Here to return to
the Table of Content.
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INSITE™ Installation and Tool ’
— ECM — User Security

Electronic Service Tools
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Agenda

—Installation/Auto Run

—Tool Security
—Start Up

—Tools Options
—ECM Security
—User Manager
—Roll Back Option
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Auto Run Menu

INSITE™ |nstallation DVD uses an Auto
Run Menu

= To Install, Select Install INSITE ™ 7.6.0

= INSITE ™ will upgrade from previous
versions

= |tis not necessary to uninstall previous versions of
INSITE before installing the new version

Back to Agenda c
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Auto Run Menu

Quick Start Guide Release Notes
Feature
Notes
- INSITE Installation Menu
" Quick Start Guides " Release Notes ~ New Features
Install
Upgrade INSITE @ él\(!)S(;TE
Detailed Instructions : e
Training Material
New Users Click Heie >>  Manual Install Packages I nStaI I
. Info
Product Infoermation
(Hover)
Exit
Other Tools
) Pr t Announcement
INSITE Presentation oduc ounceme

Back to Agenda

226  1/20/2014 Cummins Confidential Innovation You Can Depend On e




Auto Run Wrap Up

Refer to either the Quick Start Guide or the
nstallation Instructions

NSITE™ will upgrade from previous
versions

* Itis not necessary to uninstall previous versions of
INSITE ™ before installing the new version.

Back to Agenda
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INSITE Start Up

INSITE'

= ¥
L
s

<
INUNE 6
Batgbiok Adspier

EEr— I'II‘:.III'I.'l P piaE P

Copynght © 1997-2013 Cummins Inc.
All Rights Reserved.

Back to Agenda c
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e e B AR T e, r AR

Connection Status
Selected
o Connection
Communication Status Type

ﬁl__ =) INLINEG USE (J1938) Connection



-

anage Licenses

File Edit Yiew Tools Manage Lcenseis) pieip
TR s B SA s S o R T

Click on
‘Manage License(s)”

Cormnect to ECM

Language  |English (Englizh] = Help Bt IMSITE Tool Instance:

Active Licenses
|

Vs Artwee Lirenses/ - " ay
sEphrEhan LA H

- Loense Type | evalidate Hy
—_— 0374 i

Artrate | srenaecs

Active Counts

Count [ype Counks Avadabe Hevalidate By ' AFLT /3 !
restcount a3 o

@ Rendy Ef" U:" I-E IMLNES,USB (J1538) Connection i -
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Tools=> Options=>
Connections

Connections
File

General Al
Inquire Data Extraction

Units of Measure Name
User Manager INLINES, USE (J1939) Connection DAd d an d
Work Orders INSITE Integrated Simulator - Single M. Disconnected
IMLIMES, USE (Auto Detect) Connection  Disconnected
EZ TAP COM?T - Auto Detect - RP12104 Disconnected Rem ove
EZ TAP COM7 - J1939 - RP1210A Disconnected

INLINES, USB {J1538) Connection Disconnected CO nn eCt| ons

Signature/15¥ - CM870 Simulator Disconnected
|SEBed (4 and 6 cylinder) Simulator Disconnected

| Serial I Simulator I
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Tools=> Options-> General

Connections
File
5
Appearance —Start Up
Inquire Data Extraction Iv Display Splash Screen [ Enable Data Retriewval
Units of Measure
User Manager
Work Orders

Display Options ISmaII Buttons

Tool Tips IDispIay

-~ Viewbar reysmmwer D Perso n al
| Display Feature Names | Enable Key Switch Timer
Preferences

—Fault Codes
[+ Enable Auto Refresh

Refresh Fault Info Every I 30 _% 5eC,

—Calibration Selection
v Enable Auto Detect
[ view Network Calibration Drives

Reset to Cummins Default Settings
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Tools=> Options=> General->

Appearance

Connections
Appearance
File I
= General
Text Options

Inquire Data Extraction

ine
Uniits of Measure AEM Engine Shutdewn Log -

AEM Enhanced Fault Snapshot Log
User Manager AEM Start Stop Log
Work Orders

Background Colors
AEM Engine Shutdown Log

AEM Enhanced Fault Snapshot Log
AEM Start Stop Log &

Grid Colors
AEM Engine Shutdown Log

AEM Enhanced Fault Snapshot Log
AEM Start Stop Log &

Current Selection I:l |'

Selected T
Sample Te:

233 1/20/2014 Cummins Confidential

Select
Modify

aFont size can be changed for

ease of viewing

For ]
Font: Font style: Size:
Bold 2 | ok |
Reqular - |B - Cancel
Cibiie 10 _I
T
Bold Obligue |3
— Effects — Sample
[~ Strikeout
™ Underine AaBbYyZz
Color:
[ Eack ~| | Sedpt:
|Westem |
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Tools=> Options-> Units of
Measure

Insert
Group
Name

Select Add
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Tools=> Options=> Units of
Measure

Options

Predefined
Groups

dCustom
Groups may be
set up

dAdjust

Dessed Fusd Fate ok gallesns pae how

Custom Groups ekl G Conl ksl e e
to match User

Preferences
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Tools = Options Wrap Up

One place to Set up and customize INSITE™
Contains:

Connections
File Locations
General
» Location to Adjust Font Sizes
Tool Level Security

« ECM Password Removal Passwords
» Fleet Calibration Count Passwords

Units of Measure
User Manager

Work Orders
Back to Agenda
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ECM Security

Most of the Cummins ECMs have five levels
of password capabillities:

* Master

e Adjustment
* Reset

« OEM

s OEM 2

Back to Agenda e
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ECM Security

Master ECM Password
—No Changes to ECM Allowed
—Includes all Writes and Resets

Adjustment Password
—Master Password must also be Set
—Only allows changing ECM Adjustments
* Features and Parameters
Reset Password
—Master Password must also be Set
—Only allows ECM Resets
 Fault Codes, Trip Information

OEM/OEM 2 Password

—Master Password does not need to be set
—Protects OEM Specific Parameters from Adjustment
238  1/20/2014 Cummins Confidential Innovation You Can Depend On



ECM Security

ECH Passwords

m— . Tools 2ECM
Passwords: lzase make all password changes wanted before selecting
Fhe Apply butkon,
Passwords...

é Master
é' Adjustment Master Password Status: Disabled

é Reset

5 oEm

Change Password;

Mew Passwaord:

O | Cancel | | Help
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ECM Security

Passwords: FILEEI;.E TalI;E ;l:ll password changes wanted before selecting
&) Master *— 12 g 1S
é' Adjustment Master Password Status: Locked M aSte r PaSSWO rd
SReset is Set/Locked
5 0Em Enter Password:
nlock
_hange Password;
~ Enter Password
| | to Unlock
O | Cancel | | Help |
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ECM Security

Connect

Security Tvpe:

ECM Password:

Select Password
Level from the
dropdown list

Master

bk

[ Enter Password

Conneck

Cancel

Propetties

Help

241 1/20/2014

Cummins Confidential Innovation You Can Depend On




ECM Security
Wrap Up

—Used to protect the ECM from users
making unauthorized adjustments

—Different levels can be set to allow for:
* Resets only (Reset Password)
e Feature Adjustments (Adjustment Password)
 Full functionality (Master Password)

—Master Password must be Set when using
ECM Security

Back to Agenda c
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User Manager

—Enables a system administrator to assign
specific access rights to individual users
and groups

—When enabled, a login is required to open
INSITE ™

—Multiple users and groups can be created

Back to Agenda c
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Tools-> Options-> User Manager

Opﬁuns l 5 ]

Connections
File
General

CI |Ck on Inguire Data Extraction

Units of Measure v Enable User Manager
U ser [ User Manager
Groups
Man ager Users — Users and Groups

Work Orders

[rnprt |

Select to

Enable Select
Apply

&
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System Administrator

-
Modify User

User Mame:
I System Administrator

Enter the /lpfiffid:
paSSWO rd fO r / i Confirm Password:

the System [===
Administrator e

ISystem Administrators ﬂ

oK I Cancel Help |

245 Cummins Confidential Innovation You Can Depend On e
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Connections
File
General
Inquire Data Extraction
Units of Measure
= User Manager
Groups
Lsers
Work Orders

Expand User

Manager
and click
on Groups

246 1/20/2014

—Current Groups Configuration

Group Rights

[=] Predefined

Adm 5
Systerm Administration
Calibration Download
Adjust ECM Features and Parameters
Change ECHM Pazsward
Irpart ECH Image Data
Expart ECH Image Data
Reszet Trip Infarmation Data
Rezet Fauls
Adjuzt Uszer Optionz
Rezet Advance ECM Data

Cbamn

Madify

Cummins Confidential

Click on
Add to
add a
Group

Innovation You Can Depend On




Setting Up Groups

-
MNew Group . u

Group Mame:

||| Technician
Enter /
Name of

Group

Group Rights
[[]5ystem Administration
[[] calibration Download
[C] adjust ECM Features and Parameters
["] change ECM Password
Import ECM Image Data
Export ECM Image Data

Select the Reset Trip Information Data

Rights that [¥] Reset Faults
the g rou p Adjust User Options
Reset Advance ECM Data

should have

the ability
to do

oK, Cancel Help
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Setting Up Users

Connections
File
General
Inquire Data Extraction
Units of Measure
=] User Manager
Groups
Uszers
Work Orders

248 1/20/2014

—Current Users Configuration

zer Mame
5 n Administrator |5

Adminiztrators

Remove

Add New
User

Cummins Confidential

Innovation You Can Dpend On




Setting Up Users

o — ~
Mew User
Enter New
User Name |~ User Name:
ITE::hni::ian 1
Password:
o R T T
Enter | __++—
Password Confirm Password:
o R T T
Select an
existing ——11 Groups: |
Group fechnoan
oK Cancel | Help |
k. - 4
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250

odifying Users

Connections
File
General
Inguire Data Extraction
IUnits of Measure
E User Manager
Groups
Users
Work Orders

1/20/2014

—Current Users Configuration

Uszer Mame | Giroup

System Adminigtrator  Spstern Administrators
echnician 1 T echnician

Modify
existing
Users

Cummins Confidential
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Modifying Groups

Cptions
Connections
File
General
Inquire Data Extraction ~ Current Groups Configuration
Inits of Measure Group Rights =~
B User Manager Reset Trp Information Data
Groups Feszet Fauls
Users Adjust Uszer Opliohs
Work Orders Fieset Advance ECM Data
[=] Cugtarm N
Irmpart ECH Image Data NeW Group WI"
Export ECM Image Data

_ | show under
Reszet Trip Infarmation Data
Feset Faults C ustom

Adjust Uszer Optionz

Reset Advance ECM Data —

.‘

Modify
eX|St|ng —> Modify Add Remove
Group

Ok Cancel apply Help
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After Re-starting INSITE

Required
To select
Enter User Name
Password

Shutdown

Back to Agenda e
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User Manager Wrap Up

—User Manager allows INSITE ™ to be used
by multiple users with restricted access to
the Tool Functionality

Back to Agenda e
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Roll Back Option

= INSITE™ provides the capabillity to roll back to the
previous base version

= For example, INSITE™ 7.5.1 can be rolled back to
INSITE™ 7.5 by using uninstall update in the
Control Panel

Back to Agenda c
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Roll Back Option

= On a Windows 7 or Windows Vista PC

— Go to Start > Control Panel > Programs > Uninstall a
Program. On the upper left hand side, click on View
Installed updates. Select INSITE™ 7.5.1 from the list and
click Uninstall. Follow the prompts to uninstall INSITE™

7.5.1

= On a Windows XP PC

— Go to Start > Control Panel > Add/Remove Programs. On
the top, check the box Show updates. Select INSITE™
7.5.1 from the list and click Uninstall. Follow the prompts to
uninstall INSITE™ 7.5.1

= Note: The PC may need to be restarted after uninstalling INSITE™ 7.5.1

Back to Agenda c
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Roll Back Option — Windows 7/Vista

C=RACH X

¢ Control Panel »

- | | | Search Control Panel D

Eile Edit View Tools Help

Adjust your computer’s settings View by: Category ¥
il  System and Security : User Accounts
Review your computer's status i '@'Change account type
Back up your computer
Find and fix problems .' Appearance and
_ Network and Internet w Personalization
M View network status and tasks Change the theme

Change desktop background
Adjust screen resclution

; Hardware and Sound .
= View devices and printers Clock, Language. and REQIDI‘I
i | Add a device l_ Change keyboards or other input

. €. . methods
Connect to a projector - Ch dicplay |
Adjust commonly used mobility settings ange cisplay fanguage

Pm am | Eafﬁ_ Ddf Access |
h Umnstall a prograrm et srindows SUQQESt settings

Get programs Optimize visual display

“&2, Choose homegroup and sharing opticns

Back to Agenda
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Roll Back Option — Windows 7/Vista

r — IEI E; ™
@Uv| » Control Panel » Programs » Programs and Features - | +3 | | Search Programs and Featu... 2 |
File Edit View Tools Help
Control Panel Home .
Uninstall or change a program
@nstalled update) To uninstall a program, select it from the list and then click Uninstall, Change, or
® Turn Windows features on or Repair.

off

Install a program from the Organize - S @

network -
Marne Publisher i
EW Adobe AIR Adobe Systems Inc, L
B ~dobe Flash Player 10 ActiveX Adobe Systems Incorporated
[ Adobe Framehaker 9 Adobe Systemns
[ Adobe Help Viewer 2 Adobe Systems Incorporated
Eﬁkd obe Reader X Adobe Systems Incorporated
nﬁkdobe Shockwave Player11.5 Adobe Systems, Inc
ﬁﬁ.pple Application Support AppleInc,
ﬁﬁ.pple Software Update AppleInc,
ﬁ_."?'r' BarCodeFontCODE3D Barcode Inc
Ei"] Rrainhnwes Rnnst. Software Suite 2.7 | Rrainhowes | tr a2
] m b

“‘-—f Currently installed programs Total size: 4.71 GB
h ﬂ 93 programs installed
L = —

Back to Agenda
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Roll Back Option — Windows 7/Vista

ESHEERES
f{-\ 3 £l = Prograrns » Programs and Features » Installed Updates - || Search Installed Updates

File Edit View Tools Help

Control Panel Home .
Uninstall an update

Uninstall a program To uninstall an update, select it from the list and then click Uninstall or Change.
'@' Turn Windows features on or

it Organize +{ Uninstall ) == - @

Install a program from the -
network Mame Program Version =~

| INSITE 7.51

) INSITE 7.5.10147

I : Framework 4 Client Profile (3)

ESecurit_',r Update for Microsoft MET Framework 4 Clie..  Microsoft [MET Fra...
ESecurity Update for Microsoft MET Framework 4 Clie..  Microsoft MET Fra...
CE Update for Microseft .MET Framework 4 Client Profile.. Microsoft MET Fra...

Microsoft MET Framework 4 Extended (1)
CE| Security Update for Microsoft MET Framework 4 Exte... Microsoft MET Fra.. 1

Microsoft Office Professional Plus 2007 (35)

. . - - - - e —— - PR —— -

4 | 1 | b

Cummins Inc.  Parent name: INSITE
Product versiorn: 7.5.10147

Back to Agenda
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Roll Back Option — Windows XP

B Confrod Panel = 8 5
Fdit  Wew Favorles Tooks  Help &
(> + J::fl Search [~ Folders [T1{]-
Agcress | Control Parel ~| EJee
. Hame & Comments |:
Ell:- Coatral Panel = A&, accesoiiitty Cpzons Adpst wour comztter settres for wision, Rearng, and mokd. .

= add Harcware Iristalls and trousleshooks hardweans
ﬂ* Svaich bo Cabegory Vizw #dd or Remowe Pragrams rrestall or remove programs and 'dindows componerts.
5 Acministr = Conifin ingirative sethings for your comperter,

u l’-U"'IIl'ElU:| Tratall or remane progeams and Windows comporents. b atomaticaly delver imporfant updates

-

e - D Diate and TR THr T, and time sne for your computer,
‘ Virdows Update j.'l-ﬁ'l-ﬂ'lﬂ'f Charge e sppearanoe of your desklop, such a9 the ek, .,
. Help and Sugport I_I}F:idz' Cipbors Cimbomize e deplay of Ses ad Sldes, dharge ke gome, o,
chrots fcdd, change, and manage fonts on your oomputsr,
&= Gam= Controlers Add, remove:, and configre game controler hardvesre suc.. |
W 1 ik Launch Buttors HP Quick Laurch Buthors
e wiraless Asmstart Vew the status of and cortrol the power states of inbagrat..
E[m:l:n'r:t Dpbons Corfigurs vour Iniemet dsplsy ard cornecton setbrcs.
gl J2ua JavalTH) Coritrod Pans
:‘i!l'_'lﬂ:ﬂﬂ'd Oustomize your keyboard s=tengs, such as e oursor bink ..
L!h'al wirosoft Office Cutiook: Frofies
yousa CLEhomiae your mouse aetings, such as the buthon cordigu. .
ﬁu?'rl'-ﬂm Correctiong Conrects to ather compubere, metwerks, and the Intermet.
T Network Sehp Wizand Laumnhy the Nebwork Sefun deizans
EZINVIDTA rivies Deskiop Marager Corfiguea your SIDTA riview Deskiop Marager salings.
Phare ard Medem Optons Corfigune your belepbore: dishng rubes ard modem s=tings.
Porigble Mede Devces Vmwy the portables meda devices correcied o your compuber,
1 Bower Optiors Corfigurs srergy -saang s=kongs S your compuber,
y Penters and Fanees Shows rstaled priviers ard fax priviers snd belps vou acd. ..
éF‘-:l;ru'n Upclat=g [restalSqeld Lpdste Mansger dedis for updsted versons ...
ﬂ Aegioral ard Larcuage Ophoris Customize setbros for the deplay of larguagss, rurmbsers. . ..
'::}Emnn:r:endi:lnm &dd, remove, and configre scanners and cameras, |-"r

Back to A(Q%rrllda
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Roll Back Option — Windows XP

5
Change or
Remoye

Set Program

t® Add or Remove Programs

| Programs

T P e P g T ﬂ
15 Eaton MD-131-W RP1210A Driver | Sze  0.28M8
Click here for support information. Used rarely

To change this program or remove it from your computer, dick Change or Remave. [mllml'
B8 adobe Reader 8 Size 78.82MB |
5/ Conexant HD Audio Sze  0.63M8
€& Cummins Inc. Update Manager Size  4.19M8
§5 Cummins INLINE 5
[ cummins PowerSpec 4.2.3 Size  15.96MB
. (]

. ack to Agenda
260  1/20/2014 Cummins Confidential Innovation You gan Bepenge(\pn




Roll Back Option — Windows XP

©» Add or Remove Programs

%ﬂ Currently installed programs and updates: Show updates Sortby: | Mame kl
Change or s T QUK LA T DOTITS O IO FE olZE 1, J4¥IE w
Remove . )
Programs () HP QuickPlay 2.3 Size 5.96MB
@ HP Rhapsody Size 25.76MB
Eﬁ' %7 HP Update Size 3.68MB
Add lew i3 HP User Guides 0031 5 0.04ME
Programs 2= '
00 HP wireless Assistant 2.00 G2 Size 1.33MB
E] 3 msmE Size 383.00MB | =
Add/Remove € INSITE 7.5.1 Installed On i
Windows =
Components Click here for support information.
To remove this update from your computer, didk Remove.,
@ 3 NSITE Fault Viewer 5.62MB
Set Program
Access and ¥ 150 Recorder Size 0.61MB
Defaults
& 125E Runtime Environment 5.0 Update & Size 152.00MB
ﬁ_,'-’;,! Macromedia Flash Player & Size 1.43MB
ﬁ! Macromedia Shockwave Player Size 3, 17MB

% Microsoft .MET Framewark 1.1
if_,'-’;,! Microsoft .\MET Framewark 1.1 Hotfix (KBEQ28366)

ﬁ! Microsoft .\MET Framewark 2.0 Size 33.38MB M
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Roll Back Option Wrap Up

= INSITE™ provides the capability to roll back to
the previous version

Back to Agenda 6
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You have concluded this section of the training.

Please click to the next slide and continue or Click Here to return to
the Table of Content.
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INSITE™ Trip Information

Electronic Service Tools
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Trip Information

=Trip Information continuously monitors and
records engine operating data that tracks
engine and driver performance

=Stored data can be viewed using INSITE™
* Live module
e Exported ECM Image

=Parameters are grouped differently,
according to the ECM

*Not all ECMs list the same parameters
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{3 INSITE 8.0.0.402 E=naaE |
B B0 SR ARDS | cPBEBERY|D &> n s IR =

Click on Trip
Information

@ Connected to ECM. gl | INLINES,USB (J1938) Connection v!RF’"Q"“M-"‘m? Firmware: 6.40
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EINSITEB.D.UADZ - Signatu erial Numb
a File Edit View Tools Manage license(s) Window Help

e PSR ARSI cEBIBRYID &0 n =« HB =

Disconnoct from | Name 'ECM Value Units

|= Signature/ISX - CM870

= CM870
=@ All Trips (Cumulative)
@ (2 Trip Since Last Reset

If “All Trips (Cumulative)” is
expanded, ECM Values will be shown
for the life of the ECM

If “Trip Since Last Reset” is expanded,
parameter values for that ECM are shown
since the last time the ECM was reset

@ Connected to ECH. .% i g IE’ INLINES, USB (11939) Connection jl—RP121 04(11939) Firmware: §.40
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rﬂmﬂfufﬂ_y;?’ Filap» n =« P =
[ Discormect trom _Name : [ECM Value Units
Gt - Signature/ISX -\GM870 .
- CM870 s
[ iy Foulk Codes @ Al Trips (CumNative) Expamsl
1 & Trip Since Last t Collapse
Dta
LIRS Monitor/Lopger T Trip Fisel Repon
Reset
- lﬁ_:lw 0, :
Refresh
| Adwanced ECM
| Data ECM
R et o Values . , -
Alternate click on the Title Bar of Trip
Calibration -
- Jorerm Information and choose Expand All or
) Work Orers Collapse All
Trip nd crmation
%M Tirasl
B3 cnire Deta Clicking on the + or -
sign next to the
,i{l,mmim

parameter name will
expand or collapse

@ Connacted 1o ECM.

E J |-ﬁt BILINEE USE (11939) Connacton

j| RPIZ10A [JU539) Frmware: §.40
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Trip Information:
Trip Fuel Report

= A Trip Fuel Report is a condensed list of fueling parameters
= Available on any engine that supports Trip Information
= Can onIy be Prlnted from thls view

B P e e G P B i
Htuﬂ'lh}-nwlmm-i:h

EAL R AF OIB mmY " as i SE

L ET ECM Wl
“Hpnatu'| 5K - CHE0
- CHEER]
A Top Smos Lasi Pt
- 3 Dl
1 Trip Diestaraoe 15000 1
= 35 Pl Lisd
I PTO Fuss st 20004 e
21 Trip Aseraga Fual Econmy 12700 i 2]
Ay m— 12 70
21 Toip Fuol Used BO0000 g
21 Tri bt Fual ks SOE0N 1
S Ddher
O B of Saaikon Deacsberalions 125
21 t5ercm Brake Actusbons 2500
E1 Trips Ansarane Vahada Spsard 75 ph
"1___-_1\'\.- i 21 Tnp Maamum Engre Speed 4000 HFM
. 1 Trips Maasdium Vihicia 5prsad {F mgh
ﬂr.q. I ——— 2 Tima -
b [ ch W ol |k 05 Parcan!
_'||-' 1 Chrurss Ciinal A2 4 Pwcani
'HM s _!Pnr anm n PT aig Fairan!
1 Powscanrl Tieros i Tiap Comet 77 8 [oe—
B £1FTO Tme 50000 s
'_'ITupIu.l,l Trnw 0852 e
A Macaors £1Trip Time: B0 2 hes

) Cormaoi m iTH g Ay CHRTE Bt = .
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4 TecTTE O
B File Edit View Took

IS - CMETD - Engine Serial Numb
H.n?:L.i:uuu‘!l; Wimnadow H-:l

o E B PRSI M DB oFB| BRETIM
Discennact from _ Name
o = Signature/1SX - CM870
__ = CM870
B Fauit Codes =24 All Trips (Cumulative)
=3 Distance

@ Connecied o ECU

270 1/20/2014

+ Total ECM Distance
+ Total Engine Brake Distancy

Trip Fuel Report

¢ Total Engine Distance
t Tolal Service Brake Dislance
-3 Fuel Used
# Total Cruise Control Fuel Used
® Total Fuel Used
# Total Gear Down Fuel Used
+ Total |dle Fued Usad
® Total Loaded PTO Drive Fual Usad

+ Total Maxomum Accelerator Vehicle Speed Fuel Used

# Total FTO Drive Fuel Used

# Total PTO Fuel Used

‘+ Total Top Gear Fuel Used

=3 Multiple FTO

+ PTO Device 1

+ PTO Device 2

+ PTO Device 3

& FTO Device 4

® FTO Device 5

® PTO Device 6

® PTO Dewvice 7

& PTO Device 8

- Fuel
+ PTO Device 1 Total Fual Used
+ PTO Device 2 Total Fuel Used
# PTO Device 3 Total Fuel Used
@ PTO Device 4 Total Fuel Used
+ PTO Device 5 Total Fuel Used
@ PTO Device 6 Total Fuel Used
& PTO Device 7 Total Fuel Used
& PTO Device & Total Fuel Used

=28 Timee

e T Mesaan 1 Tabel T

5 h! Lj SignaturenSy - CMETE Smslator

Cummins Confidential

|ECM Value

220014 8
20
2201204
1525000.0

01
5000000
200000.0

5000000
1100000
0.1

10000.0
5000.0

5000000

Device 1
Device 2
Device 3
Device 4
Dewice 5
Device G
Device 7
Device &

21
22
23
24
25
26
27
28

b h ]

=l

Units
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Find

Expand

Collagse

Trip Fued Report
A

Reset

Refresh 0

Or Alternate Click
and select
Trip Fuel Report




i@ Connected o ECU

= Signature/15X - CM8
= CMB70
= A Trip Since Last Reset
-3 Distance
B3 Trip Distance
=3 Fuel Used
EIPTO Fuel Used

B3 Trip Average Fuel Economy
B3 Trip Drive Average Fuel Economy

B3 Trip Fuel Used
E1Trip Idle Fuel Used
- 24 Other

E1Number of Sudden Decelerations
E1Senice Brake Actuations

E1Tnp Average Vehicle Speed
E1Trip Maximum Engine Speed

£ Trip Maximum Vehicle Speed

=24 Time
E1Percent Time at Idie

E1Percent Time in Cruise Control

E1Percent Time in PTO

£1Percent Time in Top Gear

F1PTO Time
[ Trip Idie Time
[ Trip Time

|ECM Valua

| Units

Click on the “Print” button to
print a copy of parameters
listed on the screen

127

205
G624
8338
7igB
20000

59652

29652

E. E! Lﬁl SigratureSX - CMETD Smmulaior

B|

mpg
gal
gal

Find

Coltspse

W TripFu*E:pnrt
Reset
Refresh E

Alternate Click now

lists the Trip Fuel Report

as Selected
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Trip Information

Trip Information may be printed when connected to
the ECM or Image
= Tool Bar Printer Icon
= File 2 Print

Ing srini Humss e
iy omer Duly Be w5 -
rE Crmer Hams L

L o bein

S T 1
=
ZH AR | e

o Dtree

F lasECM Lt e i i L]
b Tow | rgee ome [sman a o
L pir -
P Tas Sevim Bisks Datare T m
i [T

b Tois Crsm Commad Fumi s =
¥ 1o Fomi Ui SRR gl
¥ 1o Geat Dowr Fosd Unal i il aw
* T lde | s el SO0 i
F T Londet FT0 D F ol Usad EnE s
p |om e A i W

B Fue Ui d R am
F Tonw P10 D Fmd Uinsa) O ]
b Tas P Pl Ui 5000 ¢ s
b e T e | o Linn Lo I o
= Mt 4100
& PO Dewps 1 [ES,
¥ PTO Duwien 3 Cima
b PIO Do 3 Dwwis
# FTO Comipn 4 [EP
& PTD Doieici [
& PO D Do
® PFTO [ [
¥ FTO D [

= TP

b PTO D | Vot Pl Linad n -

]

P PTG D J e sl v il
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Trip Information Wrap Up

—Allows the user to view ECM Values for
multiple time periods:

e Lifetime of the ECM
 Since the Trip Information was last reset

—Trip Fuel Report will display all fuel related
parameters for the above time periods

—INSITE™ allows the user to print these
screens
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You have concluded this section of the training.

Please click to the next slide and continue or Click Here to return to
the Table of Content.
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Work Orders

276

A Work Order is the top level identifier that contains
the ECM image(s). Work Orders can be used for
tracking vehicle and equipment repair history.

An Image is a copy of the ECM data

Work Orders may contain multiple Images

= By default, an “Initial” image is created when connecting to
an ECM with the Work Order Mode enabled

= By default, a “Final” image is created when disconnecting
from an ECM with the Work Order Mode enabled

= Additional “User” images may be created under each Work
Order while connected to the ECM

Work Orders can be created automatically by
INSITE™ or manually by the user
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Work Orders

To have INSITE™ automatically create Work Orders
when connecting and disconnecting:

Select Tools = o Work Orders

Options > Work

Orders Sl PEE—

» Select “Enable Work earr
Order Mode”

By default this feature

is Enabled when
INSITE™ is installed.
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Work Orders

= When connected to an ECM, only Work Orders
compatible with that ECM serial number will be
displayed

= Disconnect from an ECM to view all Work Orders

= Work Order and Image names are defaulted to a
Date — Time format (i.e. WO-20041027-145950 =
10/27/2004-2:59:50). These names can be
changed at the time of creation or under the Work
Order properties to help identify the specific
customer, vehicle or equipment
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Work Orders

= With Work Order Mode enabled and no
compatible Work Orders exist, a New Work Order

dialog will be displayed after connection to the

ECM

* Enter the Work Order
Number, Image Name and

Select OK

* |f you do not wish to create a
new Work Order, select

Cancel

279 1/20/2014

-
c Mew Work Order

S

= Engine Information

ECM Serial
Murnber

...... & Model
& Serial Number
-2 Image-CME70 [0]

------ &, File Location

------ “» Image Name
------ &, Start Repair Date
ey System Type
<& Surnmary Information

| -

0110031812
CMMNS

Signature/lSx - CM870

10101010

CilntelectINSITEMWOrkOrder
SiSI-20131217-14001 0090

S1-20131217-140010090
17-Dec-2013 02:00:10 P

[nitial

------ “» Custorer Contact Columbus, 1N

Cummins Confidential

------ “, Customer Name | Customer
______ N Eagt Modified ~ =
Technidan's Note
|
Print | [oc | el | el |
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Work Orders

=  With Work Order Mode enabled and compatible Work Orders
exist, the New/Activate Work Order dialog will be displayed
after connection to the ECM
» Select New to create a new Work Order

* OR: Select one of the compatible Work Orders in which to create
a new Image and select OK
* Enter the Image Name and confirm the creation by selecting OK
* OR: Select Cancel if you do not wish to create an Image

s Work Order Mode - Newactare (L0 el CREy
CME 18]
Work Order Mode is currently enabled. Select the "New™ button to CAlnteechINSITEW Ok Ordarsh 3l
create a new work order, or activate one of the following werk 215121 7=-1401 60625
orders by selecting the "OK” button, " Image Hame S1-201 8121 7-1401E0825
i Start Repar Oate | 1 7-Dac-2003 0201 50 P
Work Orders/ECM Images B, Syystes Type fritiz|
=B Sw-20131217-140010
-5 Image-CM8 70 [0]
& S1-20131217-140010090
wwwwww
rrt o | oed | e |
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Work Orders

Manually creating New Work Orders
= Select File 2> New - Work Order...

&4 MSTTE 30,0402 - Sgnatire/iS - CMBT0 - Engane Sevial Number - 10101010 - ECM Code - AB 1008000 =00 X |
A File Edit Wiew Tools Managelicensels) Window Help &l =

AL ' T L T AR AN EE L &

‘Work Orders/ECM Images z Customer Name [Vehicle Unit Number | Engine Serial Number  Start Repair Date
S, 0] SW-20131217-140010 Signaturafisx = CMETD. |Customer |EZ3 101010180 1 7=Dec-201302:00:10 PM
= Imiage-CMET0 0]
B 5-20131 217140150826 Initizl 170
B 51-20131 217-14007 0090 Initizd 17-0
M Wiowke Order
OR: Select OR: Alternate /
\ - Wake Active
New Work click and select

Order New Work Order il

Exparmd

Cellapze
Print Woek Crdens)

ECM Template  Swstem Type |Module Type | System Comment Drate And Time | Onigin
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Work Orders

Manually creating New ECM Image
= Select File > New - ECM Image...
= The new Image will be created in the Active Work Order

R, - LMETD - kAgin LR - AL
WA File Edi view Tools Manage Licenseis) Window Halp

28 ERSEk A PSP R BEY =@ v 0= @B
il‘ breim Work Qraers/ECH Images  System Typs Customar Name Wehicle Unt Humber |Engine Serial Number | Start Repar Date Last
- EEM H:ﬁ] SWAIDTSI 21 71 4001 0 Sagnaturefi S - CMETI | Customer {B2g 101010 B 1 7-Dec-2013 020000 PM 117-D
= Image-CME70 [0 Mew Werk Order
%Fﬂm & S1-2013 21 71 40160826 Inital Deletz Work Drderis) 17-0
B 51-20151217-140010040  [nifial Niaie At 17-0
Moniton/Logger Mew ECM Image
Impart Image(s]
ECM Diagrasstic: .
- \ OR: Clickon | | OR: Alternate /
Collapse
Aetvarced ECM .
o New Image click and select P it Ot
Fratires and Fiopenel
P Icon New ECM Image
Calsbration
Sedpcton
@muﬁ:
Trip Information ECM Tamplate _IS;.-'sTam Type  Moduls Type  System Commeant Date And Tima | Origirs
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Work Orders

= Each image can be exported for use in two ways:

« Exported as an INSITE compatible file, .eif (exported image file) to be
imported by another user with INSITE

* To an external file, “Image Name.csv’ (Comma Separated Value)
« This format can be opened with Excel, Word, Notepad, etc.

= All Work Order images can be exported using the right-click menu and
selecting the ‘Export All Images’ option. Highlight the Work Order image and
right-click to export all images
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Work Orders

DEB| I DRSS ADSFMOFPFEEEY O &0 1 s JRF

o luw from ‘Work Orders/ECM Imagas S;.-'m‘em Type EC.‘ugtc:mBr Mame |‘ehicle Unit Number |Engine Senal Number |Start Repair Date Last

e =) SW-20151217-140010 Signature/| S - CMETD | Custormer 623 10101070 17-Dec-2003 020010 PM 17D

= Image-CMETD [0
%ﬁ" ol B<1-20131217-140160826 | Initial
© 51-20131217-140010090  Initial R 17-D
I N Dala | Convert to Termplate(s)
% Morilan oo
Export Imageis]
ECM [iagnosdic Export Al Images
Tats Export Imageis) to Externai File
S Print ECM Image(s]...

Uetn ] ] Delete Imagels).

— Right-Click and select D

Parametors :

_ Export All Images

Salescivan
@ Work Orders

Trip Infomation | ECM Template | Systern Type |Module Type | System Commerit | Date And Time: | Origin

Aucdit Tl
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Work Orders

= |mporting an Image
« Alternate Click in the Work Order area and select Import Image
« Select the Image to be imported

= Opening an Image
 INSITE’s exported ECM images (.eif) can be opened by double
clicking .eif file
« INSITE™ will open, import the image, and automatically connect to
it

o If INSITE™ is already open, the ECM image will be imported but
not automatically connected

= Convert to a Template
» Alternate Click on the Image and select Convert to Template
« Templates provide a means of configuring multiple ECM’s with the

same base parameter settings c
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Work Orders

Printing ECM Images

= Select the ECM Image
» Select File = Print

* OR: Alternate right click — Print ECM Image(s)
[ Print ECM Images &1

Sel eCt S | n g | e Features Selected Features
feat ures w | t h (- >) .f-‘mti-.Thef_t Praotection -

. Audit Trail
or a.” W|th (- >>) [rata bonitors

\\ Dty Cycle Monitor
Enaine Abuse Higtory
Enaine Pratection
Engine Torque History
Fault Codes

Fault Snapshot

i Features and Parameters e
bl aintenance kaonitor
tulti Level ECM Security
Other [Smart) Devices

Sel eCt TO (0] I PowerSpec Enalble and Paszward
Display for
Graphical print or
¥ Tool Display Format
TeXt On Iy FO rm at ¢ Text Only Format

-l

m

=

i

-

rlease select the Features desired for printout.

(0] 4 Help Cancel
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Templates

Templates can be created from an ECM Image to allow transferring the
same Feature and Parameter setup from that Image to multiple ECMs

- Select Image then select F|Ie - Convert > ECM Template

Ao aonett e mp" Code - AF10040.00 i —
D RELAEOF<oFBEET O)®Ee » n o AB =
Wiork Orders/ECM Images  System Typa Customer Narms | Vehicks Unit Number | Engine Senial Nurmter | Start Repair Date Last
g | i ! !
ECM =@ Sw-20131217-140010 Signaturafl Sk - CMET)  Customer 623 1001010 17-Dac-2013 020010 P 17-0
= Image-CMET0 [0]
Pl Crilmi 8 51-20131217-140160826  Initial 17-0
SI-2012121 7140010090 |intia

=T Conmect to [mage

Morillor/Logges Corvert te Template)
- ?:“ Dvagnostsc Export bmage(s)
R Test . .

: OR: Select OR: Alternate Bt Al mages

. Export bmage(s) to External File
ol o Convert click and select Prnt ECH magetl..

et and Image to Convert to oy

Propertees...
Template Template(s)

Serbedican
@Wnﬂ:l’.‘i‘&n
R Trip Infammation ECM Ternplate | Svstam Type |Module T tern Cornen ent Diate And Tirne O
¥ g i P yps N
i.: Pucit Tresl
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Templates

To send a template to an ECM, select the Template:

[ icrre van s
@0

Select File > Send To - ECM...

) Fle Edn Yiew Took thumu] Window  Help

mERA A By ) oPB BETIO &=y SR T

_Jlg:unndﬁn-

ﬂfﬂ&d—

Dl
Peursit oL inprer

Egﬂwwn

Eﬂ:ﬂdﬂ:ﬂ

Features and
P ors

o=
Selection

| Customer Name | Vehicke Unit Number | Engine Sefial Number | Start Repair Date Last

Work Orders/ECM Imajies | System Type
=@ S22 21714001 ShgnaturallSi - CMETD | Customer BE3 10101010 17-Dec-201 3 020010 P 17D
= |mage-CMETD 0]
@ 51-20131217-1 40150825  Initial 17-D
35020131 217-14001 1000 | ind=l -0

OR: Select Send
to ECM

ECM Templats =
ST-201 3121 -1 16812 | SignaturafiSe - GMETO

17-Dec-20t302 1812 PM  IS200 3121 7-14001 0050

Hlm T N :II .
R mm:,\\ OR: Alternate
i oo Tt click and Send
e to ECM
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Templates

Template Report

289

— Ability to report which
parameters were not
able to be written to
ECM

— User can use this to
setup the vehicle
accordingly

Calibration Conflict Warning

Please note that the template has already completed compatible
changes to the connected ECM,
The Following data cannot be set in the ECM because the associated

features and parameters have not been enabled or there are
differences in the ECM calibrations.

Select Print o print the list of Features and Parameters that will not be
adjusted by the template,

Select O to conkinue,

Features and Parameters

Road Speed Governor\, Road Speed Governor
Feature Enable

Switched Maxirmum Engine Operatfing Speed
Trip Information, Trip Information Feature Enable

Pr"_lt i, ............ ;:.lk ............. .\f Help |
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Work Order Wrap Up

— A Work Order is the top level identifier and can
contain multiple ECM Images

— Only compatible Work Orders are displayed when

connected to an ECM. All Work Orders will display
when not connected

— Work Order Mode is defaulted ON and can be used

to create Initial and Final Images upon Connect and
Disconnect respectively

— Images can be converted to Templates to allow the
Features and Parameters from that Image to be

transferred to other ECMs c
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You have concluded this section of the training.

Please click to the next slide and continue or Click Here to return to
the Table of Content.
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Cummins® Inc.
Update Manager Overview

= Provides up-to-date information for INSITE™
— Fault Information System (FIS) files
— Help and Manual files
— Feature Packs
— Service Packs

* Provides an Automatic Update Notification Alert
when updates are available through the internet
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Fault Trees Overdew.,
Fault Trees Troubleshooting Steps
Fault Trees Indes...

Check for Updates
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Automatic Update Notification

Alert

The Automatic Update
Notification Alert will
display at a specified day
and time If updates are
available

Choose “Remind Me In”
or “Select and Install
Updates”

295 Cummins Confidential

Cummins Inc. Update Manager

Updates are avadable

Remind Men |1 How d

| Insst

Cummins Inc. Update Manager

3 Hours
Updates: 1 Day
3 Days
Remind Meln | 1week v

| Inst
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Check for Updates Manually

= Updates can be manually checked
through the following:

= INSITE > Help > Check for Updates

= Open the Cummins Inc Update Manager
and click on “Get Updates” button in the
lower left part of the window.

Cummins Confidential Innovation You Can Depend On c
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Message Box

S

| Update | Options | About | Help |

Messages

Welcome to the Cumming Inc. Update Manager

Available Updates Update From Internet -

= INSITE [ Install Al
INSITE FIS Files
INSITE Help Files

INSITE Manuzl Files
This is a notification
field which displays new
available information

Currently Selected Update Size:
Total Update Size:

© O ©O
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Get Updates From Internet/CD

=)

Choose Update from
Internet, Update from Update [optons | About | el

Other, or CD/DVD option
|

Available Updates Update From Internet -

= INSITE [ Install Al
= INSITE FIS Files
I5B6.7 CM2350 B101
I ISBE.7, ISCR3, ISLY, ISX12/15X11.9, and 15X15

i ISF2.8 CM2220 EC; ISF2.8 CM2220 ECFZ; ISF2.8
CMZ220 AN; 1SF3.8 CM2220; 1I5F3.8 CMZ220 AN;

I5B4.5, ISE6.7, 15045, |SDE.7 CM2150 SN; ISLE.S
CM2150 SN; 1ISM11 CMET76 SN; 15213 CM2150 SN;
and 1SB6.7 CM2150 50

I5F2.8 CM2220 1AM
ISF3.8 CM2220 1AM

7] IS G CM2180 / Select Get Updates

1519 CM2350 L101 w

/1
! Currently Selected Update Size:
Total Update Size:

A S E e

|
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Checking for Updates - Internet

=

F S —
& Cummins Inc. Uﬁate Manager —p|pl=)

| Update | options | About | Help |

Messages

‘Welcome to the Cummins Inc. Update Manager

L—
| | Available Updates Update From Internet -
|

= INSITE [ Install All
INSITE FIS Files
INSITE Help Files
INSITE Manual Files

/

Currently Selected Update Size:
Total Update Size:

w@_&_’
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Available Updates — Install All INSITE
Updates

€y ailable Updates - Install fo
%

| Update |Options | About | Help |

Messages

Welcome to the Cummins Inc. Update Manager

Available Updates Update From Internet ~

= INSITE 1 Install Al | [INSITE FIS Fies
= [] INSITE FIS Files \\
ISB6.7 CM2350 B101
| ISB6.7, ISC8.3, ISL9, ISX12/1SX11.9, and ISX15
ISF2.8 CM2220 EC; ISF2.8 CM2220 ECF2; ISF2.8

| - CM2220 AN: ISF3.8 CM2220- ISF3.8 CM2320 AN: B i
V] ISB45, ISBE 7, ISD4 5, ISD6.7 CM2150 SN; 1SL8.9
e e e e S Er 2, Install All available
and ISBE.7 CM2150 3Q
ISF2.8 CM2220 IAN up dates

I5F3.8 CMZZ20 1AN
ISL G CM2180
1519 CM2350 L101 g

I Currently Selected Update Size:
Total Update Size: 58.9 MB

«©« O ©O
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Available Updates Expanded
Comnctpievs B ygmilmivle indatae Evniso==

| Update | Options | About | Help |

Messages

Welcome to the Cummins Inc. Update Manager

Available Updates lUpdate From Internet -

= INSITE [ Install All
= [H] INSITE FIS Files

ISBS.7 CM2350 B101

[

ISB6.7, ISCB.3, ISL9, ISX12/1SX11.9, and ISX15

ISB4.5, ISB6.7, ISD4.5. 1SD6.7 CM2150 SN: ISLE.3 0 I n Stal I u p d ates In d VI d u al Iy
CMZ150 SN; ISM11 CME76 SN; 1SZ13 CM2150 SN )
mSRIORNA ] by expanding + and select

: .

[ ISF3.8 CM2220 1AN the desired Updates

[ ISL G CM2180

[] ISLS CM2350 L101 v

I Currently Selected Update Size:
Total Update Size: 45.6 MB

©®© O ©
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Select Available Updates

i T
e Cummins Inc, Uﬁatﬁ Manager = —
— - = i - . o o o

| Update | Options | About | Help |

Messages

YWelcome to the Cummins Inc. Update Manager

Available Updates Update From Internet b

= INSITE [ ] Install All
= [E] INSITE FIS Files

ISBE.7 CM2350 B101
ISBE.7, 1ISCE.3, 1518, 1SX1215X11.9, and ISX15

S f ISF2.8 CM2220 EC; ISF2.8 CM2220 ECF2; ISF2.8

1Zze O CMZ220 AN: ISF3.8 CM2220; ISF3.8 CM2220 AN;

ISB4.5, ISBE.7, ISD4.5, ISDE.7 CM2150 SN: SL8.9

selected CM2750 SN: ISM11 CME78 SN: 1S213 CM2150 SN:
and ISB6.7 CM2150 SQ

up dates [ ISF2.8 CM2220 IAN

[] ISF3.8 CM2220 IAN

[

\\ [] 1sL G CMm2180
\‘ ISLS CM2350 L101 w
\ ]
! Currently Selected Update Size: 4 8 MB
Total Update Size: 13.7 MB I

© O ©O
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Download Status Information
... EET=)

Updates are being installed. please wait...

18 MB out of 29 MB complete.... I
Download Status

Download Rate: 2.29 MB/s Pausze All Downloads
ISBE.7, [SC8.3, IS8, 1S5X1215X11.9, and I5X15 _
I5F2.8 CM2220 EC; I15F2.28 CM2220 ECFZ; ISF2.8 CM2220 AN ——
ISL G CM2180 _
ISL9 CM2350 L101 |
|5X CM271 and 1SM CMETE Queued for Download
Ingtall Status
ISF2.8 CM2220 1AM Inztallation Successful
|SB6.7 CM2350 E101 Inztallation Successful
ISF3.8 CM2220 1AN Inztallation Successful

X
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Once the
Installation is
complete, the
installation status
will be displayed.

If the installation is
successful,
“Installation
Successful” will be
displayed.

If the installation is

One or more of the selected updates could not be installed.

Download Status
Download Rate: -
ISBE.7, ISCR.3, ISL9, 1ISX11.9, and 15X15
I1SC, QSCE.3, and ISL
ISF2.8 CM2220 E, ISF2.8 CM2220 AN, ISF3.8 CM2220, ISF3E

ISF28 CM2220 E, ISF2.8 CM2220 AN, ISF2.8 CM2220, ISF3.8
ISF2.8 CM2220 E; I1SF2.8 CM2220 AN: ISF3.8 CM2220; ISFI.E

ISL G CM2120
ISM and Q5M11
ISM CMETS
ISM with CMB70 and CM570
|SX CMBT1 and ISKM CMATE

KT AMGR. CUMERS

Gas Plus
GTAB.3 CMa58
ISB, 15Be2, |1SBe3, |SBed, QSB45, QSBES QSBEST, 15C
ISE. ISC, ISL, |1SDe, and GSB3.3
ISB5.9 G CM2180

Installation Status Information

~

Pause All Downloads
Queued for Download
Quevad for Download
Queuved for Download
Queuved for Download
Queued for Download
Queuved for Download
Queved for Download
Queved for Download
Queued for Download
Queuved for Download

i s i e Mhmss s Lmom s

natallabon Successhul
nstallation Successful
nstallation Successhul
nstallation Successful
nstallation Successful

nOt SUCCGSSfUl, Installation f’ll e f*rnr l'.II;II‘
“ . Inztallation Failed: Emor 1002
|nSta||atIOn Irll'._ e n '_jli.l:ﬂ .Z_'rn_.q 'l_:l;:l:
Failed: Error XX” Installation Failed: Error 99
will be displayed
along with an error

code.
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Most users
will not have
to change the

proxy
settings.

For other
users, the
Proxy
Settings will
have to be
entered.

Contact local
IT support for
help with
Proxy
settings.

305

Options Tab — Proxy Settings

Language Settings

Select Language |Engiﬂl[Englhhj

Connection Settings

Do Mok Liser & Preogy
Port

HTTP Praey U @ LUse System Defaukl Progy
HTTP Presey Passwerd Lise Marual Prooy Settngs

Connection Type:

|High-Speed (3M) - Allows 4 Active Downloads

Scheduled Update Check
0 Maruaby

@ Weakiy

Cummins Confidential
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Options ab Connectlon Types

Connection
Type for
users who
want to vary
their
connection
option.

Furmit

11:37:00 AM
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Options Tab — Scheduled
Update Check

- = el

|Update  Options | About | Help |

The default 1 i

anguage ngs
Scheduled Select Language | Engliish (English)
Update T Py
Check |S - Do Mok Lisa 2 Proey
once a
month.

HTTP Preoey Usemame @ Lise System Defaukt Prowy

HTTP Prewy Fasswerd Use Manual Prooy Settngs

Connection Type:
High-Speed (3M) - Allows 4 Active Downloads

This can be

changed to e e
Daily, & Weeky ® Moniiy
Weekly,

Monthly or 0 e

Manually.
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& Cummins Inc. Update Manager
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Help Tab

i .
% Cummins Inc. UEate I'«.-Ianag:u:rll-I - - &

—m e

For assistance please contact the product’'s Technical support center:

Cummins Inc. Update Manager
INSITE

Cummins INLINE 6

INSITE Data Pack

DESA

UpdateManagerUserManual.rf
httpe:linsite. cumming.com
httpiinline.cummins.com/
https:/insite. cummins.com
https:/insite. cummins.com

The Help Tab provides
links to resources for

information about the

listed Tools
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Help Tab

[Cummins®Inc. Update Manager
About

The Cummins@ Inc. Update Manager provides a means of delivering software, Fault Information System
(FIS), Help File, and User Manual updates. Updates can be downloaded over the intemet, froma
Cummins® DWD or another location such as a network drive or removable media device. Using
Cummins Inc. Update Manager is an easy way to keep the electronic service tool and its supporting data
as current as possible.

Cummins Inc. Update Manager can be opened manually at any time or it can be configured to issue a
reminder at regular intervals.

Note: Files cannot be updated while the application is running. Ensure the application is closed before
installing updates.

Perform the following steps to obtain updates:

1. Open Cummins® Inc.Update Manager by performing one of the following steps:
+ Within the application, select Help » Check for Updates
» From the Windows Start menu, select All Programs » Cummins® Inc. Update Manager
¢ When the Cummins Inc. Update Manager reminder window opens, click on the Select and
Install Updates link.

2. Select Update From Internet, Update From DVD or Other from the drop-down menu at the top

ofthe screen.

Select the Get Updates button.

Cummins Inc. Update Manager will check forupdates. This process may take several minutes.

A rotating globe will appear in the upper right-hand comer of the screen.

o [fupdating from the internet, Cummins Inc. Update Manager will connect to a Cummins® web
server and compare the applications version and files onthe PC to the files on the server.

¢ |fupdating from a DVD, Cummins Inc. Update Manager will compare the applications version
and files on the PC to the files onthe DVD.

» [fupdating from a network drive, when Other is selected, a window will open to enter or
Browse to another location forthe update files. Cummins Inc. Update Manager will compare
the applications version and files on the PC to the files on this location.

5. W updates are available, they will be listed in the window pane under Available Updates.

6. Select the desired updates by either highlighting the item or clicking on its checkbox. When an
item is selected, its description is displayed on the right-hand side of the screen.  The Total
Update Size of all selected items is displayed in the lower left- side of the screen below
Currently Selected Update Size. Click on an item again to deselect it.

Selecting the top level box will also select all updates listed below it. Clicking on the
expand the listing.
7. Once the desired updates have been selected, click on Install.

8. Cummins Inc. Update Manager will start downloading the selected updates. Depending on the
total update size and the speed of the intemet connection, this may take several minutes.
Cummins Inc. Update Manager will display a progress bar.

9. Once the updates have been downloaded, Cummins Inc. Update Manager will install the updates.

W

+

will
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Cummins® Inc. Update Manager

Wrap Up

= Provides up-to-date Fault Information System (FIS)
files, Help files, Feature Packs and Service Packs

= Automatic Update Notification

= Scheduled update checks
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You have concluded this training package.
Click Here to return to the Table of Content.
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